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So you have learned to take photographs as well as snapshots, but are you making movies too?

Now that even entry level DSLRs include HD video mode, a whole new playground of possibilities has opened
up for digital photographers everywhere. Full-frame image sensors and a wide range of interchangeable
 lenses make digital cameras superior to camcorders in many ways. Increasing numbers of professional  
film-makers are using DSLRs for their day-to-day work, and this issue of c’t Digital Photography includes an in-
terview with a pro camera operator on a digital advertising shoot.

DSLR video is still in its infancy but, even if manufacturers still need to improve camera handling and sound
quality, video-equipped digital cameras add an exciting new dimension to every photographer s repertoire.
Practice, experience and having fun while learning are the most important ingredients if you want to produce
technically and artistically polished video, so a number of major articles in this issue are dedicated to giving
you the information you need to start shooting your own digital movies.

Photography, too, has its fair share of column inches: our Master Class shows you how to make the most of
GIMP’s free image processing power, we show you how to shoot better photos and J Henry Fair’s Industrial
Scars portfolio perfectly bridges the gap between art and photojournalism. Fair’s  photos show us the terrible
environmental destruction caused by events like the ’Deepwater Horizon’ disaster while serving up aesthetics
that are at home in art galleries all over the world.

Have fun reading and discovering!

Jürgen Rink
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Portfolio 
The beauty of J Henry Fair’s images disguises their 
true nature. These breathtaking photos document
environmental disasters, including the BP oil spill 
in the Gulf of Mexico.

8 J Henry Fair: Industrial Scars 

Bokeh – The Beauty of Blur
Which bokeh looks best and which lenses produce the
most desirable blur are both subjects of hot debate. We
provide you with tips on how to get great bokeh effects,
and we compare the bokeh produced by a range of
popular manual and autofocus lenses.

16 Bokeh Know-how
27 Lens Comparison Test 

DSLR and EVIL Video Special
Shooting HD video with digital stills cameras is 
becoming increasingly popular, especially now that 
high-end DSLRs are getting some competition from
consumer DLSRs and EVIL cameras.

32 Shooting Video 
with Interchangeable-lens Cameras

40 HD Video Camera Test
50 Video Accessories for DSLR and EVIL Cameras

GIMP Master Class
This collection of workshops shows just how powerful and
flexible the free GIMP image processing suite can be. 
From beginners to advanced users, everyone can learn
something new with our GIMP master class.

56 Image Retouching
61 Advanced Object Selection
65 Brightening up Bad Weather Snaps
68 Tuning Your Photos with GIMP
70 Two Easy Steps to Infrared Effects
72 Cross-processing Effects
74 Photomontage
76 Reducing Depth of Field
78 Professional-looking Postcard Layouts

Image Noise Know-how
All digital cameras produce noise, from consumer 
compacts to high-end DSLRs. There are many ways to
digitally reduce the effects of noise artifacts, but the best
remedy is to avoid producing noise in the first place.

80 Overview
84 What Causes Image Noise?
86 Image Noise and Sensor Size 
88 In-camera Noise Reduction
90 Tips & Tricks
92 Camera Modding – Build Your own Sensor Heat Sink
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Remote Camera Control
Cable release was yesterday! This article shows you 
how to control your camera remotely by wire, wirelessly, 
or even using your iPhone.

94 Remote Triggers for Digital Cameras

Creative Corner
Which is more important – your creative skills or the 
equipment you use? Whatever you think, the goal is 
always to produce better photos. We look at the magic 
of traditional black-and-white images and the charm of 
photos shot using low-end cellphone cameras. We have 
also included a large format panorama image of the 
Moon for you to keep and print.

106 Image Composition
112 Back to the Basics
116 Shooting in Black and White
124 Cellphone Photography with a Twist
128 The Moon in Hi-Res 

About the Magazine

3 Editorial
130 About Us
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Free DVD
The DVD includes two video tutorials. 
The first explores Photoshop Lightroom 
3’s image management and processing
functionality, and the second discusses 
RAW image processing and image correction
using Adobe Photoshop CS5. There are 
also numerous sample images and videos
relating to various articles in the magazine 
and, to round things off, we have included a
package of free image processing and photo
tools as well as a full version of Ashampoo
Photo Optimizer

6 DVD Contents
7 DVD Highlights
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Image Processing

Windows
FastStone Photo Resizer 3.0
FastStone Photo Resizer Portable 3.0
GIMP 2.6.10
GIMP Portable 2.6.10
Image Analyzer 1.32
ImageMagick 6.6.4-8
ImageMagick 6.6.4-8 (64-bit)
Inkscape 0.48
Luminance HDR 2.0.0
Paint.NET 3.5.5
Photo Pos Pro 1.82
Picasa 3.6
RegiStax 5.1.9.2
TSR Watermark Image Software 1.8.3.4

Mac
GIMP 2.6.10
Inkscape 0.48
Picasa 3.6

Linux
Luminance HDR 2.0.0

Photo Tools
Windows
Absolute Color 1.0
Awesome Duplicate Photo Finder 1.0
Curves 1.0

Edges Fx
Eraser Classic 1.01
Exif Eraser 1.0
ExifTool 8.34
Foto-Mosaik-Edda 5.6.2
GeoSetter 3.3.60
i3D Photo 3.4.0.190
Image Resizer Powertoy Clone for Windows 2.1
Image Resizer Powertoy Clone 

for Windows 2.1 (64-bit)
IrfanView 4.27
IrfanView PlugIns 4.27
IrfanView Portable 4.27
JetPhoto Studio 4.9.2
Local Equalization
Namexif 1.5
Panorama Perfect Lite 1.6.2
Perspective Transformations 8.0
PhotoRazor 2.5
Pictomio 1.2.31.0
Tint 1.0.4
XnView 1.97.8

Mac
ExifTool 8.34
JetPhoto Studio 4.9.2
PhotoGPSEditor 1.6
PhotoInfoEditor 1.2
Sofortbild 1.0.1
Tint 1.0.4

Linux 
ExifTool 8.34

RAW Tools

Windows
Raw Therapee 3.0 alpha 1
RawDev 22.04.2009
UFRaw 0.17
XDepth Raw Converter 1.5.1

Linux 
Raw Therapee 3.0 alpha 1

Sample Images and Videos
Bokeh Sample Images
GIMP Sample Images
Noise Reduction Sample Images
Moon Panorama
Sample Videos shot using 
Interchangeable-lens Cameras

Full Version Software
Photo Optimizer 2.02

Video Tutorials
Adobe Photoshop Lightroom 3
Adobe Photoshop CS5

DVD | Contents
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DVD | Highlights

Full Version: Ashampoo
Photo Optimizer 2.02 

Perfect for beginners and great for
anyone in a hurry! With Ashampoo
Photo Optimizer 2.02, you can
optimize your digital images with a
single mouse click. 

Ashampoo Photo Optimizer automatically
optimizes contrast, brightness, color

strength and image sharpness at the click of a
single button. Before and after views help you
to judge the effects of optimization and ad-
justments can be undone at any time. 

The program’s batch mode allows you to si-
multaneously optimize all the images in a fol-
der, also using just a single mouse click. Batch
adjustments can be undone for individual
images or the whole folder. The program saves
every step you apply, and if you are not satis-
fied with the results of the automatic optimiza-
tion, you can fine-tune your image manually by
 clicking the Color Correction button. The ef-
fects of your adjustments are displayed in real
time in the image preview window. 

In order to use the full version of the soft-
ware, you will need to enter the registration
code that you can download via the link inclu-
ded on the DVD or from within the program’s
interface. The registration process requires you
to enter a valid e-mail address. Once you have
entered your address, you will receive a confir-
mation mail. Clicking on the link in the confir-
mation mail confirms the validity of your 
address and automatically sends you a valid 
license key. (keh)

Video Tutorial: Adobe 
Photoshop Lightroom 3

This video2brain video tutorial
explores the basics of image
management and processing using
Adobe Photoshop Lightroom 3. 

Adobe Photoshop Lightroom was released
in its third iteration in the summer of

2010. In just three years, the program has deve-
loped from an enhanced RAW converter into
one of the today’s leading all-in-one digital
photo workflow tools. 

Tim Grey and Mikkel Aaland begin this 145-
minute tutorial with an overview of the pro-
gram’s functionality and the basic approach to
working with Lightroom. The following sections
include quick start guides for converting slide
shows into video files, creating custom print
layouts and producing web galleries with just a
few mouse clicks. The emphasis here is on sim-
plifying basic tasks without going into detail on
the software’s more complex capabilities. 

A large part of the material deals with the
program’s built-in database, importing images
into the Lightroom system, the locations and
formats they are saved in, and how to organize
your Lightroom libraries to help you find your
way around later. Subsequent sections go into
more detail on the production of slide shows
and HTML web galleries for publication on the
Internet. Grey and Aaland use clear examples
to illustrate each point, and include a wide
range of useful tips for everyday use of the 
software.  (pen)

Video Tutorial: Adobe 
Photoshop CS5

This tutorial addresses basic
functionality as well as some of the
new features offered by the latest
version of Adobe’s flagship image
processing package. 

Adobe is calling Photoshop CS5 a „mile-
stone“ and the most important upgrade

in the company’s history. The most significant
improvements are in the program’s object se-
lection, image manipulation and lens correcti-
on tools. 

Tim Grey and Mikkel Aaland are experi-
enced Photoshop users and great fans of the
program. They guide you through more than
two hours of material, starting with how to
use the Photoshop interface and tips on how
to structure your workflow. They use a range
of examples to demonstrate the program’s
new features and explain how to use Adobe
Bridge. 

The section on Adobe Camera Raw addres-
ses all of the most important aspects of RAW
image processing, including color corrections
and tonal value adjustments using Curves. 
Aaland and Grey go into detail on using the
Shadows/Highlights tool to make additional
tonal adjustments, as well as color correction
using selective gamma settings. 

The authors close with examples of how to
correct everyday image errors, such as red-eye
effects, image noise, and using the Clone
Stamp tool to remove spots caused by dust on
the image sensor.  (pen)

DVD Highlights
The DVD’s many highlights include a full version of Ashampoo Photo
Optimizer 2.02, as well as video tutorials on Adobe Photoshop Lightroom 3
and Photoshop CS5.
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Portfolio | J Henry Fair

Inside an Oil Sands Upgrader
Fort McMurray, Canada
The first step in the oil sands process after
extraction is upgrading, which separates
particulate matter from the mined bitumen
and prepares it for refinement.

Portfolio: J Henry Fair

Industrial Scars



JHenry Fair started photographing rusty
machines and broken-down buildings in

his youth, before going on to study media
and embarking on a stellar career as a fash-
ion photographer in the 1980s. His clients
back then included Issey Miyake and Ralph
Lauren, and his photos graced the pages of
Vogue and Vanity Fair. He also shot ad cam-
paigns for Sony/BMG, RCA, Polygram,
Deutsche Grammophon and Warner Broth-
ers that included noted portraits of classical
stars like Yo-Yo Ma, Cecilia Bartoli and Pierre
BoulezJ Henry Fair started photographing
rusty machines and broken-down buildings
in his youth, before going on to study media
and embarking on a stellar career as a fash-
ion photographer in the 1980s. His clients

back then included Issey Miyake and Ralph
Lauren, and his photos graced the pages of
Vogue and Vanity Fair. He also shot ad cam-
paigns for Sony/BMG, RCA, Polygram,
Deutsche Grammophon and Warner Broth-
ers that included noted portraits of classical
stars like Yo-Yo Ma, Cecilia Bartoli and Pierre
Boulez.

Fair rediscovered his passion for recording
the legacies of consumer society 10 years
ago, when he began publishing sequences of
photos that document dilapidated ware-
houses and industrial ruins. These were all
taken at ground level, but it was the aerial
photos in his Industrial Scars series that finally
gained him recognition in the art scene and
introduced his work to a broader public.

In order to produce these pictures, Fair
charters flights over chemical plants, fertilizer
factories and power stations to gain photo-
graphic access to things that are normally
fenced in or hidden behind high walls. The
ruined landscapes in the photos are not ini-
tially recognizable for what they are – the
high-contrast colors combined with varied
and often diffuse forms are more reminiscent
of abstract paintings than of documentary
photographs. The comparison between Fair’s
photos and abstract expressionist paintings
by Mark Tobey, Mark Rothko or Willem de
Kooning is immediate and obvious. 

Small wonder, then, that his photos were
soon being shown in galleries normally dedi-
cated to fine art. It is only at a second glance
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that the viewer begins to realize that the pic-
tures are actually of rivers that have turned to
sewers, or of contaminated earth and pollut-
ed lakes. The fact that these photos don’t
wag a finger makes them all the more effec-
tive. Fair leaves the interpretation entirely to
the viewer, which can have controversial re-
sults. Don’t these pictures also portray the
beauty that industry can create in a land-
scape? Do they perhaps illustrate the aesthet-
ics of destruction?

Fair knows and respects the boundaries
between art and documentation. He pro-
duces his photojournalistic work in coopera-
tion with United States and international en-
vironmental organizations, giving the result-
ing images the necessary political support.
The images come not only from the United
States, but also from Spain, Sardinia, Poland
and Kenya. He is particularly interested in
Germany’s lignite and coal industries and the
enormous industrial plants in the Ruhr area,
and closely follows the intense environmen-
tal debate that is an integral part of everyday
German politics.

During the preparatory discussions for this
portfolio and the interview that follows, Fair
was deeply involved in a new project cover-
ing the oil disaster in the Gulf of Mexico. One
of the first major images of the events in the
Gulf is included here. (jr)

J Henry Fair on the Web:
www.jhenryfair.com
www.industrialscars.com
http://soapboxhenry.blogspot.com/
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Portfolio | J Henry Fair

Sisyphus
Texas City, Texas, USA
Bulldozer pushing petroleum coke

The Last Stand
Kayford Mountains, 

West Virginia, USA
Blasting spoil being removed by

machine. Modern mining operations
work around the clock and at amazing

speed. This lonely stand of trees
disappeared in less than a day.





Thomas Saur (Art Director c’t): You’re a well-
known fashion and music photographer – what
inspired you to get on a flimsy light aircraft and
take aerial shots of industrial wastelands?

J Henry Fair: I have always been deeply con-
cerned with the environment and our impact
on it, simply because the environment is the
system that supports life on our planet. Ironical-
ly, the people that are doing most to destroy
this system – while generating vast personal
wealth for themselves – have managed to cre-
ate the impression that the “tree-huggers” are
the radical minority, while “business” is good for
everyone. I have been shooting images of pollu-
tion and decay at ground level for years, but it
was only when I saw the world from the win-
dow of an airliner that I realized how I could
produce really effective images. Shooting from
a light aircraft for this type of project is hot,
cramped and tiring work, but I still have to be
on the ball. There is no time to think on an aerial
shoot, and I often have to simply go ahead and
press the shutter release. 

People look at your work in art galleries and are
deeply impressed by its aesthetic qualities. Does
the inherent beauty of the photos distract viewers
from the destruction they portray? 

If the images are not beautiful enough to pro-
duce a response, they will not be effective. We
were already suffering from sensory overload
before use of the Internet became widespread
and today, only something that triggers a pause
and a question gets through our everyday fil-

ters. My audience has to reach its own conclu-
sions, but art always helps to bridge the gap be-
tween knowledge and understanding.

Which of your shoots has had the most impact on
you? 

On any given shoot, I try to meet the people
fighting the real battle on the ground, and that
always makes an impression. They are the first
ones to realize that a problem exists, and they are
the ones who can provide the most accurate and
timely information. Shooting the BP oil spill in
the Gulf of Mexico has probably had the most
impact on me, because of the sheer scale of the
situation, the vast deception involved and the
willingness of people everywhere to accept the
official story.

Can you tell us more about your experiences
there?

Photographing the BP Deepwater Horizon spill
has become something of an obsession for me,
but it is difficult for people who haven’t actually
experienced it to comprehend it. People ask me
what it’s like, but all I can say is, “It's worse than
you can possibly imagine.” No matter what I say,
I know I won’t be understood, because under-
standing the situation involves questioning
every single aspect of the normal, day-to-day
existence that we take for granted. The BP crisis
is so monumental on every level, I am amazed
that people aren’t already protesting on a grand
scale – not only against BP, but against the use
of fossil fuels at all. c

13c’t Digital Photography 2 (2011) 

Rio Tinto Mine 
Rio Tinto, Spain
Rio Tinto, literally “red river”, is one
of the oldest and most productive
mines in the world, having produced
a wealth of different metals over the
centuries. It is thought to have been
“King Solomon’s Mine” and the
reason the Moors invaded Spain

Ship Trail in the Oil-bound 
Gulf of Mexico
“If you haven’t witnessed the
devastation yourself, it’s 
impossible to understand the 
Deepwater Horizon disaster. It is 
worse than anyone can imagine.”

Interview mit J Henry FairPulp Waste at a Tissue Factory
Terrace Bay, Ontario, Canada
This factory produces pulp for the
USA’s most popular brand of facial
tissue. The wood fiber comes from 
the Kenogami National Forest in
Ontario, Canada, where the
government subsidizes deforestation
for the sake of just a few jobs. 
After logging, this ancient, diverse
habitat is replaced by monoculture.
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Shot using a Hasselblad HC 80 lens at f2.8



The term “bokeh” comes from the Japa-
nese word boke which means “haze” or

“blur”. The word is used to describe the
 aesthetic qualities of the out-of-focus areas
in photos. 

In photo magazines, it is often only
mentioned in passing in the course of lens
tests that go into great detail on the sub-
jects of sharpness and contrast. However,
bokeh is often the subject of  intense de-
bate in online forums and photo blogs due
to the twin facts that it cannot be meas-
ured but nevertheless has a significant ef-
fect on the overall quality of an image. Suc-
cessful images often owe their effective-
ness to the emotional impact of their out-
of-focus elements. Blur can be effectively
used to emphasize certain parts of an
image, and the transitions from sharp to
blurred often add to the feeling of space
and depth in a photo. The deliquescence of
blur can give a picture an almost musical
quality, and lively bokeh can give a back-
ground a subtle rhythm of its own, as if it
were breathing.

Images that are in sharp focus from the
near foreground right up to infinity auto-
matically take on a documentary character
and often include too much unimportant
detail that distracts the viewer and mud-
dies the picture’s message.

Thomas Saur

Bokeh
The Beauty of Blur

When a group of photographers starts to rave about “bokeh”, you might be
forgiven for thinking you have ended up at a wine tasting by mistake. What
they are talking about is, however, not the aroma of a wine, but rather the
often neglected out-of-focus parts of photographic images. This article
describes bokeh in detail and gives tips on how to control the bokeh in your
own images. We have also included a comparison of the bokeh effects
produced by a range of currently available autofocus and manual lenses.

17
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Factors that determine the
Character of Bokeh

Circles of Confusion
A camera and its lens project points on the
object plane onto the image plane (i.e., the
film or the image sensor). A point in a subject
is only in focus if all the rays of light emanat-
ing from it converge at the same point on the
image plane, as shown in the illustration
below. Foreshortening the cone of light for
points that lie either in front of or behind the
image plane displays these as discs rather
than points. These discs are known as “circles
of confusion”. The further the subject is locat-
ed from the focal point of the lens, the larger
the corresponding circle of confusion at the
sensor plane will be. It is this relationship that
determines the degree of blur in an image.
Using a smaller aperture extends the depth
of the field of focus. The look and feel of
bokeh is also influenced by the size, shape
and distribution of brightness within the cir-
cles of confusion that a lens produces. Circles
of confusion are, in fact, optical projections of
the aperture opening, and their shape is dic-
tated by the shape of the aperture blades in a
lens. A lens that has six aperture blades will
produce hexagonal circles of confusion; the
more blades it has, the rounder the circles of
confusion will be. Some lens manufacturers

deliberately round the inside edges of their
aperture blades to produce more pleasing
bokeh.

Aperture and Depth of Field
The maximum working aperture of a lens –
often described as its “brightness” – is repre-
sented by the smallest number on the aper-
ture scale. At maximum aperture, bright lens-
es produce images with very shallow depth
of field and larger circles of confusion than
they do at smaller apertures. Large apertures
thus produce more obvious bokeh. The maxi-
mum aperture setting is always part of the
name of a lens. For example, the size of the
aperture opening in an 85mm f/1.8 lens at
maximum aperture can be calculated by di-
viding 85 by 1.8. This lens is then “brighter”
(i.e., has a larger maximum aperture) than an
85mm f/2.8 lens. The depth of field and re-
sulting intensity of the bokeh a lens produces
also depend on the shooting format and re-
production ratio of the camera/lens combina-
tion you are using. These factors are, in turn,
influenced by the focal length of the lens and
the subject distance. The formulae for calcu-
lating the depth of field in a particular situa-
tion can be found at Wikipedia or other web-
sites.

If that sounds too complicated, you can
also use one of the many depth-of-field cal-

culators that are available for PC, Mac or
iPhone. There are some useful links listed in
the box on page 21. We particularly recom-
mend the DoF Plus iPhone App, which is
based on a comprehensive database of cam-
era/lens combinations.

Depth of Field and Shooting Formats
Used with smaller image sensors, lenses
cover a larger field of view and therefore pro-
duce greater depth of field than when they
used with larger image sensors. The opposite
is also true, and you can produce more fore-
ground or background blur using 35mm or
medium format cameras.

If you compare the results produced by a
Canon 85mm f/1.2 L lens mounted on a full-
frame camera with those produced by the
legendary Leica Noctilux 50mm f/1.0 used
with a Four Thirds format Lumix GF1, the
Canon lens displays much more pronounced
blur. 

We calculated the depth of field for the
Noctilux to be 10.6 cm (4.2 inches) for a sub-
ject located three meters from the camera
and photographed at f1.0. A 100mm lens
used with a full-frame camera covers the
same angle of view but already has a depth
of field of just 10.4 cm at f2.0. A medium-for-
mat Hasselblad H3D requires a 135mm lens
to cover the same area and produces depth
of field of 10.8 cm at f2.8.

Hard-core bokeh fans often use medium
format or even large format cameras to get
the best out of the out-of-focus areas in their
images. Digital compacts, with their tiny
image sensors, are not at all suitable if you
want to produce any kind of visible bokeh ef-
fect.

Home-made Bokeh

It is easy to experiment with the shape of the
circles of confusion your camera produces.
Simply use a fine modeling knife to cut an al-
ternative-shaped opening in a piece of black
card and mount it in front of your lens. This
can be a star or a polygon, or any other shape
you like, and will directly influence the shape
of the bokeh patterns in your images. The ex-
amples below show the kinds of effects you
can achieve.

“Good” or “Bad” Bokeh?

Photographers (and photography critics) often
talk about “good” and “bad” bokeh, but opin-
ion is divided as to what these terms actually
mean. Ideally, the out-of-focus areas in an
image should serve to separate objects in the
foreground from the background. This is why
many photographers prefer to use lenses that
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A cross section of the light path in a camera with the aperture wide open. The further an
object is located from the object plane, the larger the circle of confusion it produces at the
image plane and the more out of focus it will be.

Diagram of an aperture with
six blades and the hexagonal
circle of confusion it produces
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produce “soft” bokeh with the circles of confu-
sion displaying no discernible edges.

Some older lenses with less pronounced
spherical aberration correction fit into this
category and are still very popular. However,
aesthetic judgments have a lot to do with
personal taste and perceptual habits, making
“edgy” bokeh that accentuates the transition
from sharp to out of focus more pleasing to
some viewers. Some photographers particu-
larly like the polygonal circles of confusion
produced by older lenses that have only a
small number of aperture blades.

Special Lenses

Special lenses with specifically designed
bokeh characteristics are particularly popular
with portrait photographers. The Minolta/
Sony STF 135mm f/2.8 [T4.5]* lens uses a
built-in apodization filter to suppress the for-
mation of the visible outer ring in the circles
of confusion it produces.

Nikon manufactures two Defocus Control
portrait lenses (the 105mm and 135mm f/2.0
DC-Nikkors), which have manually adjustable
spherical aberration correction elements. The
results they produce are not particularly nat-
ural-looking and using them to optimize
background focus usually worsens fore-
ground focus, and vice versa. The donut-
shaped rings of confusion produced by mir-
ror telephoto lenses are generally considered
unattractive.

Classic and Exotic Manual
Lenses
Certain older, manual focus lenses are partic-
ularly popular with demanding digital pho-
tographers. Lenses manufactured by Leica,
Zeiss, Yashica and Nikon can be attached to
modern, high-end DSLRs using special
adapters (see also our high-end lens test in
issue 1 of c’t Digital Photography). Lenses con-
structed using the even older M42 thread can
also be adapted for use with contemporary
cameras. There are many treasures to be dis-
covered out there, especially among lenses
manufactured in Eastern Europe.

Some exotic lenses have found fame in
various Internet forums due to their bokeh
characteristics, and it is often optical errors
and anomalies that produce some of the
more sought-after effects. For example, the
Pentacon 135mm f/2.8 is said to have an es-
pecially soft, “creamy” bokeh. The Russian
Helios 40 (85mm f/1.5) and Helios 44 (58mm
f/2.0) models are good examples of cheap
lenses with very unusual bokeh, and can be
found on the used market for less than
US$15. Impressive sample images can be

The distribution of brightness within the individual circles of confusion influences the over-
all bokeh effect and depends on the degree of spherical aberration correction built into a
lens. The following are the most common types of circles of confusion:

The Distribution of Brightness in Circles of
Confusion

Home-made bokeh: it is easy to make your own bokeh filters out of ordinary black card. The
images here show some results produced this way.

Soft edges 

A low level of spherical aberration correction causes soft circles
of confusion. Ideally, this form corresponds to a normal Gaussian
distribution and is considered by many photographers to be
pleasing. This type of bokeh is relatively unsharp and has low
contrast characteristics.

Evenly lit

Balanced, well-corrected lens geometries will produce evenly-lit
circles of confusion

Emphasis on the outer edge

Some viewers find this type of high-contrast bokeh irritating. Un-
corrected lenses tend to produce double contours at object
edges that are located outside the plane of focus.





found in the various flickr user groups that
have formed around these often legendary
lenses. For more information, see the Useful
Links section below.

Digital Bokeh

While there are various programs and plug-
ins available that produce artificial bokeh ef-
fects, including Photoshop’s own Lens Blur fil-
ter and Alien Skin Bokeh 2, none of these
tools can produce results as effective as
bokeh that is produced optically. Applying
digital bokeh usually involves producing a
mask to protect the parts of the image that
you want to remain unaffected, and the re-
sulting images lack the layered transparency
that characterizes an original, unprocessed
photo.
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Shot using a Zeiss 50mm Makro-Planar ZE lens set to f2. Zeiss macro lenses are
renowned for their extremely clear definition and are usually corrected to produce

extremely good microcontrast. This can cause slightly unsettling bokeh with obvious
circles of confusion. The deep, three-dimensional look that these lenses produce has

its own special appeal. Zeiss is one of a handful of professional movie camera lens
manufacturers, so it is no coincidence that this look is reminiscent of cinema films.

Leica lenses are optimized to produce the
best possible contrast and image
resolution, and provide balanced correction
for a wide range of optical errors, too. This
is a combination that produces fine
transitions between in-focus and out-of-
focus areas and bokeh that has many loyal
fans. This photo was taken using a Leica
80-200mm Vario-Elmar-R set to f4.

Formula for calculating depth of field:

http://en.wikipedia.org/wiki/Depth_of_field
#Derivation_of_the_DOF_formulas

Calculating depth of field online:

www.dofmaster.com/dofjs.html 

General information:

http://en.wikipedia.org/wiki/Bokeh

Sample images:

www.flickr.com/search/?w=all&q=bokeh&
m=text

www.flickr.com/groups/finest_dof/

www.flickr.com/groups/bokehoftheday/

M42, manual focus and other older
 lenses:

www.retrocamera.net

http://forum.manualfocus.org/

www.flickr.com/groups/
m42_lenses_and_dslrs/pool/

www.flickr.com/groups/m42/

Russian (especially Helios) lenses:

www.flickr.com/groups/helios44/

www.flickr.com/groups/helios_40-2/

www.flickr.com/groups/russianlens/pool/

Useful Links
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The space around the subject is completely out
of focus and the bokeh underscores the overall
atmosphere in this shot. The photo was taken
using a Zeiss 50mm ZE lens set to f2.

Bokeh can also help to emphasize the emotional
impact of portrait shots. This photo was taken
using a Hasselblad HC 100mm set to f2.2. The

larger format produces a much stronger bokeh
effect than equivalent 35mm format lenses.





Bokeh | Know-how 

The shallow depth of field in close-up
shots emphasizes the bokeh
characteristics of a lens. This image was
shot using a Zeiss 50mm ZE lens at f2.

The focal length of a lens has a significant
effect on the resulting bokeh. The shot on
the left was taken with a Leica 80-200mm
Vario-Elmar-R zoomed in to 200 mm and
with the aperture set to f4. The image
above was taken using a Leica 35mm
Summicron-R set to f2. The longer lens
produces much more pleasing bokeh.

1. Image sensor size

The larger your camera’s image sensor,
the longer the focal length of your lens
has to be in order to successfully reprodu-
ce an object located at a certain distance
from the camera. This means that larger
sensors have shallower depth of field and
generally produce more impressive
bokeh.

2. Focal length

The greater the focal length of your lens,
the shallower the depth of field will be for
a constant frame size.

3. Aperture 

The larger the aperture (i.e., the smaller the
number on the aperture scale), the shallo-
wer the depth of field will be.

4. Subject distance 

The closer you are to your subject, the shal-
lower your depth of field will be at a con-
stant focal length. This effect is especially
prevalent in the field of macro photogra-
phy, where the field of focus is usually only
a few millimeters deep.

5. Distance between subject and
 background

The greater the distance between the
 focused subject and the out-of-focus
background details, the more obvious the
separation between subject and back-
ground will be. Portrait shots benefit from
placing the subject as close to the camera
and as far from the background as possi-
ble.

6. Unusual circles of confusion

Background light sources and reflective
metal objects, or light that is filtered
through foliage, produce particularly
pleasing effects. It is always worth taking a
close look at the defocused background
of your scene before you decide on your
final composition.

7. Reproduction ratio 

Bokeh effects can be enhanced by crop-
ping and enlarging image details or sim-
ply by making large prints. They are less
obvious in postcard-sized prints.

How to Produce Great Bokeh
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It is not only the shape of the circles of
confusion, but also the overall plasticity of 
the transitions between focused and
defocused areas that can give an image an
almost three-dimensional look, as this shot
taken with a Zeiss 50mm f/2.0 Makro-Planar ZE
strikingly demonstrates
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sults at moderate apertures (around f2.8) and
produce extremely sharp, high-contrast
images at smaller apertures. Versions with se-
rial numbers in the 3xxxxxx range (and above)
and the newer ROM versions have a particu-
larly good reputation. Many photographers
prefer the bokeh that the older 90mm Elma-

rit-R produces to that produced by the apo-
chromatically-corrected (and much more ex-
pensive) APO-Summicron version of the lens.
This is an excellent example of the discrepan-
cies that exist between the demand for techni-
cal excellence and the aesthetic effects a lens
produces.

Bokeh
Comparison
Test

The following pages include test shots that
allow you to compare the bokeh effects pro-
duced by various lenses. The lenses we tes-
ted have focal lengths ranging between 70
mm and 200 mm, and include fixed focal
length and zoom models manufactured by
Canon and Leica. They were the Canon EF
85mm f/1.2L II USM, EF 135mm f/2L USM
and EF 70-200mm f/4L USM lenses, and the
Leica Elmarit-R 90mm f/2.8, APO-Macro-El-
marit-R 100mm f/2.8, Vario-Elmar-R 80-
200mm f/4.0 zoom and Vario-APO-Elmarit-R
70-180mm f/2.8 zoom models. This issue’s
free DVD includes all of the test shots shown
here, plus others made using a Canon EF
35mm f/1.4L USM, a Leica Summicron-R
35mm f/2 and Leica Elmarit-R 35mm f/2.8
lenses.

The test shots all focused on the choker
around the neck of the bust, and our test
scene included various other objects as well.
Note the circles of confusion produced by re-
flective objects and objects edges. The tran-
sition between focus and blur along the dia-
gonally positioned necklace deserves parti-
cular attention. 

The test shots were all taken in daylight, so
we weren’t able to completely eliminate
fluctuations in the overall lighting conditi-
ons, but we nevertheless reached some
clear-cut conclusions, namely: bright lenses
are worth the extra bulk and expense. We
also wanted to test the Sigma 28-200mm
super-zoom, but found that its small (f5.6)
maximum zoom aperture and low-contrast
reproduction characteristics do not produce
useful bokeh. The bokeh it does produce is
plain and uninteresting. However, the
brighter zooms we tested prove that zoom
lenses can produce pleasing bokeh effects if
they have appropriate geometry and aberra-
tion correction.

Generally speaking, fixed focal length lenses,
with their larger maximum apertures, produ-
ce more obvious and more pleasing bokeh.
Nevertheless, some of the zooms we tested
produce great results, and we were particu-
larly interested to see the results produced
by the now legendary Leica70-200 f/2.8. The 

Leica Elmarit-R 90mm f/2.8 is an interesting
lens that is available quite cheaply on the
used market. Well-cared-for examples of this
particular model produce very pleasing re-
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We started with the 85mm f/1.2, which is,
due to its extremely large maximum apertu-
re, something of an exception. Due to space
limitations, we have printed only one image
detail and one enlarged detail for maximum
and slightly stopped-down apertures for
each lens. The entire high-resolution

 sequence for each lens is included on this
issue’s free DVD, so that you can decide for
yourself which effects you prefer before you go
out and buy a new lens.
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Martin Biebel

Shooting
Video
with interchangeable-lens
cameras

Introduced in 2008, the Nikon D90 was the world’s first DSLR with built-in
HD video functionality. This was an important milestone in the development
of digital video as a medium and, for the first time, allowed hobby and
professional film-makers to shoot video using interchangeable lenses.
Today, many entry-level DSLRs and high-end mirrorless cameras can record
high-quality video. This article provides an introduction to the subject and
includes a detailed test of six video-capable cameras as well as a review of
some useful video accessories.

Video with DSLR and EVIL Cameras | Introduction

c’t Digital Photography 2 (2011) 
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Film-makers have begun using digital stills
cameras to shoot video for a number of dif-
ferent reasons. Professional camera operators
use DSLRs to shoot films one scene at a time,
while advanced amateurs are simply discov-
ering the wonder of moving pictures as soon
as they see the astonishing quality of the
video clips that their cameras can produce.
New technology has opened up a whole new
field of creativity for photographers to exper-
iment with. The documentary film-makers
among you might want to film plays or birth-
days or weddings, while YouTube bloggers
upload videos to the Internet for fun or for
professional reasons. People shoot video for
very different reasons and require different
types of equipment to get the job done.

Professional Film-makers

Camera operators often dream about the
“good old” look of analog cinema film, and
have begun to shoot footage with DSLRs be-
cause of the large image sensors and the
wide range of available lenses that are said to
produce “film-like” effects. This assumption is,
however, only partially true.

One widespread half-truth is the idea that
a larger image sensor produces better im-
ages. A slightly different (but just as mislead-

ing) idea is that the larger a sensor’s surface,
the larger – and therefore more light-sensi-
tive – its individual photoelectric receptors
(i.e., pixels) will be. This is only true if the
number of pixels remains constant with in-
creasing sensor size. For example, the Canon
EOS D550 (or Rebel T2i, as it is known in some
markets) has 18 megapixels packed onto a
relatively small APS-C format sensor. Howev-
er, a video-maker requires only two megapix-
els of resolution to record Blu-ray quality Full
HD video at a quality level good enough for
large-scale presentations. The deciding factor
is, therefore, the number of pixels per unit of
sensor surface area – a value that is also
known as “pixel density”.

The “large sensor = shallow depth of field
= more film-like results” myth has already
caused many film-makers to write off the
Micro Four Thirds (MFT) format in favor of the
APS-C sensors built into most of today’s
DSLRs. The MFT format’s crop factor of 2 sug-
gests that it will produce one-and-a-half
times as much depth of field as a
Canon/Sigma APS-C sensor with its crop fac-
tor of 1.6, or a Nikon APS-C sensor with a crop
factor of 1.5.

In fact, the only direct effect of crop factor
is on focal length. The field of view covered
by a 25mm MFT lens is the same as that cov-

ered by a 50mm lens mounted on a full-
frame camera, such as the Canon EOS 5D.

The critical factor governing depth of field
is the working aperture. The smaller the aper-
ture, the less peripheral light will enter the
lens, so the depth of field is increased. For ex-
ample: a 32mm lens used with an APS-C cam-
era to photograph a subject located three
meters away will produce a depth of focus of
about 72 centimeters (28 inches). A lens with
(adequate) focal length of 25 mm used with
an MFT camera like the Panasonic GF1 in our
test will produce about 87 centimeters (34 ¼
inches) of focus depth. If you open up the
aperture in this lens to f1.4, the depth of
focus will be reduced to about 62 centime-
ters (24 ½ inches) and the lens “wins” when
pitted against the 32mm APS-C lens.

The same rules apply at f8. In this case, an
APS-C lens produces 4.26 meters of focus. An
MFT lens would produce an enormous focal
depth of 6.1 meters at f8 and 2.9 meters at
f5.6. So you see: if you want to experiment
with shallow depth of field, you will need to
use a lens with the widest possible maximum
aperture. Video is often shot in daylight, re-
quiring you to use an aperture of f8 or smaller
and immediately negating any advantage
your lens may have in terms of depth of field.
This is why professional film-makers often
use neutral density (gray) filters when shoot-
ing in daylight. A gray filter allows you to use
a wider aperture than normal without chang-
ing the look of a scene.

Full-frame is not a Must-have

Full-frame sensors are often “too much of a
good thing” when it comes to shooting
video. The depth of field produced by the
brightest lenses is so shallow that video shot
with them and projected onto large-format
screens (50 inches and more) often has an
unnatural look – for example, the available
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Choosing the 
Right Camera
Moving pictures are great, but which camera is best for recording the films
you want to make? Today’s video-capable cameras range from mirrorless
Micro Four Thirds compacts to top-of-the-range DSLRs with full-frame sensors.
Here, we show you which system is best suited for use in various situations.



depth of field might not be sufficient to
keep a person’s eyes and ears within the
field of focus. Which part of a face should
the camera operator focus on, and how? A
large monitor is essential if you want to
catch this kind of focus discrepancy during a
shoot. Even then, pulling focus quickly tests
the practical limits of using tape measures
and depth-of-field tables to keep your focus
accurate.

This is one of the reasons why profession-
al camera operators are starting to use 
APS-C cameras instead of full-frame models.
Cameras like Canon’s EOS 7D, or even the
entry-level Rebel T2i, offer the same range of
focal lengths that many people are familiar
with from the 35mm world. An added
“bonus” of using these cameras is that you
can often use your old 35mm lenses with
them too.

If you are prepared to void your camera’s
warranty, some specialist film companies –
for example, FGV Schmidle (www.fgv-
rental.de) – offer to swap out the standard
lens mount in a Canon EOS 7D for a 16mm
movie camera C-mount. Whichever sensor
size you decide to use, the difference in
depth of field between full-frame, APS-C and
Mico Four Thirds cameras and mid-market
video camcorders with 1/3” sensors is ex-
tremely obvious.

Twenty-five Frames per Second
are Enough
Although most camcorders record at 50
frames per second (fps), the lower 25 fps
frame rate that most video-capable DSLRs
shoot at is usually sufficient for most profes-
sional film-makers, who only occasionally
shoot handheld and don’t usually make sud-
den camera movements. The slight judder
that a 25 fps rate produces is barely notice-
able when the camera is panned carefully.
Professionals don’t usually use automatic ex-
posure systems either, making constantly
changing white balance or exposure values
less of a risk. Most professional film-makers
are happy to shoot using any camera that can
be manually controlled.

As our accessories feature on page!!!
shows, many serious film-makers jump
through all sorts of hoops to achieve their
cherished movie-like look, including con-
stantly monitoring the image being record-
ed, using exactly the right lens to shoot each
individual scene and using an assistant to pull
focus. And remember, changing lenses often
means readjusting the entire camera setup.
Some accessories, such as a radio-controlled
follow focus, often cost much more than the
camera itself. Most drama productions will
only manage to complete one or two shots
per day, and it is generally accepted that
three minutes of finished material is a good
day’s work. It is exactly this complexity that
motivates many students and film-makers
and, now that film development itself is no
longer a high art, shooting high-end video
has become one of the last bastions of artistic
image-making.
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These shots under-
score the differ-
ences in depth of
field that can be
produced using dif-
ferent cameras.
These images were
shot using (from
left to right) a full-
frame Canon EOS
5D, an APS-C cam-
era and a profes-
sional video cam-
era with a 2/3”
sensor.

A comparison of image quality and depth of
field characteristics. The image on the left
was shot using the Panasonic GF1 with its
standard zoom lens set to f5.6 and with ISO
sensitivity set to 1600. The image on the
right was shot at ISO 400 using a 45mm
fixed focal length lens set to f2.8.

Bright lenses and
selective focus: full-
frame cameras like
the Canon EOS 5D
Mark II are capable
of producing
atmospheric video
clips in low light
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Creative Film-makers

Which advanced photographer hasn’t, at
some time or other, felt the urge to make
moving pictures? Many photographers don’t
necessarily want to tell stories or edit scenes
together, but prefer to simply show their

usual subjects and moments in time in the
form of a bright, moving presentation on
some kind of screen.

Nowadays, most creative photographers
display their work using LCD monitors or
projectors. These types of devices produce
brilliant, high-contrast images – a resolution
of 1920 x 1080 pixels is greater than that
which can be perceived by the human eye if
it is projected at a distance of double the
screen’s diagonal. You can also use the over-
all resolution of an image to zoom right into
specific details. If you have ever viewed digi-
tal images saved on a memory card using a
Sony PS3, you will know how fluid and
video-like the experience of zooming in and
out of your pictures can be.

Most people who attach an Olympus or
Panasonic camera to a television for the first
time are equally amazed. The camera dis-
plays any photo and video material in the
order it was saved on the camera’s memory
card to the accompaniment of soothing
music produced by the camera’s firmware.
The colors and sharpness of both video and
photos are astonishing. At the latest, this is
the point at which the effectiveness of mov-
ing pictures becomes tangible. For example,
shifting focus from a bee to the bloom it is

feeding on and back again gives a scene an
incomparably vivid look, while the sound of
rain on a window pane emphasizes the at-
mosphere of a dreary November day. A cre-
ative user is sure to conjure countless minia-
ture movies in her mind’s eye when con-
fronted with this kind of technology, al-
though it has to be said, not many of the
cameras currently available offer this degree
of simplicity when it comes to displaying
mixed photos and movies.

Many creative photographers and video-
graphers are prepared to put up with a cer-
tain degree of complexity to get the results
they want, but the simpler the solution, the
more intensively it will be used. This is where
the latest generation of compact EVIL
 (Electronic Viewfinder Interchangeable Lens)
cameras comes into play. These cameras also
have built-in microphones that are usually of
adequate quality, even if they do pick up
some unwanted noise whenever the cam-
era’s body is touched or nudged.

Depth-of-field effects are an integral part
of the creative image-making process, so an
image sensor can never really be big enough
for creative use. If you prefer to shoot video
handheld, your camera will need to have a
built-in image stabilizing system that doesn’t
produce additional noise. One way to avoid
recording unwanted camera noise and to en-
sure “clean”, atmospheric soundtracks is to
attach an external accessory microphone to
the camera’s microphone socket. Videogra-
phers will often look for a quiet place near
the scene of a shoot where the true audio at-
mosphere can be recorded once the accom-
panying images are safely “in the can”.

Video Bloggers

Huge numbers of people enjoy shooting low-
quality video using cellphones or digital com-
pacts and posting the results to the voracious
giant known as YouTube. This mass of users
includes a number of genuinely talented
people who have learned to use the YouTube
platform to develop their own particular
brand of art. Spoof music clips of famous
artists are a particularly popular type of video
blog (or “vlog”), which work only if the cam-
eras used to film them work quickly, auto-
matically and without interference from the
user. People who need to shoot photos as a
log or as part of their business (architects or
insurance adjusters, for example) often use
video as a way of making more precise
records with audio comments. Camcorders
might produce better video, but a device that
can shoot stills and video is even better for
this type of application, or for participating in
social networks like Facebook.

A camera set up to record a dawn
scene using available light only.
Cameras with tilt/swivel monitors
have a camcorder-like feel.

Video artists 
like KevJumba,
with their 
own YouTube
channels, show
just how effective
and popular
short “trash”
videos can be
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c’t Digital Photography: You are currently shoo-
ting an advertizing clip using a Canon DSLR.
What’s the clip about?

Kumaran Herold: The clip is an image film for
a large dairy products company based in the
Black Forest. The clip shows the happy cows
in their idyllic environment and people enjoy-
ing the products and the surroundings. Apart
from the cows, which never do exactly what a
director wants, the most difficult shots are
the ones of people drinking milk. In these
“beauty shots”, I have to get the main pro-
duct (i.e., the milk) and the people looking as
good as possible. I am shooting the high-end,
outdoor footage in available light with a little
help from some spotlights. The footage will
be edited together with studio-based materi-
al during post-production.

Isn’t a shoot like this a job for a 16mm or 35mm
film camera?

I love to shoot on film. Film footage looks
more three-dimensional than video, and the
color depth and post-production color ad-
justment potential of film is fantastic. Nowa-
days, the shooting format we use is restricted
by the client’s budget, and we often have to
make do with a smaller team and simpler
equipment. I chose a Canon EOS 7D because
of its large image sensor, which allows me to
produce depth of field the way I am used to
doing with film, while the camera itself costs
a fraction of the price of an equivalent film
camera.

I can also review the footage I have shot
immediately on set, instead of having to wait
for rushes to be developed and printed.
Rushes can take as long as a whole day to
produce, which can cause a sleepless night
or two if I’m shooting particularly tricky
scenes.

Why are you using your EOS 7D for this particu-
lar shoot?

Silke Gebauer (the director) and I had a long
debate over whether to use the EOS 7D or
the more sophisticated EOS 5D Mark II. The
5D has a larger sensor and produces even
shallower depth of field, making precise

focus pulling more difficult. The field of focus
is only a few centimeters deep at full apertu-
re, so it’s impossible to keep both of the per-
former’s eyes in focus at once. That can be
quite irritating for viewers. We also only have
access to small monitors on some of the sets,
which makes it difficult to precisely monitor
the sharpness of the shots. Under these cir-
cumstances, the 7D’s smaller sensor gives us
an extra margin of focusing safety.

The clincher for the 7D is its 50 fps shoot-
ing capability in 720p mode, which allows me
to shoot in slow motion. Fifty frames can eas-
ily be resampled to create two 25-frame,
slowed-down seconds of footage. This is
great for producing atmospheric shots of
slow-flowing water or wind effects. Take a
closer look at advertizing clips in future and
note how many scenes have been shot in
slow motion.

Can you achieve satisfactory results using a 7D
with standard photographic accessories, or do

you need to use film accessories like matte
boxes or a rig?

A DSLR is not a custom-designed film camera
and is therefore not always practical for shoo-
ting video. My assistant was actually quite un-
happy during the first few test shots because
the various buttons and levers aren’t where
he expected them to be. There is no adjusta-
ble viewfinder, so it is difficult to shoot from
above or below without performing gymnas-
tics. The 7D’s monitor isn’t tiltable, so I defini-
tely need to use a rig to keep the camera po-
sition and the use of accessories flexible. A
flexible external monitor is indispensable for
shooting from unusual perspectives. Blonde
hair is usually backlit in beauty shots and
often produces stray light in the camera’s
light path, so we have to use a compendium
or barn doors as well. The compendium we
are using here doubles as a filter holder.
Video cameras usually have built-in gray fil-
ters for reducing the working aperture in
brightly lit situations.

I often need to use additional ND filters
with the EOS 7D if I’m shooting outdoors in
direct sunlight. There are also countless other
color and effect filters that I like to use to pro-
duce particular moods and looks.

Can any photographer now become a film-
maker at the push of a button?

Shooting photos and video are closely rela-
ted skills, but are nevertheless like two dissi-
milar siblings. The light, the viewpoint and

Using Full-Frame DSLRs 
to Shoot Adverts
Kumaran Herold is a professional camera operator who uses Canon DSLRs to
shoot advertizing clips. In this interview, conducted on set, Herold explains
how he came to discover the new medium and tells us where it is irreplaceable
and when he prefers to leave his DSLR at home.

The white ring around the focus knob makes it easier for the focus puller to mark the start
and end positions for each shot.
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the mood of the moment are the most im-
portant factors in a photo, whereas a film al-
ways tells a story over time using a sequence
of shots and technical devices such as camera
pans or the movements of the actors and act-
resses. The spoken word, ambient sound and
music are also important factors in the overall
effect produced by a film. The individual
shots in a film also have to be edited to make
dramatic sense. A film camera operator is al-
ways part photographer, but a photographer

has a lot more to learn to become a film-
maker.

What are the practical shortcomings of DSLRs
compared with traditional film cameras?

Most standard DSLR lenses have built-in au-
tofocus functionality, which is of no use
whatsoever in a film context. Moving pictu-
res depend on focus being accurately adjus-
ted to follow elements within the frame that
are relevant to the story being told. The focu-

sing scales of most DSLR lenses are very short
compared to those found in 35mm film
 camera lenses. It is much easier to shift focus
 accurately from 1.8 meters to 1.9 meters to
follow a person’s movement using a film
 camera lens.

Compression codecs are another draw-
back. The high compression rates they use
make it very difficult to adjust colors or image
brightness during editing without producing
excessive image noise, so it is essential to get
the lighting exactly right at the shooting
stage. Once the director and I have agreed
how a clip should look, I can use the EOS 7D
to immediately reproduce that look in the
camera. If the director wants to leave some
room for adjusting color or contrast during
post-production, I would suggest that we use
a different camera.

How would you classify DSLRs within the range
of traditional video cameras? Are they a real al-
ternative to shoulder-mounted video cameras
with 1/2” or 1/3” sensors?

These types of video cameras are typical do-
cumentary cameras with individually adjusta-
ble external microphone sockets. One of the
EOS 7D’s biggest weaknesses is its sound
level, which is very difficult to adjust manual-
ly. I found it difficult to go back to 1/2” and
1/3” video cameras once I had tried shooting
with a DSLR, even though you need to use
shoulder mounts and a certain degree of im-
provisation to get good handheld shots.

What are some of the most common mistakes
people make when shooting video using a
DSLR?

It is tempting to simply increase the ISO value
when shooting in low-light situations. The 7D
has an ISO scale that goes all the way up to
6400, which makes it easier to shoot in low
light but produces footage with very obvious
noise artifacts. At ISO values above 400, the
7D produces images with unacceptable
noise. You can produce a pleasing “movie-
like” look using fixed focal length lenses and
wide apertures of around f1.4 or f2. Zoom
lenses are usually too dark to produce accep-
table footage.

What shouldn’t we expect from a DLSR?

The EOS 7D is small and light, which makes
people think that using it to shoot video
should be quick and easy. In fact, the opposi-
te is true: you need just as much time as you
do for a 35mm shoot, especially for focus,
which has to measured and set very precisely.
I try to maximize the camera’s strengths – for
example, its small size makes it ideal for shoo-
ting inside cars or in other cramped situati-
ons. (pen) c

Kumaran Herold was
born in Sri Lanka in
1973 and grew up
there and in  Germany.
He trained as a camera
operator at the Baden-
Württemberg Film
Academy. He worked
on  various industrial
and image film pro-
ductions  before gra-
duating in 2004, and
has since been a free-
lance camera opera-
tor, mainly for adverti-
zing and documentary
films
(www.thanikai.de).

The Cameraman

The close-ups for this clip were shot using a rig and a precisely lit studio background, and
edited into the location footage later. The bolt-on 7-inch HD monitor is clearly visible in the
foreground.





Aquality HD camcorder costs about
US$1,000 and forces its owner to use a

single built-in lens. The only way to enhance
the capabilities of this type of lens is to
mount a wide-angle adapter. Most camcor-
ders are highly automated and use tiny
image sensors combined with small monitors
or low-resolution displays. DSLRs, on the
other hand, have large image sensors that
offer high sensitivity and movie-like depth of
field. Interchangeable-lens cameras allow the
user to adjust the configuration of the came-
ra itself, as well as adjusting focus and expo-
sure manually. Does this make camcorders a
thing of the past?

In order to answer this question, we tested
three DSLRs and three EVIL (Electronic
Viewfinder Interchangeable Lens) cameras
with HD video functionality. The DSLRs in-
clude Canon’s EOS 5D Mark II, which was
largely  responsible for starting the HD video
DSLR ball rolling and is still one of the fa-
vorites among DSLR video enthusiasts all
over the world. 

The 5D’s smaller, cheaper brother, the
Rebel T2i (also known as the EOS 550D in
some markets) is the latest addition to the
Canon range and is being marketed specifi-
cally with video in the foreground of its many
capabilities. The Nikon D90 actually intro-
duced DSLR video functionality before the
Canon 5D, and the new Nikon D5000’s video
functionality offers stiff competition to the
Rebel.

Today, video DLSRs are under increasing
fire from the mirrorless, EVIL competition.
These cameras are extremely compact and

often have no viewfinder at all, relying on
high-resolution three-inch displays for com-
position and image viewing.

The Panasonic Lumix DMC-GF1 represents
the Micro Four Thirds camp, named after the
unusual sensor format these cameras use.
Sony has managed to squeeze the APS-C for-
mat sensor from its A550 DSLR into the tiny
NEX-5 model. The Samsung NX10 also uses
an APS-C sensor and is the only mirrorless

camera in our test with a built-in, electronic
viewfinder.

Lenses and Resolution

The relationship between sensor format and
depth of field (see also the A Question of Sen-
sor Formats section overleaf) means that if
Panasonic wants its Micro Four Thirds camera
to produce images that are just as pleasing as
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Martin Biebel

HD Video Camera Test
Three DSLRs and three Mirrorless Cameras

Many newer digital cameras have a built-in video mode, and the
opportunity to use interchangeable lenses to shoot movies opens up
a whole range of new possibilities for moving picture enthusiasts
everywhere. We took a look beyond the HD hype and tested three
video-capable DSLRs and three of their mirrorless cousins in depth.
This report tells you what these cameras are really capable of, and
where they are still not quite as good as we’d like.

We used all the cameras in our test to
shoot standardized zooms, pans and dolly
shots, made in daylight (1000 lux), artifi-
cial light (150 lux) and low light (30 lux).
We analyzed the test sequences using a
direct HDMI link to a 40-inch Sony Bravia
monitor.

We have included some of the test se-
quences on this issue’s free DVD. These in-
clude a pan sequence that was designed
to test definition, color and low light noise
characteristics, and a second sequence
that demonstrates the capabilities of the
cameras’ automatic and semi-automatic
focusing systems. The Nikon D5000
wasn’t capable of focusing automatically
in low light, so we have included a second
clip that demonstrates the image quality
the camera produces when focused man-

ually. The noise produced by the focus
and image stabilizer motors built into all
of our test cameras is clearly audible in
these clips.

The second part of the test deals with
exposure metering. We filmed test
charts under laboratory conditions and
analyzed the results. We used standard-
ized color patches to analyze color in-
tensity, color accuracy and noise charac-
teristics, and line charts to check resolu-
tion.

We compared the results with those pro-
duced by camcorders, deliberately ignor-
ing any stills functionality for the purposes
of this test. As far as handling is con-
cerned, we concentrated on functionality,
with ergonomics playing only a secondary
role.

Test Methods and Results



those produced by an APS-C camera, it has to
manufacture reasonably-priced, wide-aper-
ture lenses to match the camera body. This
should be relatively simple, as lenses for
smaller sensor formats are smaller and
lighter, and therefore cheaper to produce
than equivalent lenses for use with larger
sensors.

Panasonic cooperates closely with Leica
for its lenses, but hasn’t yet managed to
produce any recognizable advantages over
the APS-C competition. The kit lenses sold
with all three mirrorless test cameras are
equally unspectacular: they all only cover
moderate ranges of focal length (from
medium wide to short telephoto) and have
variable maximum apertures ranging from
f3.5 to f5.6.

This is why we used brighter “pancake”
lenses to test the EVIL cameras. These have
much larger maximum apertures than their
zoom counterparts and are small enough to
make the cameras handle like compacts. The
Samsung NX10’s performance benefits
greatly from the 30mm f/2.0 lens. The low
light test was specifically designed to allow
the EVIL cameras to show their mettle com-
pared with their DSLR cousins – one addi-
tional f-stop is, after all, equivalent to dou-
bling the amount of light that reaches the
sensor. This makes maximum aperture at
least as important as focal length when it
comes to choosing a camera for use in low
light situations. 

The Sony only uses the central nine
megapixels of its sensor to capture video,
giving it an additional 1.8x crop factor and
an effective sensor size that is directly
equivalent to the Micro Four Thirds format.
Using full-frame lenses with APS-C cameras
magnifies the subject. For more information
on lenses, see the Accessories review on
page 50.

Compression Codecs 
and Real Resolution
Shooting digital video means capturing 25
two-megapixel frames per second as well as
to sound. To make it possible for cameras to
handle such large amounts of data, manufac-
turers use various compression algorithms to
remove redundant elements from the stream
of digital information produced by the image
sensor. If a compression algorithm removes
too much information, artifacts appear in the
captured footage in the form of jerky move-
ment or poor image definition.

Canon uses its own MPEG-4 video codec,
which is largely lossless but produces 40
MBit/s data streams that require a lot of pro-
cessing power. 
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The three DSLRs 
in our test:

The full-frame Canon
EOS 5D Mark II,
pictured with the
Canon Rebel T2i and
Nikon D5000 APS-C
models
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It is not the absolute number of pixels,
but rather the physical size of the image
sensor that is the crucial factor driving
the integration of video functionality in
digital stills cameras. The camcorder in-
dustry has recently realized that the 100-
year-old 35mm movie format, adapted
for use in stills cameras by Leica, is still a
state-of-the-art shooting format.

Today’s digital technology has helped
the 35mm format to return to its moving
picture roots. Since the first 35mm
movies were made using hand-cranked
cameras, generations of moviegoers
have got used to a look that portrays
their favorite film stars in front of more
or less blurred scenery. Every analog SLR
photographer knows that a portrait
looks best if the subject is framed against
an out-of-focus background. These ef-
fects are the result of the ability to ma-
nipulate depth of field in a shot.

Modern video-makers, with their small,
high-resolution camcorders, cannot use
depth of field as a creative tool. Tiny
image sensors that are often just three or
four millimeters wide have been used to
reduce the overall dimensions of video

cameras to the minimum. The smaller an
image sensor, the shorter the focal length
lens you need to capture a subject but,
unfortunately, decreasing focal length by
half also quadruples depth of field. This
phenomenon is counteracted somewhat
by the reduced size of the individual pix-
els and the way the camera is construct-
ed, but the effects it produces are still dif-
ficult to ignore. Having every last detail
portrayed in sharp focus used to be seen
as a boon but nowadays, it seems that
many film-makers no longer find the
“video look” acceptable or desirable.

The video world found its way back to
normality through the introduction of
the APS-C format image sensors found in
cameras like the Canon Rebel T2i, the
Nikon D5000 and the Samsung NX10
tested here, which give the footage they
capture a movie-like look.. The exact sen-
sor size varies slightly from camera to
camera. The Canon’s sensor measures
22.3 mm x 14.9 mm, giving it a 2:3 for-
mat, and it is no coincidence that the
APS-C format was developed as an ana-
log stills equivalent to Academy format
movie stock. The original “35mm” film
size refers to the entire width of a movie

film strip, while still images shot on
35mm film are oriented sideways be-
tween the perforations, resulting in a
much larger 24 x 36 mm frame size. This
is the same “full-frame” format that is
used in the Canon EOS 5D’s sensor.

In 2003, Olympus and Kodak, the pio-
neers of digital sensor technology,
began using a brand new, 4:3 photo sen-
sor format measuring 17.3 x 13 mm. A
little smaller than APS-C, this format was
intended for video use and was designed
for projection on 4:3 television screens.
This was a fine idea, but fell foul of public
taste, which dictated that the 16:9
widescreen cinema format is better for
watching television.

Today’s Micro Four Thirds format cam-
eras use the same size of sensor. This for-
mat’s extremely shallow 21mm lens
flange makes it possible to construct
ultra-compact APS-C format camera bod-
ies that can nevertheless be used with
bright, wide-aperture lenses. The Micro
Four Thirds specification also includes
two sensor pins intended exclusively for
video use. The Panasonic GF1 is the most
compact camera available in this class.

A Question of Sensor Formats

4.5 x 3.4
15.30

1/3.2“

5.4 x 4.0
21.60

1/2.7“

5.8 x 4.3
24.94

1/2.5“

7.2 x 5.4
38.88

1/1.8“

8.8 x 6.6
58.08

2/3“

17.3 x 13.0
224.9

Four Thirds

20.7 x 13.8
285.66

Foveon

48.0 x 36.0
1728.0

Width x Height [mm]
Surface area [mm2]

Medium format

36.0 x 24.0
864.0

35 mm format

23.7 x 15.6
369.72

DX

22.2 x 14.8
328.56

APS-C

The difference in size between full-frame and APS-C sensors is obvious, and the camcorder sensors
illustrated to the left of the top row seem tiny in comparison. Even smaller 1/4” and 1/6” video
sensors are still common in smartphones and some consumer camcorders.



Sony also records using MPEG-4, but com-
presses it to the AVCHD standard, producing
17 MBit/s data streams. Panasonic’s AVCHD
Lite recording format also works at 17 MBit/s,
but produces smaller, less compressed 720p
HD images that capture less detail. The Sam-
sung compresses its MPEG-4 video data
strongly to 9 MBit/s, a rate that is bound to
compromise image quality. 

Nikon uses the clunkier Motion JPEG (or
M-JPEG) recording standard and compresses
its data streams to 12 MBit/s, a rate which
also risks loss of image quality. 

The length of a clip a camcorder can cap-
ture is limited only by memory capacity,
whereas stills-based cameras can usually only
record up to 30 minutes of video at a time.
This is due to customs stipulations in some
countries, where cameras that can record for
longer are defined as video cameras and are
placed in a higher tariff band. Some DSLRS
also have problems with sensor overheating
if they are used for too long without a break.
The Nikon D5000 can only shoot for five min-
utes at a time, while the Canon cameras have
a limit of 12 minutes.

Viewfinders and Monitors

When you are shooting in Live View mode, a
DSLR’s mirror is raised, making it impossible
to use the optical viewfinder to check focus.
The Panasonic and Sony cameras in our test
have no viewfinder at all, while the Samsung
has a built-in high-resolution mini-monitor
for eye-level use. We found this electronic
viewfinder no better than the camera’s tradi-
tional three-inch monitor for checking detail
sharpness, although it does help to counter-
act the effects of distracting stray light in
brightly lit situations. 

The displays built into the EVIL cameras in
our test are some of the best on today’s mar-
ket, and all have around 300,000 RGB dots.
The Panasonic has a power saving OLED with
a large viewing angle that sets it apart from
the others and allows it to shoot for two
hours in video mode on one battery charge.
This is longer than all the other cameras in
our test (see also the table on page 49). The
Nikon’s monitor is smaller than the others,
with just 74,000 dots, and often displays mis-
leading color casts.

None of the monitors in our test have res-
olution that is high enough to satisfactorily
check focus for the entire frame, so they all
have a built-in magnifier function that you
can activate in manual focusing mode before
you start to shoot. None of the test cameras
allow you to zoom the monitor image during
shooting.

c’t Digital Photography 2 (2011) 

Video with DSLR and EVIL Cameras | Camera Test

43

The EVIL cameras 
in our test:

The Panasonic 
Micro-Four-Thirds-based
Lumix GF1 shown with the
Samsung NX10 and Sony
NEX-5 APS-C models



Handling

Camcorders are usually equipped with func-
tional autofocus systems, although manual
focus has been high on many camcorder
users’ wish lists for quite a while. Video DSLR
users have the opposite problem, and often
find themselves wishing their cameras had
quick, reliable autofocus. Unfortunately, such
systems do not yet exist.

The contrast-based autofocus systems
built into most digital stills cameras are too
slow and are not capable of seamless object
tracking. Only the GF1 and the NEX-5 are ca-
pable of smooth focus tracking during video
shoots, albeit with some focus delay. 

None of the cameras in our test managed
to focus accurately in low light situations,
and the Nikon D5000 was especially suscep-
tible to focusing problems. Check out the

sample videos on this issue’s free DVD for ex-
amples of each camera’s performance. All
the cameras we tested refocus if you press
the shutter button halfway while you are
shooting. This is completely impractical, and
produces loud motor noises while the lens
adjusts itself through its entire focus range
on the lookout for high-contrast objects or
the perfect focal point. This can take sec-
onds, and is guaranteed to spoil any video
shot.

You can set your aperture manually if
the lens you are using has a separate aper-
ture ring – otherwise, you can only select
apertures electronically using one of the
camera’s dials. The Sony NEX-5 doesn’t
even offer this option in video mode. All
the other test models allow you at least to
select an aperture before you start shoot-
ing, while the two Canons and the Sam-

sung also allow aperture adjustment dur-
ing a shot.

The NX10 has stepped aperture settings,
while the Panasonic allows you to preview
the depth of field your chosen aperture set-
ting will produce. This is not to be confused
with AE Shift functionality, which simply
shifts the effective aperture value to gain a lit-
tle image brightness at the cost of increased
noise. This type of functionality has nothing
to do with true exposure compensation or
adjustment.

It is therefore more practical to use AE
Lock to lock exposure before you start to
shoot. Usefully, both Canon cameras allow
you to unlock and reset a locked exposure
value while you are shooting.

No Motorized Zoom

Video DSLRs don’t have the zoom rocker
switch that allows camcorder users to per-
form smooth zooms. Creative film-makers
often prefer to zoom manually anyway, but
documentary film-makers often have to react
to fast-changing scenes, making a power-as-
sisted zoom a real advantage.

If you adjust the zoom ring on your lens
manually while shooting video, you will be
amazed how jumpy the movement looks in
the finished shot. Sony’s NEX lenses are easier
to zoom smoothly than those manufactured
by Samsung or Panasonic. Canon and Nikon
offer a larger range of lenses, but you will
have to choose carefully to find the ones that
are best suited to video use.

To summarize: stills cameras have a long
way to go to catch up with the ease of han-
dling offered by purpose-built camcorders.
Photo cameras are also not designed for pro-
longed use at eye level and can only produce
smooth, shake-free footage using longer
lenses if you use image stabilization to keep
your shot steady. The problem with image
stabilizers is that, if they are set to continu-
ous mode, they produce constant motor
noise that gets picked up by the camera’s
microphone. The problem was more obvious
in our Nikon, Samsung and Canon test cam-
eras, and less significant in the Sony and
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Vari-angle monitors
like the ones used
by Sony and Nikon
(shown here), which
can be rotated to
prevent unwanted
reflections, are
perfect for shooting
video footage

Test Results
Color variance [D] 
(Δ E) lower is better 

Color variance [A] 
(Δ E) lower is better 

Color variance [L] 
(Δ E) lower is better

Noise [D] (%)
lower is better 

Noise [A] (%)
lower is better

Noise [L] (%)
lower is better 

Relative contrast D/A (%)
higher is better

Canon EOS 5D
Canon EOS 550D
Nikon D5000
Panasonic DMC-GF 1
Samsung NX 10
Sony NEX-5

Key: D = Daylight A = Artificial light L = Low light

7.11
8.93

8.00
11.34

9.82
9.15

13.43
16.60

18.04
17.10

16.46
9.04

11.50
23.09

10.54
17.45

16.67
16.26

6.50
5.43

7.02
5.53

14.22
9.65

6.72
6.15

8.47
4.55

15.31
8.86

4.19
5.46

9.36
7.23

18.00
6.43

86.00
75.00

60.00
91.00

57.00
73.00



Panasonic models, probably due to these
manufacturers’ experience in building cam-
corders.

The menu systems are of secondary im-
portance compared to the basic handling
weaknesses of the test cameras. The Sony

menu system is the most sophisticated, while
the Samsung system is clearest, and includes
a precise percentage value to indicate re-
maining battery power.

Unlike most camcorders, none of our test
cameras allow you to change the battery

without first removing the camera from the
tripod. The DSLR models have memory card
slots on the side of the camera body that can
be accessed without difficulty. Our handling
test results are based more on whether the
camera settings can be adjusted at all during
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Relative contrast D/L (%)
higher is better

Horizontal resolution 
(absolute) higher is better

Vertical resolution 
(absolute) higher is better

Horizontal resolution 
(relative, in %) higher is better

Vertical resolution 
(relative, in %) higher is better

Color resolution (absolute)
higher is better

Color resolution 
(relative, in %) higher is better

80.00
60.00

49.00
85.00

38.00
48.00

632.95
554.88

345.48
444.48

339.77
610.41

791.68
714.66

479.85
430.67

588.15
623.72

68.50
57.80

37.50
58.80

35.10
67.90

79.40
68.20

52.80
0.55

64.20
66.20

177.52
164.33

148.71
117.46

161.14
163.00

43.80
41.30

48.80
34.40

53.80
43.80

We measured the real, usable resolution
(i.e., detail resolution) of each camera by
analyzing their ability to reproduce fine
textures. The graphs show how many pairs
of vertical line pairs per frame width each
camera can reproduce when used to film
black and white test bars. 

Full HD camcorders shooting at 1920p hor-
izontal resolution encounter a limit of 960
line pairs due to the effects of the Nyquist
frequency. The red curves show the hori-
zontal resolution in daylight (1000 lux),
while the yellow curves show horizontal
resolution in low light (30 lux). The green

curves show vertical resolution, which we
have also listed in units of line pairs per
frame height to make it easier to compare
the vertical and horizontal values. 

The Nikon D5000 has a short but linear
spectrum, which shows that the signal is
not artificially enhanced by the camera, but
doesn’t provide particularly good resolu-
tion. Increasing image sharpness could help
to improve things. The Samsung NX10 has
similar characteristics with weak contrast in
low light, but with HD-grade vertical resolu-
tion. The Panasonic GF1’s 720p signal drops
off dramatically after an overly high con-

trast peak at 300 LP/frame width, but still
produces almost HD-quality footage.

The Sony NEX-5 produces convincing reso-
lution, with good contrast that drops off
gently above 400 line pairs. Low light resolu-
tion is also more than acceptable in compar-
ison with camcorder performance. The
Canon Rebel T2i’s horizontal performance is
not as good as the Sony’s, but compensates
to a degree with higher vertical resolution.
The EOS 5D Mark II performs much better
overall, with only one small kink in the verti-
cal resolution curve. The 5D’s low light curve
is easily the best we tested.

Resolution
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filming, rather than on any basic ergonomic
considerations. Canon handling is the best of
the bunch, followed closely by Samsung. The
Sony and the Panasonic both have many use-
ful automatic features, while the Nikon is the
most difficult to use.

Sound Quality

None of our test cameras produced satisfac-
tory sound, and they all picked up unwanted
motor noise from the camera’s autofocus and
image stabilizing systems, as well as during
zooms. These types of sounds are all trans-
mitted and amplified by the camera body.
The Panasonic dealt with unwanted noise
better than the others. The Sony has a built-in
stereo microphone that produces genuine
three-dimensional sound, but also picks up
too much camera noise in the process.

Most of our test candidates produced
background noise and significant fluctua-
tions in sound levels due to their automatic

level control systems. The only exception is
the Canon EOS 5DD, which has been given
usable manual sound level adjustment in
the course of a recent firmware update. All
of the test models have stereo microphone
jacks, allowing you to use accessory micro-
phones to produce better sound. You can
also use separate sound recorders (see the
Accessories section on page 50). The Pana-
sonic and the Samsung both have a built-in
wind reduction filter that helps to improve
the quality of outdoor sound.

Other Connectors

All of our test cameras have an HDMI socket
for HD video playback and an AV OUT socket
for connection to a conventional television.
You can also use the AV socket to record ana-
log sound or connect headphones using an
adapter. 

Only the Canon cameras offer Live View
for monitoring during shooting, although the

5D’s reduced-quality output makes judging
image quality slightly difficult.

The proprietary multi-function sockets lo-
cated behind the Sony and Panasonic hot
shoes are an annoyance and can only be
used with the manufacturers’ own acces-
sories. We would prefer to see standardized
stereo microphone sockets that allow users
to choose which accessory to use.

Playback and Editing

Video signals can be transmitted to a monitor
for editing or presentation via an HDMI cable.
The introductory section on page 32 de-
scribes various types of video or combined
video/stills output.

Viewing direct output from the Nikon
D5000 and the Samsung NX10 is a real pain:
the clips appear with significant time delay
and often in the wrong format. Fast forward
and rewind are difficult to operate and play-
back stops automatically after every clip. 
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We used a 31-tone signal made up of har-
monic thirds to test the sound quality of the
cameras’ built-in microphones. Our test sig-
nal covered the entire spectrum of frequen-
cies between 20 Hz (deep bass tones) and
20 kHz (the highest frequencies audible to
humans). Our 0 dB reference tone had a fre-
quency of 1000 Hz. Ideally, camcorders will
not record any tones above the 0 dB level.
Camera microphones don’t need to be par-
ticularly sensitive in the bass range, as this
only emphasizes distracting background

noise produced by wind and other inciden-
tal sounds.

The Nikon’s sensitivity range is similar to
that of a telephone line, and the curve
drops off at relatively low frequencies. The
Samsungs NX10 shows weakness in the
bass range due to excess filtering – low fre-
quencies are only recorded satisfactorily
above 500 Hz.

The Panasonic GF1 also dampens bass
tones too much in an attempt to reduce

camera noise, but performs well in the mid-
dle range. The EOS 5D Mark II’s curve is
steep, indicating a strong, but not necessar-
ily natural, sound. 

The Sony NEX-5 records bass only hesitant-
ly, like the Samsung, and the curve drops off
relatively early at around 10 kHz. The Canon
Rebel T2i recorded the best sound in our
test, and also managed to produce satisfac-
tory high frequencies.

Built-in Microphone Sound Quality
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The Sony allows you to view multiple clips
in sequence (albeit with a slight delay be-
tween shots) and has a usable slide show fea-
ture. The Panasonic firmware includes prere-
corded sound effects that can be included as
a soundtrack with your video output. Both
Canon models offer relatively simple, com-
prehensive navigation between clips.

Both Canon cameras are designed with
subsequent editing in mind, and the Rebel –
like the Panasonic – even has some rudimen-
tary built-in editing functions. Apple Final Cut
Pro opens and processes Canon MOV files
without any glitches, and the consumer-level
iMovie program included with most Mac
computers also handles Canon video files
without any problems. Adobe Premiere
CS4/CS5 and Photoshop Elements 8 can also
handle Canon video natively. Other software
manufacturers are working on Canon sup-
port.

QuickTime 7 (and higher) is a useful stan-
dard video player. All camera manufacturers
include their own players on their software
CDs, although these rarely include any really
useful editing functionality. The Panasonic
PHOTOfunSTUDIO package is better than the
proprietary software included with the other
test cameras.

All programs that support AVCHD can
load and process Panasonic and Sony files.
AVCHD playback can be jerky if you are using
an older computer, and editing is virtually im-
possible on notebook computers or desktops
with less than four processor cores.

Samsung’s 720p, 30fps MPEG-4 files are
easy to edit using Adobe Premiere CS4, Sony
Vegas 9.0 or Final Cut Pro. These clips were
also easy to load and view in the widely-used,
freeware VLC Media Player and Microsoft’s
Windows Media Player 11.

The Motion JPEG files produced by the
Nikon are supported by most media soft-
ware, including older programs.

Image Quality

Our analysis of the image quality produced
by our test cameras yielded mixed results,
with only the two Canons and the Sony
recording true HD quality. The Panasonic,
Samsung and Nikon cameras only managed
to produce standard horizontal resolution.
The Samsung NX10 produced the most noise,
whether shooting indoors or outdoors in
bright sunlight. 

The Panasonic and the Nikon both left a
lot to be desired in low light situations and
aren’t much better than purpose-built cam-
corders, in spite of their much larger sensors,
although the Panasonic Program Shift fea-
ture does allow you to artificially brighten

your image a little. Both Canons and the Sony
are capable of shooting good low light
footage although, it has to be said, the EOS
5D really is in a class of its own – it produces
brighter, less noisy footage than any cam-
corder we have used.

The quality of the available lenses plays a
significant role in the overall image quality, as
demonstrated by the images in the introduc-
tory section on page 32. The depth of field
available to the Panasonic and Sony cameras is
very similar, but Samsung and Nikon both have
more to offer in this respect. Compression arti-
facts left some darker parts of the Panasonic’s
images looking rather soft, although this is not
a significant drawback if you are working with
out-of-focus backgrounds anyway.

Panasonic and Samsung showed erratic
white balance behavior and even produced
some distinctly magenta colored faces. All of
our test cameras produced good overall color
balance in bright daylight and indoors. Only
the Canon Rebel suffered from some limita-
tions when recording red tones in indoor sit-
uations.

The Canon Rebel T2i is the only test
model with a true 50fps shooting mode. All
the others displayed jerky progressive scan
performance during pans, although the
slower shutter speed used by the Sony, the
Panasonic and the EOS 5D counteracted
this effect to a certain degree, especially in
less brightly lit situations. The sharpness of
the Rebel T2i’s images also diminishes in

If you use an older editing program or if your current program has compatibility
problems, you will have to convert your files to a different format. This screenshot
shows the Green Valley EDIUS export interface with its choice of export codecs.
Conversion can take time, but allows you to edit smoothly once it is done.
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720p/50fps mode due to the progressive
scan technique it uses.

The Samsung and the Panasonic both dis-
play the dreaded “rolling shutter” effect that
produces horizontal image distortion during
fast pans. The Panasonic and the Nikon both
produced wavy, colored interference in artifi-
cially lit shots, although the Panasonic does
have a menu setting for suppressing this type
of effect.

Conclusions

Surprisingly, we discovered in the course of
our tests that the more blurry the background,
the sharper the other elements in an image
appear. Unlike when you are using a cam-
corder, these cameras allow you to produce a
variety of looks for your images, opening up a
whole new world of creative possibilities. We
also discovered that shooting video with these

cameras is a completely different experience
from shooting with an automatically con-
trolled camcorder, and requires you to spend
time and effort setting up each shot. 

Our major criticisms of the test cameras all
relate to handling. In our opinion, the most
important thing for the manufacturers to
concentrate on is developing practical focus-
ing mechanisms and zoom rings that are eas-
ier to adjust smoothly.

These graphs show how accurately the test
cameras reproduced six primary colors and a
range of natural colors. The closer the points
are to their corresponding lines, the more ac-
curate the test colors were.
The Panasonic GF1 has perfect white balance
in daylight, but tends to accentuate reds in
artificial light. The condensed look of the en-
tire left-hand side of the Panasonic’s graph
indicates too little color saturation.

The Sony NEX-5 produced the strongest
colors and the most precise white balance
in our test, both outdoors and in artificial
light. On the other hand, the Sony’s discre-
pancies for blue and sky blue were among
the largest we tested. The Samsung produ-
ces extremely bright colors that look good
on television screens, and the saturated co-
lors (especially cyan) are very accurate. Its
bright colors can, however, cause highlight

blooming when viewed on a television
screen.
The Nikon produced unremarkable results
with some slightly shaky red tones. The
Rebel T2i uses a color space that is optimized
for video use, resulting in accurate blue and
green tones. The EOS 5D produces similar re-
sults to the Rebel, but with less overall satu-
ration.

Color Accuracy
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The extraneous noises produced by kit
lenses make it imperative to record sound
separately, which involves extra effort. These
cameras’ autofocus and exposure systems
are designed for use in a stills environment
and often produce inappropriate results
when used to shoot video. A basic camera
setup will probably be sufficient for your first
clips without zooms or dolly shots, and sim-
ple shots won’t generally suffer too much

from poor sound quality. Should you need
to, both Canons allow you to adjust expo-
sure during a shot.

If you are prepared to invest in more so-
phisticated equipment, you will be rewarded
with respectable results. There are many very
impressive film sequences shot using DSLRs
to be found on the Internet. The two Canon
cameras produced the best overall results in
our test, although the EOS 5D, with its excel-

lent image quality and super-sensitive image
sensor (as well as its price!) is definitely in a
league of its own. The 5D produces video of a
quality that few camcorders can equal. The
Rebel T2i is a great tool for skilled amateur
video-makers, and includes a great set of
high-end video features. Among the EVIL
cameras we tested, the Sony NEX-5 was the
clear leader in image quality and sensor per-
formance. (pen)  c
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Camera Test Overview
Model EOS 5D Rebe T2i / EOS 550D D5000 DMC-GF 1 NX 10 NEX-5
Manufacturer Canon Canon Nikon Panasonic Samsung Sony
Video codec AVC/H.264 MPEG-4, AVC/H.264 MJPG AVCHD, MJPG MPEG-4, AVC/H.264 AVCHD, MJPG
Video storage medium CompactFlash SD-HC/XC SD-HC SD-HC/XC SD-HC SD-HC/XC, Mem. Stick PRO Duo
Video Specifications
Image sensor (Total pixels, size) 21.1m, 36 mm x 24 mm 18m, 22.3 mm x 14.9 mm 12.3m, 23.6 mm x 15.8 mm 13.06m, 18 mm x 13.5 mm 14.6m, 23.4 mm x 15.6 mm 14m, 23.4 mm x 15.6 mm
HD Resolution 1080 1080 / 720 720 720 720 1080
Progressive scan / Interlaced v / – v / v2

v / – v / – v / – – / v1

Frames per seond (fps) 24 / 25 / 30 24 / 25 / 50 / 30 / 60 30 25 30 25 / 50
Max. clip length 12 minutes 12 minutes 5 minutes 30 minutes 25 minutes 30 minutes
Manual aperture / focus / WB v / v / v v / v / v – / v / v – / v / – v / v / v – / v / v
Manual shutter speeds 1/30 – 1/4000 sec. 1/25 – 1/4000 sec. – – – –

Autofocus v(press shutter rel. halfway) v(press shutter rel. halfway) v(press shutter rel. halfway) v v(press shutter rel. halfway) v

Depth of field setting – – – v – –

Manual sound level setting v – – – – –

Wind reduction filter – – – v v –

AE Lock v v v v v –

AE Lock adjustabel during shooting v v – – – –

Face recognition v v – – – –

Viewfinder active – – – – v (color LCD) –

Monitor size / resolution (in pixels) 3 / 306 660 3 / 335 000 2.7 / 78 000 3 / 460 000 3 / 300 000 3 / 307 000
Tiltable monitor – – v – – v

Thumbnail view v v v v v v

In-camera editing v v – v – –

Live View v
3

v v – – v

Seamless ouptut / with photos v / – v / – – / – v / v – / – v / v
Photo Specifications
Max. resolution (in pixels) 5616 x 3744 5184 x 3456 4288 x 2848 4000 x 3000 4592 x 3056 4592 x 3056
Built-in flash – v v v v v

Shooting formats JPG/RAW/RAW+JPEG JPG/RAW/RAW+JPEG JPG/RAW/RAW+JPEG JPG JPG/RAW/RAW+JPEG JPG/RAW/RAW+JPEG
Connections
Computer interface USB USB USB USB – USB
HDMI out v v v v v v

Composite Video in / out – / v – / – – / v – / v – / v – / v
Microphone / Headphone socket v / – v / – – / – v (proprietary) / – v / – v (proprietary) / –
What’s in the Box
Mains adapter / Charger – / v – / v – / v – / v – / v – / v
Battery life (in constant use) 110 minutes 120 minutes 115 minutes 120 minutes 160 minutes 118 minutes
Remote control v

7
v

7
– – – –

Software ZoomBrowser EX/EOS Utiliy Zoombrowser EX/EOS Utiliy Nikon Transfer, ViewNX, 
WT-4, QuickTime, Silkypix

HD Writer Samsung Master, QuickTime Picture Motion Browser

Weight (body only) 28.6 oz. (810 g) 18.7 oz. (530 g) [incl. Battery] 19.8 oz. (560 g) 10.05 oz. (285 g) 17.6 oz. (499 g) 8.1 oz. (229 g)
Dimensions (B xH x T – body only) 6.0“ x 4.5“ x 3.0” 

(152.0 x 113.5 x 75.0 mm)
5.1“ x 3.8“ x 3.0” 
(128.8 x 97.5 x 75.3 mm)

5“ x 4.1“ x 3.1” 
(127 x 104 x 80 mm)

4.69“ x 2.80“ x 1.43” 
(119 x 71 x 36.3 mm)

4.84“ x 3.43“ x 1.57” 
(123 x 87 x 39.8 mm)

4.36“ x 2.31“ x 1.5” 
(110.8 x 58.8 x 38.2 mm) 

Video Test Results
Image quality ++ ++ ± + ± +

Light sensitivity ++ + - - - ±

Sound - - -- ± - ±

Viewfinder / Monitor + + ± + ++ ++

Handling + + - ± ± ±

Feature set + + - ± ± -

List price US$ 2,500 US$ 900 US$ 750 US$ 6805 US$ 5506 US$ 6504

1Progressive scan recording – interlaced output     2720/50p and 1080/25p     3Reduced format during shooting     4with AF-E 16mm f/2.8 Pancake lens     5with 14-45mm lens     6with NX 18-55mm lens     7Remote control via PC and USB

++ Excellent            +ˇ Good            ±ˇ Satisfactory            -ˇ Unsatisfactory            --ˇ Poor            vˇAvailable            –ˇNot available



Depending on the amount of time and ef-
fort you want to spend, you can shoot

video using a minimal setup or a complete rig
that includes follow focus gear and a bolt-on
monitor. Of course, you can also shoot video
using just a camera and a lens, but you are
sure to find that a bare minimum kit doesn’t
produce the quality of results you might have
been hoping for.

Without a tripod, you won’t be able to
shoot shake-free video or make smooth pans.
Many scenes require additional lighting, and
a fair amount of extra effort and gear is need-
ed if you want to use lenses designed for stills
cameras for video shoots that include zooms
or focus pulls. Most camera microphones are
not capable of capturing clean, high-quality
dialog or ambient sound. 

The following sections explain what to
look out for when you are choosing acces-
sories We distinguish between high-end gear
and accessories for use with mid-range mir-
rorless cameras, and there is a separate sec-
tion devoted to high-quality sound recording
devices.

Lenses
There are not as many lenses available for
mirrorless cameras as there are for DSLRs.
There are just three lenses to choose from for
the Sony and Samsung cameras reviewed in
our test, and the manufacturers have not yet
fulfilled their promise to introduce more lens-
es. Nikon and Canon DSLRs can fall back on a

wide selection of bright, wide-aperture lenses
that has developed over a period of many
years. These lenses are, however, much more
expensive than the standard kit zooms that
are included with most DSLRs. We recom-
mend that you use a bright wide-angle zoom,
like the Canon 24-70mm f/2.8L USM as your
standard lens, but that you also experiment
with ultra-wide-angle lenses with focal
lengths of 18 mm and below. These offer a
completely new view of the world that was
previously unobtainable using video cam-
eras. We also recommend that you use a
100mm (or similar) fixed focal length lens for
telephoto shots. The Sigma 105mm f/2.8
macro lens is particularly effective in this
range. Avoiding camera shake is a real chal-
lenge with longer telephoto lenses. Whichev-
er lens you choose, remember that the focal
length is the equivalent 35mm focal length
and needs to be multiplied by the crop factor
appropriate to the size of your camera’s
image sensor. For example, a 50mm standard
lens becomes an 80mm short telephoto
when used with an APS-C format camera.
Olympus and Panasonic lenses use the same
control signals and lens bayonet and can usu-
ally be used with both brands of camera.

Lens Adapters

Adapters like those manufactured by
Novoflex broaden the range of lenses Sam-
sung and Olympus users can use, and are
available for the – mostly manual – lenses
made by a number of manufacturers. Pana-
sonic also sells its own adapter for use with
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Martin Biebel, Hans Ernst

Video Accessories
for DSLR and EVIL cameras

Whether you are a professional camera operator or an occasional
videographer, if you use your DSLR regularly to shoot video, you are
sure to need some accessories to make the job easier. From choosing
the right lens to selecting a follow focus setup, this article describes
some of the essential and nice-to-have equipment on offer.

The best standard lens for
Canon-based film-makers:

the EF 24-70mm L-series
lens has a constant

maximum aperture of f2.8



the Leica M-series lenses, which have an ex-
cellent reputation among film-makers and
command high resale prices in spite of being
decades old. But be warned: some Leica lens-
es that were designed for use with 35mm
lens flanges extend backward at certain focus
settings, which can damage the image sensor
and/or mirror in some cameras. Sony recently
announced the introduction of an adapter
that makes it possible to use Alpha-series
lenses with the new NEX cameras, including
full autofocus control. Other suppliers, like
www.enjoyyourcamera.com, sell a range of
adapters for Canon EF lenses, although most
of these can then only be used at maximum
aperture. Micro Four Thirds adapters with
aperture rings are available for Nikon and
Pentax lenses. Many adapters can only be
used at close focus distances. Always check
the exact capabilities of an adapter before
making a purchase.

Tripods

A tripod is the basis for all video shoots and
needs to meet a multitude of requirements.
Photographers who shoot video only occa-
sionally will probably just buy a video head
for their existing photo tripod, and a mono-

pod is sufficient for most documentary uses.
A tilt capability for positioning the camera in
portrait format is not necessary for film pur-
poses. Serious film-makers, who think in
scenes, will look for a custom-built video tri-
pod. These are often equipped with a stan-
dard-sized bowl for use with a ball-based
video head, which allows the operator to
quickly align the entire camera/head setup
with the horizon using a single movement of
the grip built into the tripod head. This is
much more effective than adjusting the legs
of a photo tripod individually. A fluid-
damped tripod head with adjustable resist-
ance is the best option for smooth pans. A tri-
pod is often one of the most expensive parts
of a video setup. If you want to include track-
ing shots in your work, you will need to have
access to a dolly and rails, a crane, or special

gear for attaching your camera to an airplane
or helicopter.

Sun Shades

You will need to eliminate stray light if you
want your footage to display sufficient con-
trast. The sun shades included with most
DSLR lenses are great if you want to keep
your setup small and inconspicuous and
some, like those included with Canon’s L-se-
ries lenses, are coated with a soft protective
material on the inside.

Professional film-makers usually use a
more complex, much more expensive matte
box with adjustable “barn door” shades and
multiple filter mounting slots. Filters are an
important part of any professional’s creative
gear. Speckle filters can be used to liven up
dead shadows, while gray and blue graduat-
ed filters help reduce contrast and simulate
bright skies.

Shoulder Mounts

A shoulder mount helps you to carry your
setup once your rig gets too large for normal,
handheld use. Unfortunately, the center of
gravity of most shoulder mounts is located in
front of the user’s body and is centered on
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The Panasonic DMW MA2M adapter allows you to use Leica M-series lenses with Lumix G-
series Micro Four Thirds digital cameras. The original Panasonic version costs about US$200
and third-party alternatives are available for about US$100.

A tripod head with adjustable fluid
damping ensures smooth camera
movements at constant speeds and in all
directions. The ball base built into the
head allows you to precisely align the
camera/head combo with the horizon.
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the mount’s hand grips. Most manufacturers
have obviously not yet realized that their
products need to support the use of various
sizes of interchangeable lens. Systems that
utilize the user’s chest to support the camera
usually offer better support.

Follow Focus

If you want to be able to reproduce a scene
later, you need to be able to precisely repro-
duce the focus points you use. This is where a
“follow focus” setup is particularly useful. A

follow focus consists of a toothed belt at-
tached to the focus ring on the lens and a
geared knob for turning the ring according to
pre-measured and marked focus points. A fol-
low focus usually requires its own operator
and, if it is motorized, can also be operated
via radio control or remote cable. A follow
focus is mounted on the same rails as a matte
box and enables extremely precise and
smooth focusing.

Lighting

Most DSLRs are light-sensitive enough to re-
quire only minimal additional lighting for
video shoots, and a hot shoe-mounted video
light is usually sufficient to keep image noise
down to an acceptable level. Low-power
LED-based lights have recently become very
popular, and high-end models can be
dimmed to suit the situation and produce
balanced, evenly-projected light. Unlike most
camcorder lights, LED video lights have a
separate power source and their own charg-
ers.

Microphones

It is virtually impossible to operate an inter-
changeable-lens camera noiselessly, making
it essential to decouple sound recording from
the camera’s built-in microphone. This is eas-
iest to achieve using a separate directional
microphone made by a high-end micro-
phone manufacturer, such as Sennheiser,
Beyerdynamic or Shure. Videographers gen-
erally try to capture only the sources of sound
that are visible within the frame and to elimi-
nate all others. Only a very few DSLRs have
separate microphone sockets. These are usu-
ally located behind the hot shoe and have
channels for saving sound information and
for providing power directly from the cam-
era’s battery. This type of solution is often in-
adequate for professional use because the
hot shoe is required for mounting a flash unit
or an optical viewfinder.

The focus puller
uses a felt pen
to mark the
focus points for
the upcoming
shot

The LUX-LED4AA, manufac-
tured by Bebob Engineering
(around US$250) runs on four
AA batteries and uses a spiral
of LEDs to produce 250 lux 
of homogenous light at a
distance of about three feet.
The barn doors shown in the
illustration are optional.
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Most DSLR manufacturers sell own-brand
accessory microphones, but independent mi-
crophone manufacturers have yet to offer
models designed for use with specific cam-
eras.

Monitor Magnifiers

A magnifier for the camera’s monitor is a
practical way to bridge the distance be-
tween your  eye and the monitor when you
are shooting shoulder-mounted and also
helps prevent shoulder cramps and eye
strain. The Hoodman Corporation’s Hood-
Loupe 3.0, one of the less expensive solu-
tions available, is attached to the camera
using a rubber band. The Zacuto Z-Finder
costs around US$375 and offers state-of-the
art 3x magnification, an adjustable eye-
piece, a robust body and finely-tuned
diopter adjustment. The Z-Finder is the best
currently available option for shooting
handheld.

Checking Footage On Set

Professional film-makers prefer to leave
nothing to chance, so a powerful notebook
computer is an integral part of every mod-
ern video shoot. The camera operator’s as-
sistant transfers video files from full memory

cards to the notebook’s hard disk and is also
responsible for checking that the major
scenes have been properly recorded. Mis-
takes that go unnoticed during a shoot are
virtually impossible to rectify later – “Video
Photoshop” simply doesn’t exist! Most

DSLRs include playback software, so an on-
set notebook doesn’t necessarily have to in-
clude an editing program. Highly com-
pressed codecs like AVCHD are better edited
using a powerful, multi-core computer any-
way.
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Most camera operators build their own custom shoulder mounts using
aluminum rails, a shoulder pad, hand grips and a compendium. The
illustration shows a complete solution offered by Vocas Systems BV.

A matte box is used
to hold filters and
to prevent stray
lateral light from
reaching the lens.
This matte box is
mounted on
aluminum rails.
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Memory Cards
The first major rule of recording digital video is
“swap out your memory card more often”.
With today’s high-capacity cards, streaming
rates of 17 MBit/second and more (for AVCHD-
compressed footage) are not a problem, but
using a single memory card poses risks. If a
lone memory card gets lost, the potential set-
back for the project is much greater than if just
one of a number of cards gets lost or dam-
aged.

The Nikon M-JPEG and Canon H.264
recording formats stream as much as 40
MBit/second to the memory card, so it is es-
sential to have a stock of cards at hand. Cards
with transfer rates of 30 MB/second and more
are now the norm, and are available at rea-
sonable prices from high-end manufacturers
like Sandisk. Avoid no-name products – they
often don’t fulfill their nominal specifications,
which can lead to recording errors.

Remote Control

Canon offers a USB-based remote control
system for the EOS 5D Mark II (see also the
article on remote triggers on page 94). The
EOS Utility program included with the cam-
era has a built-in video mode that allows
you to view the current shot live on a com-
puter monitor and transfer the footage di-
rectly to a hard disk (albeit in non-HD quali-
ty) if required. It also supports remote
recording and camera settings.
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The Zacuto Z-Finder is held in place by a robust
metal frame. Additional rubber bands prevent it
from getting accidentally dislodged.

Sony’s accessory microphone
for its NEX cameras reduces
camera noise and improves
the directionality of
recorded sound
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Sound recorders capture stereo sound using
built-in or external microphones connected
either directly or via radio and usually have
line input sockets as well. They offer manual
pitch control and usually have a built-in peak
limiter. Some even have built-in wind filters
for outdoor use. Sound recorders can be used
as independent external microphones with-
out attaching them to the camera at all, and
battery operation means that you can place
the recorder as near as you like to your sound
source, providing clear, targeted recording.

Cheaper models don’t allow for precise
synchronization between the camera and
separately recorded soundtracks. Digital
recording is inherently more stable and reli-
able than tape recording, although it is virtu-
ally impossible to keep even digital cameras
and sound recorders synchronized for peri-
ods of 30 minutes or more. This isn’t usually a
problem for film-makers, who tell their story
and synchronize sound one scene at a time. 

At the cheaper end of the scale, we rec-
ommend the Yamaha Pocketrak C24 for use
with DSLRs. It weighs just 2 oz, can be fixed
directly to a camera rig or hot shoe if neces-
sary, and produces much better sound than
its size might lead you to think. A good alter-
native at the same price level is the H1 manu-
factured by market leader Zoom.

Pocket recorders capture sound directly
using built-in Flash memory or removable
memory cards. They usually also have an
auto-level option for making spontaneous
recordings. All of the devices listed can
record in high-quality PCM/Wave mode or
compressed MP3 format. Some also offer the
less common WMA recording format. You
can control microphone sensitivity to close-
up or wide-area recording situations, and we
recommend that you activate the peak lim-
iter if you are recording loud noises or live
music. You can check your recording lev-
els using the built-in display, where
peak LEDs warn you of potential
over-modulation. We recommend
that you use headphones to moni-
tor the sound during recording.
Make sure that your preferred
recorder can sample sound at 48 kHz,

as this is the frequency used by most com-
mon video formats. Many newer recording
devices can even sample 24-bit sound at 96
kHz, although this level of sound quality ex-
ceeds the requirements of most video appli-
cations.

By far the best recorder currently available
at a sub-US$300 price level is the Sony PCM-
M10. The Sony’s microphones offer excellent
recording quality and the device is reported
to record less of its own internal noises than
its competitors. Unfortunately, it doesn’t
have built-in XLR sockets, unlike the Zoom
H4n, which can also be used as an audio in-
terface for a computer. One of the really at-
tractive features of all these devices is the in-
credibly small amount of power they require,
leaving you free to concentrate on recording
and the amount of free memory capacity you
have left. (pen)  c

Mobile Audio Recording
Devices

Audio Recorder Overview
Manufacturer Model XLR

socket
Price
(approx. 
In US$)

ESI Rekord M – 120
Marantz PMD661 v 599
Olympus LS-11 – 299
Roland/Edirol R-09 HR – 265
Sony PCM-M10 – 299
Tascam DR-100 v 300
Tascam DR-07 – 115
Yamaha Pocketrak C24 – 200
Zoom H1 – 100
Zoom H2 – 140
Zoom H4n v 300

vˇbuilt-in              –ˇn/a

The Zoom H4n offers
XLR connectors in a

great-value package. XLR
connectivity is only usually
available in top-end Tascam

or Marantz recorders.

Great footage but terrible sound? Our camera test shows that only a few
video-capable DSLRs record adequate quality sound. Pocket-sized sound
recorders developed for the music industry provide a solution. These
pint-sized miracles record high-quality stereo sound on internal Flash
memory or removable memory cards.

The Yamaha Pocketrak
C24 weighs just 2 oz.
and is small enough to
be attached directly to a
camera rig or hot shoe
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Retouching Images
with GIMP

As well as dealing with spots and specks caused by random dust on the image
sensor, which are easy to remove, we sometimes need to “erase” larger
unwanted objects, such as cars, street signs or people from our images. Power
pylons and power lines are two of the things that people most often want to
eliminate from their photos. With a little patience and some practice, you too will
be able to use GIMP to retouch these and other imperfections in your pictures.



To retouch an image, you “paint over” the
blemish and the pixels surrounding it. It

therefore makes sense to check whether this
is actually possible before going into the de-
tails of how to remove the object in question.
Are there sufficient source pixels surrounding
the object? If not, are there pixels with the
right qualities elsewhere in the image?

Let’s train our cloning eye with the follow-
ing example:

Example 1: In this image of Apulian trulli,
there is sufficient blue sky surrounding the
power mast and the power lines for copying
and cloning:

Here, all we need to do is copy blue sky
pixels to cover the power mast and power
lines, taking care not to paint over the roof of
the smaller trullo on the left.

Example 2: It is much more difficult – if not
impossible – to retouch the tree branch in the
foreground of this shot of the Amalfi coast. In
principle, you would be right to say that
nothing is impossible, but in some cases, you
nevertheless need to assess whether the po-
tential improvement in an image is worth the
effort involved in adjusting it. Here, it would
take an enormous amount of time and effort
to remove the individual twigs covering the
houses. I had a second shot without the tree
branch which I could have used to copy the
house façades into my favorite shot, but this,
too, would involve a lot of time and effort ad-
justing perspective, exposure and tonal
range in order to get the merged image look-
ing authentic.

Example 3: Cloning is perhaps not the best
choice of tool at all for improving this image of
a sculpture in Atlanta. Here, it is probably more

effective to select and crop the subject and
then paste it onto a suitable background, such
as a sky or a color gradient. 

Preparing to Clone

Retouching is generally performed using a
brush tool, the tip diameter, opacity and
strength of which can be selected in the win-

dow that is displayed below the currently ac-
tive tool in the GIMP interface. The settings
you select will depend on the nature of your
image and the areas you wish to clone. Don’t
use a brush tip that is too hard, as this can
cause obvious edge artifacts in your results. 

Adjust the brush size to suit the resolu-
tion of your image and the nature of the
cloned pixels. 

Open the strommasten-muss-weg.jpg file
from this issue’s free DVD and select a brush
size that completely covers the mast. 

It’s a good idea to create a new, transpar-

ent layer for the details you are working on
when you are cloning. This way you don’t
have to adjust your original image data at all,
and you can readjust your cloned elements –
or even delete them and start again – if your
adjustments don’t go according to plan. You
can create a new layer using Ctrl+Shift+N in
the Layers dock. Call your new layer Clone
Layer, select the Transparency Layer Fill Type
and click OK. 

We will be adding our cloned pixels to this
layer in the course of the following steps. To
let the program know that you want to clone
pixels into your new Clone Layer from the
image layer below, activate the Sample
merged tool option. 

Select the Aligned option in the Alignment
drop-down list to ensure that the offset be-
tween the source  and the cloned pixels re-
mains constant.
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The Clone Tool
This is the most important image
adjustment tool, used for copy-

ing and pasting pixels.

The Healing Tool
This functions much like the
Clone tool, but also takes the tex-

tures and exposure in the surrounding pi-
xels into account. It is ideal for correcting

minor skin blemishes, dust particles or im-
perfections in colored surfaces.

The Perspective Clone Tool
Also similar in its functionality to
the Clone tool, the Perspective

Clone tool also allows for perspective effects
in cloned image areas and uses user-defi-
ned vanishing lines to adjust images accor-
dingly.

GIMP Retouching Tools



The most important tool settings are:

Let’s Go!
We will now use the power mast in our image
to learn the basics of cloning. Make sure you
have selected your new Clone Layer in the
layer dock and zoom into the area you want to
clone by repeatedly pressing the “+” key. 

Activate the Clone tool. Copy the source
pixels using a Ctrl+click near the power
mast. 

Now release the Ctrl key and place your
cursor over the power mast. You will now be
able to see two circles. The one with the
crosshairs in the center indicates your source
area and the empty circle shows where you
are about to paste the source pixels. Click to
“paint over” the power mast.

Now, if you move your mouse down-
ward, the Aligned option ensures that the
source area moves correspondingly. Now
click along the power mast to blot it out
completely. 

Always use source pixels from as close as
possible to the area you want to retouch –
here, from both sides of the mast.

If you make a mistake, use Ctrl+Z to undo
your previous step.

So far, so good.

Cloning Edge Detail

But what can you do if you need to retouch
an area that isn’t as easy to paint over as the
power mast or the power lines in our exam-
ple? Let’s use the area where the power mast
meets the roof of the trullo to practice.

In this case, it is all too easy to paint over
some of the roof tiles. We can work around this
risk by creating a selection that functions as a
boundary when we are pasting our cloned pix-
els. This makes it impossible to paint outside
the frame – something we all did in our paint-
ing books when we were children.

We used the Free Select tool to make our
selection. You can make your selection either
by painting with the mouse button pressed –
which can make the selection slightly shaky –

or by clicking a series of individual
corners to form a polygon. Once
you have selected your corners,
the tool automatically joins them

up. We used the polygon approach and acti-
vated the Feather edges option (with a radius
setting of between 3.0 and 5.0) to soften the
edges of the selected area. The setting you
use will also depend on the resolution of your
image. 

Click on the image at a “safe” distance
from the roof, release the mouse button and

click again to produce the first edge of your
selection, and continue carefully along the
roof of the trullo, clicking and releasing, until
you have finished bounding the roof. Once
you have clicked your way back to your start-
ing point to close the polygon, you can clone
away within your selection using source pixels
from anywhere within the image – the only
area limited by the selection is the area into
which you can paste. Once you are done, you
can deselect your selection using Select >
None, or Ctrl+A.

Cloning using Asymmetrical
Source Pixels

Cloning sky is pretty easy, and one cloud
more or less doesn’t usually make a signifi-
cant difference to the finished image. Howev-
er, if we want our results to look realistic, we
need to be a little more careful if we are
cloning asymmetrical objects, such as tufts of
grass. 

If you look closely at our sample image,
you will see the remains of a well in the fore-
ground. We will now use the surrounding
grass to retouch these remains out of the
image. Check out the grass and consider
which parts you think will provide the most
inconspicuous cover. The dark green “line” is
fairly distinctive and can be used as a refer-
ence point. The numbers sketched into the
cropped detail here indicate one possible se-
quence for copying and pasting. 

Always work smoothly from left to right or
right to left and don’t use source pixels that
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are located too far from the object you are re-
touching. If you paste source pixels from too
near the camera into an image area that is
further away, the perspective won’t look
quite right. If you can’t find suitable source
pixels close to the subject, use the Perspec-
tive Clone tool (see below). 

Try to clone horizontally or following
lines within the area you want to retouch.
Work inward from the outside edges of the
frame using source pixels from left and the
right of the subject. Poor retouching is often
recognizable due to unnatural-looking re-
peated patterns within natural objects. You
can always re work specific areas using
source pixels from further away if you find
that parts of your retouched image still look
unnatural. 

Correcting Errors

If you make a mistake while cloning, you can
undo your last step immediately using Edit >

Undo (or Ctrl+Z). You can also
undo multiple steps using the
Undo History dialog located in the

dock (indicated by the tab with the double

yellow arrow). Simply click on the state of
your image that you wish to return to.

You can also undo your cloning steps by
erasing pixels on your Clone layer (see Prepar-
ing to Clone above). Temporarily hide the
background layer(s) to show just your cloned
areas and activate the Eraser tool to erase
your chosen cloned pixels.

Perspective Cloning

If you want to clone parts of your image fore-
ground and paste them into an area that is
“further back” in your image (or vice versa),
you will need to alter the perspective in your
source material. Fortunately, the GIMP Per-
spective Clone tool can do this automatically
using the following steps. 

First, create a new transparent
layer to add your cloned pixels to
and activate the Sample merged and
Modify Perspective tool options. The

image window now displays handles at the
corners of your image, which you can drag
until the resulting vanishing lines represent
your desired perspective. The area you want
to clone doesn’t have to be enclosed by the
vanishing lines, as these only serve to delin-
eate the perspective effect.

Now select the Perspective Clone tool op-
tion and work as you would using the stan-
dard Clone tool. You will see when you paste
your selected source pixels into “distant”
areas of your image that they are automatical-
ly adjusted to fit your designated perspective.

Retouching by Copying

Brush-based clone tools are not always the
best choice if you want to clone large source
areas or clone without being restricted by the
brush parameters. In such cases, you can sim-
ply select and copy larger portions of your
source image, paste them into your new
image and soften any hard edges later. 

In this example, we want to get rid of the
ugly hatch on the left of the image. The stan-
dard clone brush would produce a series of
round edges, so it is much quicker and easier
to copy a section of the façade above the
hatch and paste it into separate layers as
often as necessary. 

You can try this technique yourself using
the sample klonen-durch-kopie.jpg file on this
issue’s free DVD. 

Activate the Free Select tool and a radius
setting of between 3.0 and 10.0 (depending
on the resolution of your image), then make
your selection by clicking the corners of the
area you want to copy and close the polygon
you have created by clicking on the first corner
again, or by double-clicking.

Copy and paste your selection using
Ctrl+C and Ctrl+V, and then use Shift+Ctrl+N
in the Layers dialog to anchor the floating se-
lection. You have now extracted a portion of
the façade which you can move to cover the
hatch using the Move tool. 
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You can duplicate the layer containing
your new piece of wall by clicking on the
third button from the right at the bottom of
the Layers dialog. Move the new duplicate
layer to cover more of the hatch and repeat
the last two steps until the hatch is complete-
ly covered.

To fine-tune your retouched image,
merge all of the layers to a single layer by
right-clicking and selecting the New from
Visible command in the context menu that
pops up.

Finally, soften any remaining edges using
the Smudge tool and re-clone any patterns
that are too obviously repeated. You can also
use the Healing tool to erase any remaining
irregularities.

Check your results at different zoom lev-
els and don’t be afraid to try a different
clone technique if you are not completely
satisfied with the effects you have
achieved.

Eliminating Dust Particles

You can get rid of individual blemishes
quickly and effectively using the Clone and
Healing tools described above, but what
can you do if your image is covered with
dust spots or scratches? This problem often
confronts people who are working on scans
of slides or other, older image material. The
simplest way to counteract these types of
imperfections is to reduce the size of your
image using the Image > Scale Image com-
mand. 

If this doesn’t suit your intentions, try
using either the Despeckle or the NL Filter.
Both of these tools not only eliminate hun-
dreds of irritating dust specks at the click of a
mouse, but also go a long way toward elimi-
nating the noise artifacts that often occur
when photos are taken in low light or using
high ISO sensitivity settings. Generally speak-
ing, both filters function by smoothing the
brightest or darkest pixels in an image, which
can have an adverse effect on overall sharp-
ness. If the specks you are trying to eliminate
only occur in specific parts of your image, se-
lect the affected area and use the Despeckle
filter to make your adjustment. The NL filter
can only be applied to a whole layer, but not
to a selection. Whichever filter you decide to
apply, duplicate your background layer first
and apply effects to the copy. This way you
avoid the risk of irreversibly altering your
original image data.

The Despeckle filter is located in the Filters
> Enhance menu. 

If you activate the Adaptive option, GIMP
automatically calculates the ideal filter set-
tings based on the image’s histogram and
moving the sliders in the filter’s dialog has no
effect. If you activate the Preview option, you
can see the filter’s effects in real time in the
Despeckle dialog window – simply move the
preview cursor to the image detail you want
to check. Activating the Recursive option
makes the filter’s effect stronger, but can also
make the results less sharp. 

If Adaptive mode doesn’t provide you with
satisfactory results, you can always deactivate
it and make your settings manually. The Ra-
dius setting determines the overall strength of

the effect, but remember, the higher the Ra-
dius value, the less sharp the resulting image
will be. The Radius setting ranges between 1,
which is equivalent to a 3 x 3 pixel area, and
20, which affects a 41 x 41 pixel area.

The Black Level and White Level sliders de-
termine above or below which points on the
0 to 256 scale of 8-bit tonal values white or
black pixels are removed from your image.
For example, if you set the White Level to
230, all tonal values between 231 and 256 –
together with any bright blemishes – are
deleted from the resulting image. Adjusting
Black and White Level values affects image
sharpness less than adjusting Radius values,
and its overall effect is milder.

The Swiss Army Knife

The GIMP NL Filter is widely known on the In-
ternet and in image processing circle as the
Swiss Army knife among today’s image cor-
rection tools, and combines sharpening, de-
speckle and smoothing functionality in a sin-
gle interface. This makes the NL filter more
complex to use, but also more gentle in its ef-
fect than the Despeckle filter – it generally
smoothes more subtly and thus affects over-
all image sharpness less. 

The NL filter cannot be applied to selec-
tions and is also deactivated if the active layer
contains an alpha channel. Alpha channels
contain information regarding a layer’s trans-
parency. A layer’s name is displayed in nor-
mal type if an alpha channel is present or
bold type if not. To delete an alpha channel,
use the Remove Alpha Channel command in
the layer context menu.

The NL filter is a complex tool, and a de-
tailed description would go beyond the
scope of this article. Here, we will here stick to
describing its Despeckle mode. Activating
the Alpha trimmed mean option and moving
the Alpha and Radius sliders to the right in-
creases the filter’s effect. 

If you want to know why: the Alpha
trimmed mean option replaces a pixel’s color
values with the average value of the pixel it-
self plus the six pixels surrounding it in
hexagonal form. The values of these seven
pixels are determined by the Alpha value you
select, while the effect’s strength is governed
by the Radius setting. The Alpha and Radius
slider values range between 0 and 1, and set-
ting both to 0.8 is a good starting point. Once
you have set your values, apply the filter by
clicking OK. Re-applying the filter (Ctrl+F)
strengthens the effect. 

There are some sample images for you to
experiment with in the Sample Images and
Videos section on this issue’s free DVD.

(ae/rez)  c
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The basic steps involved in selecting an
object are as follows:

1.An object first has to be outlined as precise-
ly as possible, using Paths, the Free Select
tool or the Foreground Select tool in con-
junction with a layer mask.

2.Once you have successfully outlined your
object, copy it using Ctrl+C.

3.Paste the copied object into its new locati-
on – for example, into a new layer – using
Ctrl+V. In GIMP, this keystroke produces a
floating selection, which has to be ancho-
red to a new layer using Shift+Ctrl+N.

As a result of these steps, the selected ob-
ject is pasted onto a transparent background,
which is indicated by a checkerboard pattern
in the new layer. The object can then be
copied and pasted at will into other images
and layers.

SIOX – Simple Interactive
Object Extraction

The GIMP Foreground Select tool is capable
of selecting objects semi-automatically. This
tool is based on the SIOX plug-in and has
been included in GIMP since the 2.4 release
of the program. The SIOX plug-in was
 developed at the informatics department at
the Free University of Berlin (see also
www.siox.org), and can “guess” the precise
outline of an object using a rough, hand-
drawn outline as a reference. It can also de-
tect objects of similar size and color to the
outlined object and select them all at the
same time using the Multiple Object Extraction
option. 

Let’s take a look at how to use this won-
derful tool in practice. Using conventional
tools to select the thistle flower in our exam-
ple would involve a great deal of painstaking
work, as it is extremely difficult to outline the
individual blossoms sticking out from the
main flower. The GIMP approach to the task is

as follows: first, we outline the
flower roughly using the Fore-
ground Select tool and a Radius
value of about 15. The exact value

will depend on the resolution of your image,
but 15 gives us a sufficiently soft edge for the
selection in our 4,000 x 3,000 pixel example.

Handling the GIMP Foreground Select tool
is a slightly unusual experience in that the
tool takes on different forms and functions
while you are using it. The first step involves

outlining your chosen object roughly while
pressing the mouse button. Once you have
completed the outline (1) and released the
mouse button, the background will be dis-
played with a blue tint (2).

For the next step, the tool acts as a brush.
Select a relatively broad brush in the tool op-
tions and paint liberally over the foreground
object to give SIOX the best possible set of
reference colors for your chosen object (3).
Once you stop painting by releasing the
mouse button, GIMP display the results of the
foreground extraction and displays the entire
background in blue. All non-blue areas have
been selected (4).

If there are any blue tinted “holes” in the
selection that are larger than you would like,

Bettina K. Lechner

Selecting Objects
at the Click of a Mouse

If you want to place an object on a different or more
neutral background, you will first have to isolate it from 
the rest of the image – a process known as “selection”.
Selection is often one of the most complex tasks in the
whole image processing workflow, especially for randomly
shaped objects. This article shows you how to use the GIMP
Foreground Select tool, which automates and simplifies
complicated selections.
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you can repeat your brush action using a
smaller brush. If there are only a few unob-
trusive “holes”, simply ignore them for now,
as any attempt to remove them can cause
the plug-in to resample the whole of the rest
of the selection. It is quicker and easier to re-
pair them once we have finalized our main
selection. 

If large portions of background have been
wrongly recognized as belonging to the fore-
ground subject, select the Mark background
tool option and correct them using the eraser
tool that appears. Here too, you can cover the
affected areas liberally, although a small
splash is often sufficient to get rid of unwant-
ed foreground elements.

The Foreground Select tool resamples the
selection after every brush stroke. Progress is
indicated in the status bar. Once you are sat-
isfied with your selection, press the Enter key
to finalize it. You will now see the running

black and yellow selection border surround-
ing your selection. If your selection includes
closed sub-selections, you can integrate
them into the main selection by surrounding
them with the Free Select tool while pressing
the Shift key (see illustration 1 below). If your
selection includes elements that protrude too
far into the background, you can also drag
these into the main selection using the same
Free Select/Shift maneuver (see illustration 2
below).

You should now have a clean, precise se-
lection. Press Ctrl+C and Ctrl+V to extract it
from the background and Shift+Strg+N to
anchor it to a new layer. You can test the
quality of your selection by inserting a solid
colored “check layer” below the main image
layer. To do this, select a suitable fore-
ground color in the Toolbox color picker
and use it to create a new layer (Layer >
New Layer). If the edge of your selection is
too sharp, you can soften it by returning to
the Foreground Select step in the History

dialog (the double yellow arrow in the Lay-
ers, Channels, Paths dock) and then reducing
the Radius of the feathered edge to a value
between 1 and 10 in the tool options. Con-
firm the new, softer selection and repeat
the copy, paste and anchor steps described
above. The Foreground Select tool pro-
duces spectacular results that never fail to
impress me.

You can now turn your selection into a fin-
ished illustration like the one shown above!!!
Currently, we have the extracted thistle
flower on one layer, followed by a white or
colored check layer with the original image
below that. The layer stack looks something
like this:

You can use either a new layer
(Shift+Ctrl+N) or the check layer to create a
black gradient located behind the backlit
thistle. Press the D key to revert the fore-
ground/background colors to black/white
and activate the Blend Tool. Check the fore-
ground to background checkbox and select
the Shaped (angular) Shape option. You can
now draw your gradient into your chosen. To
produce the white frame, create a new, trans-
parent layer and select it using Ctrl+A. Then
use the Select > Shrink command to shrink
the frame by about 30 pixels (or a different
value that matches the resolution of your
image). Press the X key to switch the fore-
ground color to white and navigate to the
Edit > Stroke Selection command. Here,
 select a Line width of 1 pixel and press Stroke
to confirm. As a final flourish, I inserted the
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thistle’s Latin name – which, you have to
admit, sounds more glamorous than “Great
Globe Thistle”. I then used the Filters > En-
hance > Unsharp Mask filter to sharpen the
thistle a little. 

The original image is included on this
issue’s free DVD in the Sample Images and
Videos section.

Selecting People

So far, so good, but how does Foreground Se-
lect cope with human subjects? We used this
photo to test its capabilities. 

We started by roughly outlining the subject
(below left) and marked the foreground as
explained above (below right). 

The result isn’t perfect, but it will do as a
starting point for a bit of fine-tuning. You can
use a layer mask or the Eraser Tool to remove
unwanted background details.

Selecting Multiple Objects

As already mentioned, Foreground Select can
select several objects simultaneously. 

To do this, activate the tool and outline
the entire image. Then select the Mark back-
ground option. For this example, I also set the
L*a*b* lightness setting to a very high value

to compensate for the very bright back-
ground (see the box Tips & Tricks with Fore-
ground Select on page 64).

Marking part of the background now pro-
duces the usual preview in the image win-
dow. Keep experimenting with the feather

value or the L*a*b* settings until you are sat-
isfied with your results, then press Enter. The
sample photo used here can be downloaded
at www.bigfoto.com.

1. Outline the subject 2. Mark the subject with a few bold  brush -
strokes

3. Press Enter

The Three Basic Selection Steps
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I would like to thank Dr. Gerald Friedland
at the International Computer Science Insti-

tute, Berkeley, USA, who is the main develop-
er of the SIOX plug-in, for his support. More

information is available at http://en.wiki
pedia.org/wiki/Simple_Interactive_Object_Ex
traction. Dr. Friedland recently took part in a
Google Summer of Code project and men-
tored a student who implemented the new
soft segmentation module, which promises
to be capable of selecting objects as fine as
human hair in the near future. The new mod-
ule is earmarked for inclusion in the 2.8 ver-
sion of GIMP.

Foreground Select is a fantastic tool that
produces great results for clearly outlined
subjects. Use it – it’s worth it! (ae/rez)  c

Subjects: Foreground Select is very good at
recognizing and selecting objects that were
clearly photographed as the main subject of
a picture, or which simply stand in obvious
contrast to the background.

Don’t be too precise: Try to err on the
vague side rather than being too precise
when drawing your initial outline, and paint
over your subject using bold brushstrokes.
You can deal with any “holes” in your selecti-
on later.

Marking your selection: Foreground Select
is based on a segmentation algorithm that
requires the user to mark the right colors if it
to function successfully. If you are marking a
portrait, try to include as many different skin
tones and as much hair and clothing as you
can. When marking animals, make sure you
mark the body as well as the head.

Default tool colors: The plug-in uses the
currently active foreground and background
colors in the Toolbox for marking the fore-
ground and background. The plug-in uses
the currently active GIMP preview color as its
semi-transparent background masking color.

Mode: Save your image in RGB mode. If your
image is indexed, convert it using the Image
> Mode > RGB command.

L*a*b*: The tool options include sliders for
making adjustments using the L*a*b* color
model. These are labeled L for Lightness, a
for the red/green tones and b for the
blue/yellow tones. If your subject contains
too much of one particular tone, move the
appropriate slider to the right. This will help
the tool to select the correct parts of the
image.

Tips & Tricks with Foreground Select



65c’t Digital Photography 2 (2011) 

GIMP Master Class | Improving Bad Weather Photos

The sky always plays a significant role in
the overall “weather mood” of an image.

In this example, we want to replace the dark
clouds with clear blue sky and adjust the co-
lors of the mountains to fit the new, tweaked
weather situation.

The two image files we used are also in
the Sample Images and Videos section on this
issue’s free DVD. 

Ideally, you will have a picture of an ap-
propriate sky at hand before you start, but if
you don’t, we explain below how to use GIMP
to produce artificial sky. Open the bad weath-
er image and then open your sky image as a
new layer using the File > Open as Layers
command. The sky image is now on top of
the main image in the layer stack and covers
it completely. The first step involves remov-
ing enough of the sky image to make the
mountains behind it visible.

You may be tempted to simply erase the
parts you don’t need. The problem with this
approach is that it irreversibly deletes the
erased parts, making it impossible to undo
the change if you make a mistake. We prefer
to use a non-destructive layer mask method

to make our adjustments so that we can sim-
ply mask the parts of the sky that we don’t
want to see in our final image.

Before actually creating a layer mask, we
will save ourselves some effort by turning the
boundary between the mountains and the
sky into a selection that we can apply to the
mask. This means that we don’t have to trace
the profile of each mountain into the layer
mask manually. This particular technique
doesn’t always work smoothly for all types of
images, but is usually reliable for images that
show a reasonable degree of contrast.

Creating a Layer Mask
Selection
First of all, hide the sky layer by clicking on
the eye icon next to the layer in the Layers di-
alog. Now switch to the image layer and acti-
vate the Fuzzy Select Tool. This tool automat-
ically selects colored pixels of a similar color –
exactly what we need to select our bad
weather sky.

Activate the Feather Edges option and se-
lect a value between about 3.0 and 10.0. The
exact value will depend on the resolution of
your image. Set the Threshold (color sensitiv-

ity) value to about 22. Now click on
the sky. If everything works out,
the resulting selection will follow

the line between the mountains and the sky.
It doesn’t matter if there are “holes” in the se-
lection. If your first attempt doesn’t produce
the desired result, try again while clicking
elsewhere in the sky, or by clicking on multi-
ple locations while holding down the Shift
key. You can also adjust the size and position
of the selected area by increasing or decreas-
ing the Threshold value and clicking on the
image once again. Once your selection is
good enough, you can create your layer mask

for the good weather sky. Show the sky layer
(by clicking the eye icon) and select the Add
Layer Mask command in the Layers dialog
context menu. Confirm the Selection option.
You should now be able to see the good
weather image filling the spaces outlined by
your selection.

Masking the Bad Weather Sky
with a Layer Mask
Everything that is colored black in a layer mask
completely obscures the corresponding por-
tions of the layer it is linked with, while white
colored areas allow the corresponding image
areas to show through. In our example, we can
“see through” the mountains and the glacier
to the sky layer. Accordingly, gray values in a
mask are semi-transparent and are often used
to apply soft transition effects from dark to
light or from one color to another.

Bettina K. Lechner

How to Brighten up Your 

Bad Weather Snaps
You had a great trip with unforgettable moments, but the weather didn’t play along? 
This workshop explains how to turn your bad weather snaps into wonderful memories. 
To give ourselves the greatest possible processing flexibility, we use layer masks to
make these kinds of image adjustments.
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We have already produced a pretty good
result which we are now going to fine-tune.
Remove your selection using Shift+Ctrl+A and
select the Brush tool in the Toolbox. We will
now use the brush to “free up” the sky. If nec-
essary, press the D key to switch the fore-

ground and background colors back to black
and white, and then press X to switch the
foreground to white. Select a soft-edged
brush size that suits the resolution of your
image and click on the layer mask in the Lay-
ers dialog. The layer mask will then be dis-

played with a white frame to indicate that it
has been selected and the image window will
display a green frame (instead of its normal
black/yellow dotted frame) to indicate that
you are painting into the layer mask and not
into the original image.

Now, using the white foreground, paint
over the sky to eliminate the remains of the
bad weather sky. If your selection includes
parts of the image that lie outside the sky
area – which can happen if the colors are sim-
ilar enough – you will need to paint over the
parts of the mask that are unintentionally

Here’s how to make your own sky using
GIMP. First create a new layer, then click
on the foreground color icon in the Tool-
box and select a dark blue with red 60,
green 107 and blue 174 values. Confirm
this color using the OK button and create a
lighter background blue with red 170,
green 201 and blue 232 values. Now acti-
vate the Blend Tool, select the Radial
Shape option and draw a gradient that co-
vers the whole layer. Take care to check
your bad weather image and to locate the
lighter blue of your gradient nearer the
source of light in the image.

We can now create a few clouds to make
our sky look more interesting. Create a
new transparent layer and select the Fil-
ter > Render > Clouds > Solid Noise com-
mand. Set the Detail option to 1 and the
X/Y sizes to relatively low values (for
example, 1.8 and 3). Now click OK and re-
peat these steps for a second layer using
slightly different values to create more
varied and realistic-looking clouds. Set
the Mode for both sky layers to Grain
merge and Opacity to about 22. You can
also use the Render command to create a
mist-like effect (using a desaturated Plas-
ma effect).

You can now experiment with the opacity
and layer modes of your new layers until
you find a mix of effects that suits your
image. GIMP can also be used to create rea-
listic-looking “classic” cirrocumulus clouds.
To do this, activate the Eraser in the Tool-
box and select the Galaxy, Big brush type.
Reduce opacity, set Scale to 10 and click
once or twice on your rendered sky layer.
You can now merge all of your sky layers to
a single layer by showing them (click the

eye icon) and selecting the Merge Visible
Layers command in the Layers dialog con-
text menu. As all of the new layers are the
same size, you will need to select the Ex-
pand as necessary option in the Merge dia-
log. And that’s it – instant clouds!

And a quick tip: if you have managed to
select the mountains instead of the sky,
select the Invert mask option before you
click OK. If you find that your fuzzy selecti-
on hasn’t worked out as you would have
liked, remove it using Shift+Ctrl+A and se-
lect the White (full opacity) option when
creating your layer mask. You will then see
only sky once you confirm the layer creati-
on action. The next section tells you how
to delete the parts of the new image you
don’t need.

Digital Sky
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white using a black brush. To do this, switch
your foreground color to black (by pressing
the X key) and paint over the details you no
longer want to appear in your mask.

Adjusting Colors

Once you have successfully created your new
sky, you can fine-tune the colors in the rest of
the image to match the brightness of the sun
that was not present in the original. Select
the mountain layer in the Layers dialog and
navigate to the Colours > Hue-Saturation dia-
log. Select Y (for yellow) and move the Light-
ness and Saturation sliders to the right. This
intensifies the yellows in your image. Do the
same for the reds, click OK and then navigate
to the Colours > Colour Balance dialog.

Here, you can intensify the complementa-
ry cyan, magenta and yellow tones for the
shadows, highlights or midtones in your
image. A Shadows adjustment is appropriate
for the dark cliffs in our example, while a Mid-

tones adjustment helps to brighten the
meadow in the foreground. Try to increase
the warm yellows, reds and magentas in the
midtones and highlights, but remember to
use these adjustments sparingly if you want
to keep your results looking realistic. Confirm
your color adjustments by clicking OK and
navigate to the Colours > Curves dialog,
where you can brighten the image highlights
globally by moving the top right-hand end of
the curve slightly upward.

So you see, bad weather is no longer a
reason to keep your camera in its bag, espe-
cially if you are faced with one-of-a-kind
views like this one in the Ziller Valley in Aus-
tria. (ae/rez)

Duplicate the background and position
the copy – with a low opacity value –
above the sky layer you are working on.
This helps to identify the parts of the layer
mask that still need to be painted white.

Tips & Tricks 1

Take pictures of skies everywhere you go
– they often come in handy when you are
merging images or making photomonta-
ges later on. 

Save your skies in a separate folder and
try to collect as many different moods as
you can.

Tips & Tricks 2

c



Bettina K. Lechner

Tuning Your Photos

with GIMP
If you are already a GIMP user, then this article is for you.
It’s the first of an occasional “Get the most from your
photos” series. This installment explains how to produce
impressive infrared color shifts, cross-processing effects,
photomontages, reduced depth of field and professional-
looking postcard layouts.
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Infrared images are usually produced using
special cameras or infrared filters, but can
also be simulated using GIMP. The best pho-
tos to use for your first IR images are well-lit
landscapes, winter shots or urban scenes. The
effect is different for every photo – this is
what makes using it so exciting! The more
you use it, the more likely you are to go out
and purchase an infrared filter for your cam-
era.

Step 1
> Open your image, duplicate the back-
ground layer using Shift+Ctrl+D and rename
it Channel Mixer by double-clicking its name
in the Layers dock.
> Leave the new layer active and open the
Channel Mixer dialog in the Colours > Com-
ponents menu. Take care – the effectiveness
of the entire process is determined by the
settings you make here, although the opti-

mum values vary widely from image to
image. Whatever you do, activate the Mono-
chrome and Preserve luminosity options. The
following values worked well with our sam-
ple image:

Red: 118
Green: 200
Blue: 102

The most challenging part of this step is to
find the right mix for the red and blue chan-
nels, to preserve detail without making the
result too grainy. Keep an eye on the image
preview and use the Magnify button to check
detail close up. Pay special attention to uni-
form shapes like the sky, where image noise
is most obvious.

Increasing the Red and Blue values re-
duces noise and, if the result still lacks detail,
you can further reduce the Blue value to pre-
vent your image from looking too dull. There

are no catch-all settings that we can recom-
mend, but a good starting point for your ex-
periments is:

Red: 40-200
Green: approx. 200
Blue: 100-150

Once you have entered your chosen values,
click OK to close the dialog.

Please note: you can only see the results of
your settings once you have clicked OK. If you
don’t like what you see, use Ctrl+Z to undo
the previous step and reopen the Channel
Mixer to enter different values.

Step 2
>ˇDuplicate the background layer again using
Shift+Ctrl+D and name the resulting layer In-
vert.
>ˇActivate the Invert layer and select the
Colours > Value Invert command. This inverts
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Two Easy Steps to Infrared Effects
Infrared techniques block the transmission of the parts of the visible spectrum that we normally see
and make frequencies beyond both ends of the range visible. Infrared processes produce magical-
looking black-and-white images and fanciful color shifts with a multitude of tones.



only the luminosity values in your image. Set
the Layer Mode to Soft Light and reduce Opac-
ity (perhaps to between 40% and 70%) until
you like the result. And that’s it! If you are still
not happy with your results, try these fine-tun-
ing steps:

Reducing Image Noise 
Duplicate the Channel Mixer layer, place the
new layer between the Channel Mixer and In-
vert layers and reduce its sharpness using Fil-
ters > Blur > Gaussian Blur (for example,
using a Radius value of 9). Reduce opacity to
about 10%. This reduces the noise produced
by the Channel Mixer and softens the overall
effect.

Color Variations 
Instead of using the Value Invert command
described above, use the Invert command
from the same menu. This inverts all color
and saturation values as well the luminosity
values, providing your image with a new
spectrum of colors.
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The GIMP infrared effect 
is easy to use and produces
impressive results

GIMP Master Class | Infrared Effects

Step 1: The settings you make in the
Channel Mixer are the key to successful
infrared effects 

Step 2: The Layer stack before the
luminosity values are inverted to their
complementary values …

… and after applying the IR effect in Soft
light Layer Mode.



Did you read that right? A 1980s style and
contemporary digital photography men-
tioned in the same sentence? Actually, cross-
processing has its origins in analog dark-
rooms, where adventurous types deliberately
used the “wrong” chemicals to develop their

films, using color negative developer to de-
velop slides, for example. The randomness of
the process means that there is no definitive
cross-processing look, but the idea has al-
ways been to produce something that looks
unusual.

Any well-lit image makes suitable source
material for digital cross-processing, but
retro-style images with unusual views (of an-
tiques shops, for example) are ideal. Just
about any portrait shot is also a good starting
point.
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Cross-processing is Back!
Cross-processing is enjoying a revival. The style had its heyday in the 1980s, when
extreme contrast, over-the-top highlights and deep shadows were combined with
bizarre colors to produce a new, contemporary look.

Gaudy, unrealistic colors and over-the-top contrast are typical features of cross-processed images
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Step 1
>ˇOpen your image and, once again, dupli-
cate the background layer using
Shift+Ctrl+D.
>ˇNavigate to the Colours > Curves dialog to
change the hue of the individual color chan-
nels. It is important to keep an eye on the ef-
fects your adjustments have using the image
preview. The look of your results on your own
monitor at home is much more important
than concentrating on using the same set-
tings that we do. Switch from Value to Red in
the Channel drop-down menu and shift the
upper anchor sharply to the left and the
lower anchor sharply to the right. This elimi-
nates the brightest highlights and the dark-
est shadows from the red channel. You can
then adjust the curve to form a moderate S
shape to increase contrast. Don’t worry if
your initial results look a little over the top.
>ˇSwitch to the Blue channel in the same dia-
log and shift the top right anchor down by
one square, then shift the lower left anchor
up by the same amount. This shifts light blue
tones toward red and strengthens the shad-
ows. You can now shift the middle of the
curve down a little to form a light curve.
>ˇSwitch to the Green channel. At this point
you should be starting to get an idea of the
new look your image is taking on. Here too,
you can form an S curve and, if necessary,
shift the highlights a little to the left until the
leftmost tonal values start to increase. This in-
tensifies the greens in your image.

Confirm your changes and click OK to
close the dialog.

Step 2
Switch the Color layer’s Layer Mode to Colour
and duplicate your cross-processed layer
using Shift+Ctrl+D. Switch the new layer’s
Layer Mode to Soft light.

Step 3
Open the Curves dialog for the uppermost
layer and create a moderate S curve with the
Channel option set to Value. This increases
contrast for all color channels simultaneously.

Optional: strengthen the colors
To strengthen individual colors, use the
Colours > Colour Balance dialog. Leave the
Range setting set to Midtones and shift the
first slider toward Cyan, the second toward
Magenta and the bottom slider a little toward
Blue. As already mentioned, these are sample
values that won’t necessarily be applicable
for your own image.

Another way to add an artificial color cast
to an image is to create a new layer at the top
of the stack, using Shift+Ctrl+N, and fill it with
a strong color like magenta (HTML notation:
dc18d5).

A useful trick when filling a layer is to de-
fine your color first and then simply drag the
foreground color icon from the toolbox to
the image window. You can then adjust the
Opacity setting for the filled layer in the Lay-
ers dock until you achieve the right degree of
transparency for your image. A value of
10.5% worked well in our example.

Frame Your Image to Look Like
a Slide
You can give your retro-look image a final
flourish by framing it to look like an analog
slide. To do this in GIMP: right-click the top

layer in the stack and select the New from Vis-
ible command. GIMP then creates a new
composite layer using all the current layers in
the dock. Remove the alpha channel by right-
clicking the new layer and selecting the Re-
move Alpha Channel command. Now all you
have to do is select Filters > Decor > Slide and
enter some text. We used “1980s”. Leave the
rest of the settings at their default values and
click OK. The built-in GIMP script does the
rest.
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Step 1: Altering the curves for the individual color channels – 
in this case, the red channel

The layer stack after step 2 has been
performed

You can use the Colour Balance dialog to
fine-tune individual colors
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Let’s start with a few basic “rules” for making
a successful photomontage:
– Collect all of the images that are relevant to

your subject in a single folder
– Select a background image that has suffi-

cient empty space or unimportant details

that you can cover with your other, more
important details

– Select a single main image and a collection
of smaller details that help to tell your story

– Make sure all of your images have colors
that suit each other. It’s easiest to make a
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A photomontage and the source images 
we used to construct it
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Making Photomontages
A photomontage is like a picture book that has been compressed onto a single
page to tell a story without words. The first challenge lies in selecting source
images that fit together to produce an agreeable finished picture.



successful photomontage using images
taken as a series or on a single shoot.

– If the colors in your images don’t harmo-
nize, you can adjust individual colors later
once you have finished the merging pro-
cess. Desaturating a finished montage
also helps to harmonize mismatched co-
lors.

To keep this article concise, we will show you
how to make a photomontage using simple
layer masking techniques and just four
source images. Use these guidelines as an in-
spiration for making your own, more com-
plex photomontages.

Step 1
>ˇOpen the image you want to use as your
background (here: montage1.jpg) and then
use the File > Open as Layers command (or
Ctrl+Alt+O) to open your second file as a new
layer. 
>ˇClick on the upper layer in the Layers dock
and select the Add Layer Mask command
from the context menu (reached via a right-
click).
>ˇIn the dialog that follows, select the White
(full opacity) option. We will now use the
layer mask to cover the parts of the layer that
we don’t wish to be visible in our final,
merged image. The necessary steps are as
follows:
>ˇPress the D key to set the foreground
color to black and the background color to
white. Painting into the layer mask with a
black brush masks pixels in the upper layer
and allows the background to show
through, while painting white into the mask
has the opposite effect, and “uncovers” al-
ready masked pixels. You can now experi-
ment as much as you like, as this method is
non-destructive, which means that you can
undo any of your brushstrokes at any time
should you mistakenly “erase” the wrong
part of your image. The Brush, Pencil and
Airbrush tools are great for this type of work,
too. The Blend tool is a boon for photomon-
tages, so we will start by using it to create a
smooth transition between our two source
images. We will use the Brush tool later to
fine-tune some details.
>ˇPress the L key to activate the Blend tool.
The default settings create a linear gradient
and use the current foreground and back-
ground colors – in this case, black and
white.
>ˇClick on the layer mask in the Layer dock.
The image preview will now be outlined in
green to indicate that you are working on the
mask and not the original image.
>ˇPlace your cursor where you want the gra-
dient to start – in this case, slightly to the
right of the jeep

>ˇClick in the image and drag a short hori-
zontal line from right to left. This masks the
entire right-hand side of the active layer and
creates a smooth transition between the two
visible half-images. If you are not happy with
your results, simply reposition your cursor
and drag a new gradient using different
lengths, angles and gradient shapes.

Step 2
>ˇOpen the next file (here, montage3.jpg) as
usual using File > Open as Layers or
Ctrl+Alt+O.
>ˇRepeat step 1 to create a layer mask for the
new image. We used a black-to-white blend
gradient to reveal the clear water from the
lower layer in place of the muddy river in the
image on the new layer. Starting at the river
bank, we dragged the gradient to the lower
edge of the bridge.
>ˇWe then used a relatively broad, soft-
edged brush to reveal the jeep. Once again, if
you reveal too much of the lower layer, press
the X key to switch the foreground color to
white and paint over the excess pixels.

Step 3
>ˇLoad the final image (here: montage4.jpg)
and use the Move tool (press the M key to ac-
tivate) to place it in the lower right corner of
the preview frame. The road sign is pasted
onto a homogenous white background,
which makes selecting and cropping it using
a layer mask easier. Activate the Fuzzy Select
tool (press the U key to activate), check the
Feather edges option and set its Radius value
to about 10.0. You can now click on the white
frame around the road sign.
>ˇNow create a new layer mask for the mon-
tage4.jpg layer (using Add Layer Mask in the
layer’s context menu), activate the Selection
and Invert mask options. This switches the
white portions of the frame surrounding the
sign to black, making them invisible in our
photomontage. Confirm your selections by
clicking Add and delete the temporarily
saved selection using Shift+Ctrl+A.

Step 4
Nearly done! The last step involves inserting a
colored layer reminiscent of the dusty red
landscape in a Western movie.
>ˇCreate a new layer using Shift+Ctrl+N and
click on the foreground color in the toolbox
to open the color picker. Enter appropriate
color values (we used Red: 118, Green: 103,
Blue: 103) and click OK to select the new color.
You can now drag the foreground color to the
image preview window. Switch Layer Mode 
to Saturation and set opacity to about 50.
There you have it – a finished photomontage.
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Using the blend tool to create smooth
transitions between the image elements 
on the various layers

Selecting and cropping the road sign using a
layer mask

Using the Brush tool to reveal 
the masked jeep



Most compact digital cameras have relatively
short focal length lenses and, consequently, a
relatively deep field of focus that portrays
subjects in sharp focus from the close fore-
ground to the furthest background. This
makes deliberate, creative use of depth of
field virtually impossible if you are using a
compact camera. This article shows you how
to use GIMP to reduce apparent depth of
field after shooting.

Step 1
>ˇOpen your source image
>ˇDuplicate the background layer using
Shift+Ctrl+D and temporarily hide the copied

layer by clicking on the eye icon in the Layers
dock. Reactivate the background layer.

>ˇThe background layer is where we create
the defocused part of our final image. Se-
lect Filters > Blur > Gaussian Blur and enter
a high Radius value. We used a value of 40
for our 4000 x 3000-pixel sample image.
Select the IIR Blur Method option for faster
processing and click OK to apply the blur
effect. If the effect is not strong enough,
you can re-apply the filter by pressing
Ctrl+F. Shift+Ctrl+F reopens the filter dia-
log if you want to change your selected val-
ues manually.
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Reducing Depth of Field
Adjusting focus is an effective way to steer a viewer’s attention toward the most
important element in an image.

The original image, showing the
entire subject in sharp focus

Reducing depth of field automatically
attracts the viewer’s attention to the parts
of the image that are still in focus

Step 1: As always, we work on a copy of the
background layer. At this stage, the copied
layer is hidden.



Step 2
>ˇShow the upper layer by clicking on the
eye icon in the Layers dock. The preview
image will once again be in focus.
>ˇThe next step involves masking the un-
wanted sharp areas using a layer mask that
allows the blur we have created on the copy
layer to show through. Layer masks are ex-
plained in detail in the Photomontage section
above, so we will only include an outline of
the necessary steps here.
>ˇCreate a white layer mask for the upper
layer and press the D key to switch the fore-
ground color to black and the background
color to white. Then press the X key to switch
these settings (i.e., to make the foreground
color white). Now Press the L key to activate
the Blend tool and set the Shape option to
Radial.

>ˇNow place your cursor where you would
like the center of your in-focus area to be and
drag it to where you want your blur to start.
The line that the tool displays is a radius of
the circle formed by the gradient. Once you
release the mouse button, you will see the ef-
fect your gradient has in the image preview.
The layer mask enables you to adjust the blur
effect and the run of the gradient as often as
you like without actually affecting a single
pixel in the original image.
>ˇYou can further enhance the sharpness of
the in-focus area by applying a couple of
careful dabs with a large, soft white brush
(activated by pressing P) to the area where
the gradient is active.

Step 3
>ˇTo complete the process, we used the Un-
sharp Mask filter to sharpen the entire edited
image. To do this, select the 100% view in the
status bar, as this is the only setting at which
you can adequately judge overall image
sharpness. Instead of the layer mask, select
the image itself in the Layers dock and navi-
gate to Filters > Enhance > Unsharp Mask.
The values you enter here will depend on the
sharpness of your edited image. We didn’t
need to sharpen our sample image too much,
so relatively low Radius and Amount values
of 7.9 and 0.43 did the trick. The greater the
Threshold value, the more blurred the results
will be, and we selected a medium value of

28. Click OK to apply your selected values. Re-
ducing background sharpness is a particular-
ly effective way to accentuate faces in por-
trait photos.
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Use a blend gradient 
in a layer mask to

determine which parts 
of the finished image 
are kept out of focus

Step 3: Sharpening the finished image using
the Unsharp Mask filterThe layers stack at the start of step 2
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Step 1
Select File > New (Ctrl+N) and make the fol-
lowing settings:
>ˇSet the units to millimeters 
>ˇSet Width to 170 mm and Height to 120
mm – these are common postcard measure-
ments. The slight discrepancies between the
values you enter and the values displayed by
the program are due to rounding errors dur-
ing the internal conversion from pixels to mil-
limeters, and can simply be ignored.
>ˇClick the Advanced Options button and set
X resolution to 300 pixels/in – the Y resolution
value will automatically change to match.
Leave the color space set to RGB and select
white as your Fill color. Use Ctrl+S to save
your settings as a template.

Step 2
This is where we prepare the image for use in
our postcard template.
>ˇSelect File > Open (Ctrl+O) to load your
image in a new window. Make any adjust-
ments to color, contrast etc. before proceed-
ing.
>ˇAdjust the size of your image to fit the
postcard layout using Image > Scale Image.
Set X resolution to 300 pixel/in. Now switch
the Image Size setting to millimeters and se-
lect a width of 136 mm. Pressing the Enter
key automatically sets the height to match.
Confirm these settings by clicking the Scale
button.
>ˇThe image is still a little too high. Use the
crop tool to draw a large frame over the en-
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Step 1: Selecting width, height and
resolution settings

Creating Professional-
looking Postcard Layouts
Have you ever looked closely at the postcards that people send you?
The quality of the images often leaves a lot to be desired, but a frame
and some appropriate text can easily turn a sub-standard photo into a
great-looking greeting.



tire width of the image. Here too, you need
to set units to millimeters and a height value
of about 80.
>ˇMove the crop frame to the correct posi-
tion using your mouse and press Enter to
confirm your settings.
>ˇSelecting the Filters > Decor > Add Border
command does just what it says. Set the X
and Y border widths (in pixels) and select a
color. A border adds emphasis to the image
in the finished postcard. We used a 7-pixel
border with the HTML color notation 4e4e4e
and a delta value of 20. The higher the delta
value, the more luminous the border’s color
will be.
>ˇConfirming your border settings by click-
ing OK creates a new Border layer, so you
will need to use the Image > Flatten Image
command to combine the two layers into
one.

Step 3
This step combines the prepared image with
the layout template we made earlier.
>ˇNavigate to your template file in the Win-
dows menu and select your image file in the
drop-down menu at the very top of the Lay-
ers dock.
>ˇNow drag the image icon from the Layers
dock to the empty template in the image pre-
view window.

Step 4
>ˇAs soon as you release the mouse button,
your cropped, framed image will be posi-
tioned precisely in the center of the template.
Switch back to the layout layer in the Layers
dock and use the move tool (M key) to shift
the image toward the upper edge of the

frame. It is quicker and more precise to use
the keyboard instead of the mouse. Pressing
the arrow keys moves the image one pixel at
a time, or 25 pixels every time if you hold the
Shift key down.
>ˇActivate the Text tool (T key) and select a
typeface and type size (in millimeters). Leave
the Hinting and Antialiasing options checked.
Hinting makes text look smoother by adding
pixels to the rough edges of individual letters.
For our caption, we used the same 4e4e4e
color (78, 78, 78 in RGB notation) that we
used for the frame around the image. Select
center justification (the third button) and ex-
tend the character pitch to spread the letters
out. We used a value of 57.
>ˇClick on the text frame, drag it to cover the
entire area below the image to ensure that it
is truly centered and type your desired text
into the editor that automatically opens
when you adjust the frame. You can then
fine-tune the position of the text frame using
your mouse.
>ˇFinally, add a drop shadow to your caption.
Leave the text layer activated and navigate to
Filters > Light and Shadow > Drop Shadow.
We used X and Y offset values of 5, a blur ra-
dius of 15 and an opacity value of 64. Black is
the best color to use for a shadow. Click OK
and your postcard is finished.

You can use the technique described
here with any image you like to make birth-
day cards, Christmas cards, greeting cards or
whatever else takes your fancy. The range of
variations for text size and shape is endless.
One final tip: remember to use the thickest
paper your printer can handle when printing
home-made cards. (keh)
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Step 3: Getting ready to drag the prepared
image …

The final touch: a drop shadow for the
caption

Step 3: … into the empty postcard layout

The layer stack after step 3
The text settings we selected
in step 4 c

Step 2: Scaling and cropping the image to
fit the layout
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Sascha Steinhoff 

How to Reduce

Image Noise
Whether you use a cheap compact or an expensive full-frame
DSLR, your unfiltered image data will always contain a certain
amount of image noise. There are many ways to combat this
phenomenon, but most noise filters have side-effects of their
own. Reducing noise digitally always involves a loss of image
quality, so it is better to reduce noise while you are shooting
if you can.

c’t Digital Photography 2 (2011)



Image noise was never a problem for ana-
log photographers, and the only thing

that produced electronic noise in those
days was the television. The nearest analog
equivalent to image noise is grain, which is
usually used, or even deliberately enhan-
ced, as part of the creative process. Alt-
hough grain is basically an imperfection in
the analog process, no-one ever thought of
trying to reduce it or filter it out. The oppo-
site is true of digital image noise, which is
widely regarded as unaesthetic. Most cur-
rently available digital cameras have built-
in, adjustable noise reduction filters and
there is a whole armada of tools available
for reducing noise during image processing.
The disadvantage shared by most of these
tools is that they involve additional work

that costs time and effort. Once you have
switched on a built-in noise filter, you can
leave it switched on and forget about it.

Noise reduction filters tackle the symp-
toms rather than the cause of noise (for
more information, see the following secti-
ons). Noise usually appears in one of three
forms. The first, called luminance noise, oc-
curs exclusively in the brightness channel
rather than in the color channels of an
image’s data. The degree to which luminan-
ce noise interferes with the photo workflow
depends on the type of output you intend
to produce. Luminance noise is much more
obvious on a monitor than it is in a print
and reducing it also reduces overall image
sharpness.

The second type of image noise, called
color or chroma noise, occurs in the color
channels of an image and is a more signifi-
cant problem, because it directly affects the
quality of print and monitor output. In order
to keep the loss of detail to a minimum, it is
advisable to reduce noise for each color
channel separately.

The third major type of image noise is
hot pixel noise, which is caused by much
the same circumstances as color noise.

In-camera 
Noise Reduction
The noise reduction filters built into most
cameras affect both color and luminance
channels and can usually only be switched
on or off (see also page 88), although some
cameras do offer different strength settings.
As far as we know, there is no camera firm-
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Night shots, with their long exposure 
times and high ISO values, are especially
susceptible to image noise. Applying a noise
filter produces a smoother, more pleasing
overall look.



ware that includes the range of settings and
precise level of user-definition offered by
purpose-built noise reduction filters like
Neat Image, Noise Ninja and Nik Dfine. The
dark frame data used to combat image
noise during long exposures is usually acti-
vated automatically by the camera and can-
not be switched on or off manually.

If you prefer to filter image noise manu-
ally, it will involve extra time and effort du-
ring image processing. Many of the options
available in noise filtering tools, such as
masking, are time-consuming and complex

to apply, so you will have to decide whet-
her the extra effort involved justifies the po-
tential increase in image quality that manu-
al filtering produces.

Other Alternatives to Noise
Filters
Just as with unsharp-masking, the appropria-
te degree of noise filtering depends on our
chosen output medium. Images that appear
clear and sharp on the camera monitor can
actually prove to be noisy and unsharp when

viewed at 100% magnification on a compu-
ter monitor. Luminance noise is not necessa-
rily a problem for print output, so make sure
you really need to reduce noise before app-
lying a filter. Strong filter effects reduce
image detail as well as noise, and can produ-
ce flat, fake-looking images. This type of ef-
fect can actually improve images of cars or
other products, but can produce waxy, artifi-
cial-looking skin if overused in portraits. The
best way to deal with image noise is to avoid
producing it in the first place – the following
pages explain how.
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One of the side-effects of noise
filters is flat-looking skin texture that

tends to make real people look like
shop window dummies
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Care is required when applying noise
filters to portraits, as they often produce
a non-authentic look
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Noise, caused by unwanted interference mi-
xing with the signals that we wish to receive
or transmit, can affect music or moving
images just as it affects digital photos. All
the types of noise that affect digital images
are referred to collectively as image noise.

Both CCD and CMOS image sensors con-
vert incident light into electrical signals in a
process known as the photoelectric effect.
While generally reliable, this effect produ-
ces anomalies under certain circumstances.
Sometimes the sensor simply cannot inter-
pret the incoming light correctly or records

light where none exists. In such cases, the
pixels in the resulting image have the
wrong colors, i.e., the image contains noise.

Dark Noise

Image noise occurs in various forms, inclu-
ding the ambient (or “dark”) noise common
to all image sensors. You can make dark
noise visible if you take a picture in com-
plete darkness. Theoretically, the complete
lack of incident light should produce an
image consisting entirely of black pixels,

but this is not the case. Your image will be
largely black, but will also contain random,
colored pixels. Dark noise is not usually a
problem under normal shooting conditions
and, if sufficient light reaches the image
sensor, the useful signals outweigh the in-
terference anyway.

Dark noise is responsible for most of the
noise produced by image sensors. It is cau-
sed by the “dark current” of electrical sig-
nals that result from the effects of warmth
on the image sensor, which are then falsely
interpreted as light. Dark current can be re-
duced by reducing the temperature of the
image sensor. It is physically possible to use
external means to do this, but the process
involved is technically very complex. No
current compact or DSLR camera has built-
in sensor cooling, and such systems are ge-
nerally the preserve of special astronomical
and scientific cameras. Image sensors in
off-the-shelf cameras simply adapt to the
surrounding air temperature, although ca-
mera features such as Live View also produ-
ce additional sensor heat. Long exposures
subject the sensor to longer periods of
electrical activity and therefore also produ-
ce heat. Simply put: the warmer the sensor,
the more noise the resulting image will
contain, which is why image noise is some-
times also known as “thermal noise”.

Other Sources of Noise

Normal, incident light can cause “photon
noise” if it hits the image sensor in an erra-
tic pattern and causes individual pixels to
record erroneous information. The circuits
that are used to amplify the signals captu-
red by the image sensor can also produce
noise and amplify any interference that is
present anyway. This type of interference is
known as readout noise and is amplified in
direct relation to the strength of the ampli-
fication applied to the original signal. The
electrical signals generated by an image
sensor are amplified only slightly at low ISO
sensitivities, but amplification increases
with increasing ISO speeds, making images
taken at ISO 200 less noisy than those taken
at ISO 1600 using the same camera.

Lastly, there is the noise caused by hot
pixels, which are usually very bright and of
a noticeably different color from the sur-
rounding pixels. Hot pixels are reminiscent
of the broken pixels sometimes found in
LCD monitors but only occur when an
image sensor becomes warm. The effects
dissipate once the sensor cools down. Indi-
vidual image sensor pixels can break, but
are then either dark (dead pixels) or bright
white (stuck pixels).

This is not a picture of a distant galaxy, but rather a digital image taken in complete
darkness using a long shutter speed at ISO 1600. The colored pixels are dark noise, which we
have accentuated for clarity’s sake by digitally increasing the dynamic range of the image.

What Causes Noise?
The basic principle of digital photography is simple: light falls on an image
sensor and is saved as visual information. However, the technical limitations
of the process mean that the results are often less than ideal.

The process of converting incident
light rays into electrical signals isn’t
perfect, and a certain amount of
interference noise is unavoidable.
This picture shows the image sensor
from a Canon EOS 7D.
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This photo was taken in 30-degree heat at ISO 1600 as part of a burst sequence. All of these factors
increase sensor temperature and can cause hot pixels to occur. The hot pixel shown here disappeared
once the camera had cooled down.
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The noise patterns produced by an
image sensor depend on the physical ar-
rangement of its electronic circuits. This

image is a full-frame reproduction of
the noise pattern produced by the

Nikon D70s used in our tests. The rea-
dout amplification circuits are located

at the top left corner of the sensor
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A camera’s image sensor is the major culprit
when it comes to producing digital image
noise, so you should choose carefully when
purchasing a camera. If you are looking to buy
a camera with interchangeable lenses, you will
usually end up using just one size of sensor.
Most current DSLRs use either Four Thirds,
APS-C or larger, full-frame (i.e., 24 x 36 mm)
sensors.

Larger sensors are more costly to manu-
facture, making small sensors the key to af-
fordable DSLRs. The size of an image sensor
also determines which lenses can be used –
an important factor when you consider that

even a modest set of lenses usually costs
many times more than a camera body alone.
For example, if you decide to invest in a
Nikon D90 with its APS-C sensor, you will not
be able to use the same lenses if you later de-
cide to upgrade to a full-frame D700. The
D90’s DX lenses simply cannot cover enough
of the larger image sensor to produce satis-
factory images.

It is said that large image sensors produce
less noise, and some photographers avoid
using particular camera systems for this rea-
son. The real reasons for sensor noise charac-
teristics lie in the way the camera manufactu-

rer uses an image sensor and its circuitry. The
Four Thirds system uses the smallest sensors
currently available on the DSLR market.

Pixel size and pixel density are more im-
portant than absolute sensor size when it
comes to determining the noise characteris-
tics of an image sensor. The number of mega-

Image Noise 
and Sensor Size
“The larger an image sensor, the less noise it will produce” – a
widely-believed rule of thumb – is not entirely true. It is pixel
density, not the absolute sensor size, that makes the difference.

If you increase
resolution for a
constant sensor area,
the pixel density
increases. The less
space a single pixel
covers, the more likely
it is to produce noise.

Comparison of Pixel Densities
Manu-
facturer

Camera Model Camera Type Sensor Size Sensor
Height
[mm]

# of Pixels
(vertical)

Sensor
Width
[mm]

# of Pixels
(horizontal)

Pixel Density
[Pixels/mm]

Sensor
Area [cm2]

Theoretical
Pixel Width
[μm]

Sensor Area 
Proportional to
35mm Frame [%]

Megapixels
(absolute)

Samsung Pixon 12 M8910 Mobile 1/2.5 4.30 3000 5.76 4000 694.44 0.25 1.43 3.86 12.00

Canon G101 Compact 1/1.7 5.60 3312 7.60 4416 581.05 0.43 1.69 4.93 14.63

Canon G11 Compact 1/1.7 5.60 2736 7.60 3648 480.00 0.43 2.05 4.93 9.98

Panasonic DMC-L10 DSLR Four Thirds 13.00 2736 17.30 3648 210.87 2.25 4.75 26.03 9.98

Olympus E-30 2 DSLR Four Thirds 13.00 3024 17.30 4032 233.06 2.25 4.30 26.03 12.19

Sigma DP2s3 Compact Foveon X3 13.80 1768 20.70 2652 128.12 2.86 7.81 33.06 4.69

Canon EOS 550D DSLR APS-C 14.90 3456 22.30 5184 232.47 3.32 4.31 38.46 17.92

Nikon D70s DSLR APS-C 15.60 2000 23.70 3008 126.92 3.70 7.80 42.79 6.02

Nikon D90 DSLR APS-C 15.80 2848 23.60 4288 181.69 3.73 5.55 43.16 12.21

Canon EOS 5D Mark II DSLR 35mm 4 24.00 3744 36.00 5616 156.00 8.64 6.41 100.00 21.03

Nikon D700 DSLR 35mm 4 24.00 2832 36.00 4256 118.22 8.64 8.47 100.00 12.05

Leica S2 DSLR Leica-S 30.00 5000 45.00 7500 166.67 13.50 6.00 156.25 37.50

Hasselblad CFV-39 Medium format Medium format 36.70 5412 49.00 7212 147.18 17.98 6.78 208.14 39.03

Leaf AFi 10 Medium format Medium format 36.00 6000 56.00 9288 165.86 20.16 6.00 233.33 55.73

Anagramm David2 3 Large format Large format 72.00 16000 118.00 26000 220.34 84.96 4.50 983.33 416.00

Anagramm Salvadore 3 Large format Large format 72.00 8000 118.00 13000 110.17 84.96 9.00 983.33 104.00
1 The follow-up G11 model has reduced reoslution but the same sensor size.                                          2 These are scan backs that are used for scanning static objects
3 An unusually large sensor for this type of camera                                                                                            4 For reference

The 35mm format was the dominant format
in analog compact and SLR cameras. In the
digital market, the high costs of producing
larger image sensors have led to a wide
variety of formats competing for acceptance.
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pixels or the physical measurements of a sen-
sor are not particularly meaningful on their
own, but the relationship between the two is
crucial to sensor performance. For example,
the Nikon D90’s sensor packs 4,288 pixels
into its 23.6mm width, giving it a horizontal
pixel density of 4,288/23.6 = 181.69 pi-
xels/mm. Each pixel is therefore 0.0055 mm
(or 5.5 m) wide. Generally, the higher a sen-
sor’s pixel density, the more likely it is to pro-
duce noise. However, it is important to com-
pare sensors of a similar age, as signal attenu-
ation technology is also improving rapidly. 

The table lists models of all classes, from
mobile phone to high-end, large-format cam-
eras. The results are extremely interesting and
prove that technically, the Olympus E-30, with
its Four Thirds sensor, is no more prone to pro-
ducing noise than the Canon EOS 550D with
its APS-C sensor. The Canon has greater reso-
lution but offers no noise-related advantages.
The Anagramm Salvadore scan back has the
lowest pixel density of all our candidates, due
to the manufacturer’s decision to keep resolu-
tion relatively low in relation to sensor size. In
the full-frame DSLR category, the Nikon D700
has lower pixel density than its Canon EOS 5D
Mark II rival, which has a pixel density closer to
that of some APS-C cameras due to its high
(20-megapixel) resolution. Older APS-C cam-
eras, such as the Nikon D70s, have lower pixel
density than newer, full-frame cameras like the
EOS 5D. Many compact cameras have the
highest pixel density of all, due to manufactu -
rers’ use of the smallest possible – and there-
fore cheapest – high-resolution image sensors.

The Canon Powershot G10, with almost 600
pixels/mm, is particularly susceptible to image
noise. Canon has given its successor, the G11,
a sensor of the same size with a third less reso-
lution, and the results it produces prove that
this was a wise decision. Small sensors do not
produce low-quality images per se, but are

nevertheless not suitable for producing
poster-sized prints. All types of cameras pro-
duce less noisy images if sensor resolution is
chosen to suit sensor size. The Canon G11 is
evidence of a trend reversal that we hope
more camera manufacturers will soon be fol-
lowing.

Canon squeezed 15
megapixels onto the 1/1.7”
sensor in its Powershot G10

model. The follow-up G11
model has a third fewer
pixels on a sensor of the

same basic size. 

APS-C vs. Four Thirds: Canon continues to follow the trend of increasing resolution 
in its consumer DSLRs. The Rebel T2i/EOS 550D's high resolution means that it has the same pixel density as the Olympus E-30 Four Thirds
camera. In this case, the higher pixel density cancels out the nominal advantage of a greater number of pixels.
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The in-camera noise reduction systems built
into early DSLRs didn’t have a particularly
good reputation. The algorithms used were
not highly developed and camera hardware
was still quite rudimentary. Serious photogra-
phers tended to shoot RAW images and redu-
ce noise later using the superior performance
offered by computer-based processing. Even
now, photographers who shoot JPEG images
still have to accept a degree of automatic, in-
camera noise reduction as part of the simpler
JPEG workflow. 

Nowadays, most cameras have higher-per-
formance hardware and improved noise re-
duction algorithms built in, but these factors
alone still don’t entirely explain the astonis-
hing performance of the latest Canon or Nikon
DSLRs, which both use a combination of vario-
us types of noise reduction.

On-chip Noise Reduction

The recent move from CCD to CMOS image
sensors, typified by the difference between
Nikon’s D70s and D90 models, has one disad-

vantage, namely: CMOS sensors are noisier
than CCDs. Camera manufacturers are now
busy trying to stamp out noise at the sensor
level and Canon has already published an ex-
tensive white paper on the subject (see the
link at [1] below).

The Canon method uses an additional
transistor for each pixel to help separate in-
terference from the usable signal, which
means that output from the sensor has al-
ready been filtered for noise. This process
cannot be switched off by the user. While
Canon manufactures its own image sen-
sors, other manufacturers purchase their
sensor chips from third-party suppliers like
Kodak or Sony, who also build their own
proprietary noise filtering technology into
their products. 

Long Exposure Noise

Dark frame noise reduction is the most com-
mon type of on-board noise reduction and is
often used during long exposures as these
are, by nature, more prone to noise. This

technique causes the camera to automatic-
ally generate a second, separate image, cal-
led a dark frame, after the actual exposure.
The dark frame is produced using the same
ISO and exposure settings as the image it-
self, but without the effects of incident light
on the sensor. This doubles the time requi-
red to make a long exposure. Once the dark
frame is stored in the camera’s buffer me-
mory, the firmware subtracts the dark
frame’s pixel values from the image data,
thus effectively reducing noise in the finis-
hed image. Like other noise filtering proce-
dures, dark frame noise reduction can lead
to a loss of image detail. Some cameras
allow you to switch off the dark frame me-
chanism – the Nikon D70s doesn’t allow for
separate configuration, while the D90 has a
menu item for switching the dark frame off
during timed exposures. You can, of course,
simply switch off your camera after the first
exposure but before the dark frame is recor-
ded. The camera will then only save the data
that is already present in the data buffer.
French astrophotographer Christian Buil dis-
covered this method and named it “Mode
3”. In any case, our D70s doesn’t generate a
dark frame for exposures that are longer
than 30 seconds.

Generate your own Dark Frame

If you don’t have complete faith in your ca-
mera’s systems, you can also generate your

In-camera Noise Reduction
RAW image files are widely believed to contain “pure” image
data, but even high-end cameras rarely save images without
subjecting them to some built-in processing.

Input:
optical signal

Output:
optical signal only

Readout: optical signal and noise

Noise recognition
Noise reduction

Many camera manufacturers
build noise reduction circuitry
into their image sensors. 
Canon uses additional
transistors to separate 
usable signals from noise. Ill
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own dark frame and manually subtract it
from your image data. Dark frame techniques
can produce clear improvements in image
quality, especially when combined with sta-
cking techniques that superimpose multiple
images taken using varying exposure values
(see the link at [2]  below).

This involves producing a sequence of
images and a corresponding sequence of
dark frames while keeping the camera in
exactly the same position. Generally, the
more images you stack, the more complex
the merging process will be, but the quality
of your results will improve accordingly.

Astrophotographers often use stacking
techniques to improve their results (see the
link at [3] below). Although painstaking, sta-
cking is better at reducing readout noise than
even a cooled image sensor.

High ISO Values

Low noise at high ISO values is a killer feature
in any digital camera and, as a result of im-
provements in sensor technology and firm-
ware-based noise filters, today’s cameras pro-
duce less noise at ISO 6400 than their prede-
cessors did at ISO 1600. Reduced-noise
images often look cleaner, but sacrifice sharp-
ness and authenticity. Sony, Canon and

Olympus only allow you to switch their noise
filters on or off, while Nikon’s latest cameras
offer various noise filter options. When asked,
Nikon also confirmed that some automatic
noise filtering takes place at certain ISO set-
tings. Note that sensor-level filtering takes
place independently of any menu-driven set-
tings.

RAW Processing

In-camera noise reduction doesn’t only af-
fect JPEG image data; it is often sampled
into RAW data too. The processes used to
apply in-camera noise reduction vary from
manufacturer to manufacturer and from
model to model. For example, Nikon doesn’t
allow its users to switch off sensor-level
noise reduction and claims that the feature
simply produces better images. The dark
frame is irreversibly integrated into the
RAW image file (Nikon’s RAW format is cal-
led NEF). If activated, the same is true of Ni-
kon’s High ISO noise filter, and once a NEF
file has been de-noised, it stays that way.
Basic noise filtering is active for every
image file anyway, but you can still use a
RAW editor to perform your own fine-
tuned noise filtering in addition to any fil-
ters applied automatically. 

Limited Choice

The idea that RAW image data represents
the “pure” form of the light hitting your
image sensor is becoming less and less ap-
propriate as technology advances and ca-
mera manufacturers build increasingly so-
phisticated automatic noise filters into their
products. These usually produce better re-
sults than non-filtered systems, but we
would still like to see them as an option rat-
her than a hard-wired necessity. Currently,
camera manufacturers tend to decide what
is good for consumers without giving them
any choice in the matter. A quick look at
some of the more popular Internet forums
reveals that this trend is not necessarily a hit
with consumers.

Useful Links

[1]ˇCanon CMOS Whitepaper: www.usa.
canon.com/uploadedimages/FCK/Image/
White%20Papers/Canon_CMOS_WP.pdf

[2]ˇAstrophotography, Nikon vs. Canon:
www.astropix.com/HTML/I_ASTROP/
NIK_CAN.HTM

Dear Reader,

Digital image noise is a terrible thing and
should be eliminated by every means pos-
sible!

This mantra can be heard on an almost
daily basis from various camera manu-
facturers, and is repeated blindly by the
media and many consumers. While the
number of megapixels alone defines the
quality of consumer-level cameras, a cam -
era’s noise characteristics are the make or
break selling point for enthusiasts and pro-
fessionals. The less noise a camera produ-
ces, the more high-end fans it will have.
The continuing image noise debate is a
blessing for camera manufacturers and
keeps the market for improved technology
alive in times when ever more megapixels
no longer loosen consumers’ grip on their
wallets. 

Nikon’s “improved noise reduction” argu-
ment persuaded large numbers of users to

upgrade from the D70s to the D200. But
why did the D200’s largely identical sensor
produce so much less noise than its prede-
cessor? The answer lay in its improved
noise filter circuitry. Whether this represen-
ted a dramatic improvement for the D200’s
proud owners is a matter of conjecture, as
we assume that they mostly shot in RAW
anyway. This particular discussion finally
ended two years later with the introducti-
on of the D300. And guess what had been
improved in the D300? I'll give you a clue: it
begins with “n” ...

Personally, I am not a big fan of noise re-
duction per se, and complete elimination
of noise produces the super-smooth, artifi-
cial-looking images that many critics of di-
gital imaging decry. Waxy looking por-
traits and product photos that look far bet-
ter than the products themselves are often
the result of over-enthusiastic noise re-
duction. I like to have the option of swit-

ching noise filtering off, but in today’s
market, I can want as much as I like – even
a “purist” camera like the Leica M9 forces
its owners to filter long exposures for
noise. Not that I question the competence
of the Leica engineers, but RAW means
raw, and that’s how I like my image data
served up. Pre-filtered is like pre-chewed
and I don’t like the taste of either! Whet-
her or not to maltreat my image data later
using software remains my own decision.
Maybe in future I will simply ignore noise
filters altogether and declare image noise
to be a cult phenomenon – that way at
least I’ll have time to get out and take
some photos.

All the best from Bangkok
Sascha Steinhoff

The Right to Generate Noise

Image Noise | Reduction and Prevention
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If you feel you need to use an in-camera or
software-based noise filter it is probably too
late, as this usually means your image is alrea-
dy noisy. There are, however, various ways to
avoid producing noise artifacts in the first
place – prevention is not only the most ele-
gant way to avoid image noise, but also pro-
duces the best results. 

First, protect your camera from excessive
warmth. Most digital cameras are designed
to function properly in a temperature range
of 0–40 degrees Celsius (32–104 degrees
Fahrenheit), and it is generally true that the
cooler the image sensor is, the less noise the
resulting images will contain. Even if you

cannot directly influence the ambient tem-
perature, you can protect your camera from
excess heat. The interior of a car can quickly
heat up to over 50 degrees Celsius (122 de-
grees Fahrenheit) in summer, so do not leave
your camera in the glove compartment of
your car in warm weather. Always take it with
you if you can. 

The longer an image sensor is in use, the
warmer it becomes, so using shorter shutter
speeds helps to avoid producing too much
sensor heat. The same is also true if you are
shooting in burst mode, although bursts
have to be long and the additional shooting
conditions fairly adverse before they really
make a difference to the noise levels in your
images.

Live View allows you to view a scene di-
rectly as it will appear in the photo, either via
the camera’s monitor or its electronic
viewfinder (if it has one). Most current com-
pact cameras do not have viewfinders and
the latest EVIL (Electronic Viewfinder Inter-
changeable Lens) cameras have purely elect-
ronic viewfinders. The disadvantage of this
type of design is that the image sensor is
active the whole time an image is being vie-

Useful Tips for 
Reducing Image Noise
Even if it’s impossible to eliminate image noise completely, there 
are still various ways for digital photographers to influence the noise
characteristics of their images during shooting.

Subsequent image brightening
amplifies noise artifacts, so it is always

better to expose your original image 
for longer rather than relying on

adjustments you make later
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wed, which produces unnecessary sensor
heat. Thirty minutes of Live View usage are
usually enough to seriously deplete a came-
ra’s battery and to produce additional, un-
wanted image noise. Always switch off Live
View during long sessions to save battery
power and avoid producing additional heat-
related noise.

Camera Specifications

Pixel density is an important factor in the
chain of events that cause image noise. Once
you have decided which camera you wish to
purchase, you cannot alter the pixel density
of the built-in image sensor. High resolution
combined with small sensors automatically
produces more noise than large-sized, low-
resolution sensors. The relationships bet-
ween sensor size, sensor resolution and

image noise are described in detail on page
136!!!. Once you have chosen a camera, you
can still influence noise levels by shooting at
lower ISO speeds. The lowest speeds offered
by your camera (usually ISO 100 or 200) will
produce the lowest noise levels, but require
more available light to make exposures.
Bright, wide-aperture lenses are heavier and
more expensive than other lenses, but allow
more light to reach the sensor in low-light si-
tuations. Generally, image detail suffers at
wider apertures, so a standard 50mm f/1.8
lens will produce its best image quality at a
medium aperture of f8 or f11.

Four Thirds cameras offer no gains in
image detail through stopping down. The 2x
crop factor doubles the format’s depth of
field in comparison with traditional 35mm ca-
meras. The amount of light that reaches the
sensor is doubled (or halved) with each f-

stop, and the mathematical difference bet-
ween f-stops can be calculated by multiply-
ing the previous value by the square root of
2. If you replace an f/2.8 lens with an f/1.4
model, you gain two f-stops – in other words,
four times as much light reaches the sensor). 

Choosing the Right Exposure
Values
You can also influence image noise levels by
adjusting your exposure values. Many digi-
tal cameras, typified by the Nikon D70s, tend
to slightly underexpose, producing fewer
highlights than an image can usefully bear.
If you adjust the dynamic range of an under-
exposed image to brighten its highlights,
you also automatically strengthen any noise
artifacts present in the image data. Experi-
ence has shown that it is better to adjust ex-
posure slightly upward than to attempt to
adjust underexposed shadows and high-
lights later. Making sure the image histo-
gram is exposed slightly “to the right” is
often a better option and makes subsequent
brightening unnecessary.

Aperture Steps
Common f-stops Arithmetic equivalent
f0.5 0.5
f0.7 0.71
f1 1
f1.4 1.14
f2 2
f2.8 2.83
f4 4
f5.6 5.66
f8 8
f11 11.31
f16 16
f22 22.63
f32 32

Live View is a really useful feature,
especially when combined with a
tiltable monitor. However, having it
on all the time will increase the
amount of noise in your images.
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The range of focal lengths covered by
the 18-55mm f/3.5-5.6 and 17-55mm
f/2.8 Nikkor lenses are almost identical,
although the brighter lens – at US$1,350
– costs nearly six times as much as the
cheaper model. The more expensive lens
has much wider apertures at longer focal
lengths, but offers no real advantage 
at the shorter end of the scale.Im

ag
e:

 N
ik

o
n

Image Noise | Tips & Tricks

c’t Digital Photography 2 (2011) 91



Astrophotographers lead a tough life. Not
only do they have to stay awake all night, but
they also have to get their cameras to do all
sorts of things they weren’t designed for.
Hours-long exposure times and a subject that
is basically black (i.e., the night sky) are a per-
fect recipe for producing a lot of image noise.
And image noise is exactly what we don’t
need when we are trying to portray distant
galaxies, due to the simple fact that errone-
ous pixels look a lot like stars. For the same
reason, software-based noise reduction is a
risk for astrophotos because it is all too easy
to unintentionally filter out individual stars
along with image noise. 

The only sure-fire way to reduce image
noise in astrophotos is to build an active coo-
ling element into your camera. Some came-
ras – the Hasselblad H3DII, for example – use
passive cooling to dissipate heat from the
sensor via the camera body. The disadvanta-

ge of passive cooling is that it only reduces
excess heat. It is, in fact, much more effective
to actively reduce the sensor temperature to
below that of its surroundings.

Less Heat, Less Noise

None of the major camera manufacturers in-
clude actively cooled image sensors in their
range of products. Active cooling is still the
preserve of scientific applications, although
Canon did briefly manufacture and sell the
special astrophotographic EOS 20Da, with a
modified low-pass filter and early Live View
focusing aids. The 20Da’s sensor neverthe-
less remained uncooled. In spite of the in-
dustry’s apparent disinterest, there is a flou-
rishing worldwide community of astrophoto-
graphers who build and operate their own
sensor cooling systems. Operating tempera-
tures of as little as –20°C have been widely

reported, although these do require a great
deal of additional energy if they are to be
consistently effective.

Home-made vs. Factory-built

There are several factory-built sensor coo-
ling solutions available. One example is Cen-
tral DS in South Korea (www.centralds.net),
who build and sell actively cooled versions
of the Canon EOS 400D and EOS 50D mo-
dels. Sensor cooling can be achieved either
by cooling the entire camera, which is simp-
ler to achieve, or by cooling just the sensor,
which involves taking the camera apart. The
simplest of all cooling methods is to use a
portable beer cooler with a hole cut in it for
the camera’s lens but since this approach se-
verely restricts camera handling, targeted
sensor cooling is a more practical and ele-
gant solution.

Modification techniques vary, but the
basic principle involves dismantling the ca-
mera so that the back of the sensor is expo-
sed. It is theoretically possible to mount a
cooler directly on the sensor, but that would
severely hinder use of the viewfinder and the
camera’s other controls. Most practical soluti-
ons involve the use of a metal bridge or heat
pipe to transfer heat away from the sensor.
You can attach such a “cold finger” to the

Camera Modding – 
Build in a Sensor Heat Sink
If you cannot reduce image noise enough using the conventional
methods described above, you can, as a last resort, build a heat
sink into your camera. This type of accessory is, as yet, the
preserve of specialist applications such as astrophotography.

It is easy to try out the effects of sensor
cooling for yourself. Simply wrap your ca-
mera in a towel and put it in the freezer for
an hour or two. This is the method we used
to produce our test photos. However, the
cooled camera quickly reaches room tem-
perature once you start shooting, making
this particular technique unsuitable for lon-
ger sessions. You also need to take care
that your camera doesn’t warm up too
quickly, causing water to condense inside
the camera’s body. The greater the diffe-
rence in temperature between the camera
and its surroundings, the higher the humi-
dity will be, and the more likely it is that
water will condense in or near the camera.
The freezer effect also occurs if you shoot
outdoors in winter, but both situations are
outside the manufacturer’s recommended
usage scenario. Nikon and Canon both re-
commend operating temperatures of 0–40
degrees centigrade, which effectively
equates to a recommendation not to shoot
outdoors in winter!

Deep-freeze DSLR

Our test scenario: a five-minute long exposure made at ISO 1600 in complete darkness using
a Nikon D70s. At +30°C, the image displays strong noise and a large number of bright red
hot pixels. Noise and hot pixel incidence are visibly reduced at –5°C. We used an identical
tonal shift to make both effects visible in print. 
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back of your sensor using thermally conducti-
ve paste, allowing you to position the heat
sink or cooler beside or below the camera
body. This type of solution usually also invol-
ves modifying the camera back to accommo-
date whichever type of heat bridge you are
using.

Peltier Devices

Peltier devices are the most popular image
sensor cooling solution and are constructed
using a special type of thermocouple that
produces heat at one end and absorbs it at
the other when an electrical current is pas-
sed through it. Peltier devices are compact
and highly effective, but unfortunately not
very efficient. Because they use a lot of
power they have not been able to establish
themselves in the computer CPU cooling
market. A Peltier device requires a power
outlet to function properly, which seriously
reduces mobility for Peltier-cooled cameras.
You can make a Peltier device more efficient
by attaching a conventional heat sink and a
powered fan, just like in a computer. Once
you have set up your cooing system, all that
remains is to switch on the electrical current
and to cool your image sensor to the desired
temperature. 

Any cooling system is potentially useful in
a photographic context. For example, the
website at www.ledametrix.com/co2 de-
monstrates a camera cooling system based
on liquid CO2. Solutions based on liquid ni-
trogen are also feasible.

Conclusions

In spite of the obvious improvements in noise
levels it can produce, practical and technical
limitations make active sensor cooling un-
suitable for widespread use. Active cooling

has been an integral part of specialized appli-
cations such as scientific or astrophotogra-
phy for years, but is simply not of enough use
to be of interest to the photographic public
at large.

We would like to see camera manufactu-
rers put more effort into developing practi-
cal passive cooling systems for their image
sensors, but they currently seem more inte-
rested in selling cameras with Live View
functionality and electronic viewfinders,
both of which contribute to increased sen-
sor heat. (anm) c

Active sensor cooling requires a high
degree of electronic know-how. This

illustration demonstrates the
principles of such a system. Im
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The website at http://ghonis2.ho8.com/
rebelpeltier.html includes detailed
descriptions of the advantages and
potential pitfalls of modifying a Canon 
EOS DSLR with a Peltier device

Im
ag

es
: w

w
w

.a
st

ro
kl

au
s.

d
e

Image Noise | Camera Modding

c’t Digital Photography 2 (2011) 93



94 c’t Digital Photography 2 (2011)

Ralph Altmann

Remote Triggers for
Digital Cameras

You don’t have to be a wildlife photographer to know that the best position 
for the camera is not necessarily the best position for the photographer.
Remote control can improve the situation. This article explains the technical
possibilities not only for releasing the shutter from a safe distance, but also for
completely controlling digital cameras remotely, either by wire or wirelessly.



When using digital cameras, effort and
success are sometimes only moments

apart – the image appears on the display a
split second after taking the picture, and it
only takes a little longer to print the pictures
or transfer them from the memory card to a
computer. However, sometimes this isn’t re-
ally convenient or fast enough. For studio
photographers it isn’t enough to have the
result on the display. They often want it
right on the computer’s monitor without ha-
ving to take the memory card out of the ca-
mera and plug it into the computer. Sport
and nature photographers need to be able
to be physically detached from the camera
at times, for various reasons. The ideal posi-
tion for the camera may be too uncomforta-
ble or too dangerous. In some cases the pre-
sence of the photographer would make it
impossible to take the picture, for example
with shy animals. Still, all of the camera’s
functions should remain controllable and, if
possible, the image should be transmitted.
This is no longer a problem as many SLRs
have a live preview.

Almost all cameras have a data interface,
which is usually a miniature USB socket. Ho-
wever, a USB cable merely makes it possible
to transmit images to a computer, so that you
don’t have to remove the memory card. Ca-
mera manufacturers only allow for higher
communication capability in their digital
SLRs, and even then, sometimes only in top-
of-the-line models. The CHDK program
(Canon Hack Development Kit), which can be

used to retrofit several of Canon’s compact
cameras with a USB remote control, shows
that this is only a question of firmware and
therefore, of the manufacturers’ will.

A few compact cameras have the ability to
transmit images to a computer over wireless
LAN (mostly designated as Wi-Fi) at the out-
set. Other cameras can use a special SD me-
mory card with an integrated Wi-Fi chip, alt-
hough this requires that the camera has an
SD memory slot. These cards are available
under the Eye-Fi label and cost between
US$50 and US$150 depending on the versi-
on. It is more of a marketing strategy than a
matter of necessity that Eye-Fi offers so many
different versions. Only the most expensive
Pro versions can transmit RAW files and allow
ad hoc connections. However, memory cards
have a rather limited range; in cameras with a
metal body, it may be just a few feet. It is not

possible to control the camera remotely
using this kind of memory card.

USB Remote Control

All that is required to trigger the camera is a
signal in its direction. In comparison, a full-
fledged remote control needs the commu-
nication to run in both directions. This is ne-
cessary so that at least the current camera
settings can be displayed on the computer.
The camera has to provide this information
at the USB interface. It should also provide
the Live View display at the same time. The-
refore, the computer as a controlling device
needs to have the right software. Most ma-
nufacturers offer both software and remote
control, but only for their high-end came-
ras. Sometimes the remote control software
is not included in the package and has to be
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Behind the casing of
these the small SD
memory cards you will
find full-fledged
wireless electronics.
The transmission only
goes in one direction,
from the camera to
the computer.

The wireless USB
transmission is the
only wireless item

on the computer
side of the setup.

The adapter has
to be connected

to the camera and
a power supply.



bought separately. For Nikon’s Camera Con-
trol Pro 2 you need to spend around
US$180. For Canon DSLRs the software EOS
Utility, which comes with the camera, takes
care of the remote control.

The connection between camera and
computer is achieved quickly and without
any installation via USB cable. The cable
can be up to 16 feet long. Larger distances
can be reached using USB repeaters that
provide an additional 16 feet of signal
strength each. The maximum number of
amplifiers permitted in series is five, accor-
ding to USB specifications. Together with
the first passive cable, this equals a length
of 96 feet. Plugging more together might
work, but success is not guaranteed. Using
special USB Ethernet adapters and a net-
work cable, you can reach distances of up
to 197 feet and more. If the network and
adapters are designed for Gigabit Ethernet
(as with the Silex SX-3000GB) such a con-
nection can easily compete with USB 2.0 in
terms of speed.

USB Wireless

Wireless USB was launched in 2005 with the
intention to replace the USB cable connecti-
on. It was predicted that the wireless standard
would have a big future. However, wireless
kits are still rather scarce. We tested Hama’s
“Basic” Wireless USB Starter Kit. The Hama
model is difficult to find in the US, but Belkin
make similar models which are available for
around US$60 at retail stores. The kit compri-
ses two USB sticks with swivel-mounted plugs
and a small port docking station, including an

AC adapter. The USB peripheral device is atta-
ched to the docking station, as it probably
won’t have its own power supply. Therefore,
this solution isn’t entirely wireless, since the
starter kit needs a socket nearby. With a little
skill, you can make your own power supply
with four mignon (AA) rechargeable batteries,
which can be integrated with the camera USB

stick in a small housing. Instructions are avai-
lable at: http://ip-networx.de/index.php?opti
on=com_content&task=view&id=39. Or see
here: http://faq.d-r-f.de/wiki/Bild:Kl_wusb1.jpg
for a lithium ion battery alternative. According
to the author, the battery charge can last for
the transmission of almost 1000 pictures,
while the camera battery is used up much
more quickly.

The disadvantage of wireless USB is its
short range of about 30 feet. The highest
transmission speed of 480 Mbit/sec can only
be reached within a 10-foot range. In the case
of larger distances, the transmission rate
drops to 110 Mbit/sec. In our experiments,
the Hama wireless kit had a range of only 15
feet. The Live View transmission rate dropped
to almost half the cable transmission speed
and the image was quite jerky. 

Not even 110 Mbit/sec can be achieved in
practice. We actually reached similar trans-
mission rates with the wireless LAN 11.g – at
least this was the case when we tested it at
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This is what the “wireless” configuration
using the Belkin “Home Base” USB WLAN
adapter looks like in practice. Here, too, 
an outlet is required to supply power to 
the adapter.

The USB wireless LAN adapter can integrate up to 15 USB devices into a wireless home
network. This picture shows the Silex SX-2000WG.
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distances greater than 10 feet. So why not
use the wireless LAN in the first place? The
wireless network can be used over greater
distances, is available almost everywhere
and, most of all, it is technically mature. A
special USB wireless LAN adapter is necessa-
ry on the client side (camera), to transmit the
USB signals transparently over the wireless
network. The software on the host side (com-
puter with wireless LAN or connection to a
wireless LAN router) ensures that this con-
nection appears as if it were a USB interface
to other programs. There is a wider range of
wireless LAN adapters than wireless USB
adapters available on the market, but none
of them are designed for mobile use, as they
have a relatively large  housing that contains
a lot of air and several USB ports. In compari-
son, Belkin’s “Home Base” (for around US$70)
is a nicely designed flat box with four USB
ports to which 15 more USB devices can be
attached via additional hubs, and already
supports the new wireless networking stan-
dard, 11n. Moreover, configuration, inclu-
ding the security settings, is surprisingly
simple. Simply attach the device to the
router with the LAN cable, select the network
and you’re done. Selecting the WPS button,
if the router has one, is even faster.

When a camera is attached to the Home
Base it appears as a removable media device
or multimedia device in Explorer or the Fin-
der, depending on which USB setting (mass
storage or MTP/PTP protocol) you have se-
lected. The remote programs work with this
constellation in the same way as with a USB
cable connection, except that the transmissi-
on speed is slower. As long as the host com-
puter is connected to the Internet you can
upload pictures to Picasa or Flickr. Silex’s USB
Device Server SX-2000WG is rather more ex-
pensive at around US$150 retail.

You can connect up to 15 devices to the
network using a hub to just one USB port. Ho-

wever, the Silex USB device does not yet sup-
port the fast 11n wireless standard. 

It was possible to install rechargeable bat-
teries as a replacement for the power supply
in both of the USB wireless LAN adapters we
tested. The Silex SX-2000WG offers the best
specifications, with its 5V supply (Belkin
Home Base:12V). However, USB wireless LAN
adapters use more than twice as much power
as Hama’s wireless USB adapter.

Wi-Fi: Fire without Wire

To our knowledge, only Nikon and Canon
offer wireless remote control for some of
their top-of-the-line DSLRs. The technology is
either integrated in an adapter, which is scre-
wed into the camera, or is a small device with
an antenna that is then connected via a USB
cable. There is enough room in the device for
additional rechargeable batteries to power

the wireless network electronics. We took a
closer look at two such devices.

Nikon WT-4

Nikon’s external wireless adapter WT-4 is at-
tached to the camera via a short USB cable
and can therefore be used for several Nikon
cameras. The included software allows you to
browse the saved images and transfer them
wirelessly to the computer or FTP server. In
order to use the remote control, you will have
to purchase and install the program Nikon
Camera Control Pro. The communication
with the camera has to be installed using the
“WT-4 Setup Utility”, which is part of the kit.
Make sure you manually download the latest
update from the Nikon website, as in our test
the “Nikon Message Server” didn’t recognize
that updates were available or rather, didn’t
install them correctly and, as a result, failed to
communicate with the D700.

The WT-4 can be attached to a belt with a
device bag (special accessories). Power is sup-
plied by a rechargeable lithium ion battery, EN-
EL3e, the same type of battery used by several
of the supported camera types. The WT-4 can
also get its power supply from a separate
power supply unit. It is not possible to supply
power to the WT-4 via the camera. The packa-
ge does not include rechargeable batteries, a
charger or an AC adapter, so these have to be
purchased separately. 

The WT-4 transfers data using the protocols
IEEE 802.11a, b or g, which allows for maximum
outdoor transmission distances of up 150 yards
and data transfer rates of up to 3 Mbytes/sec.
Up to 5 cameras can be set up in a wireless net-
work (each camera with its own WT-4). There is
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Nikon’s separate wireless adapter WT-4, the camera-specific adapter WT-2 (for the D2x,
middle) and WT-3 (for the D200, right)

The back of Canon’s 
5D Mark II including 
the attached wireless
adapter and the
connecting options



also an Ethernet connection (10Base-T and
100Base-TX) available, which allow you to di-
rectly implement the cameras in wired net-
works. It does not have another USB port for
connecting GPS devices. 

The WT-4 seems to work similarly to the
USB wireless LAN adapters. One might therefo-
re assume that it would work with other Nikon
cameras and maybe also with those of other
manufacturers. However, the WT4 setup utility
on the host computer does not allow this. It
does not even recognize those Nikon cameras
that can be controlled remotely via a USB
cable. According to Nikon, the WT-4 can only

work with the following cameras: the D300 se-
ries, the D3, D3x and D700. Nikon also offers
two camera-specific wireless adapters for the
D2x and D200, the WT-2 and WT-3. Both can be
screwed tightly to the bottom of the camera
body.

Canon WFT-E4 II

All Canon wireless file transmitters (WFTs)
are camera-specific. There is no adapter
available that fits all Canon cameras but, at
the end of last year, Canon extended the
range or adapters for the DSLR cameras 1D
Mark IV and the 5D Mark II. The WFT-E4 II fits
to the latter camera and can be screw
mounted to the bottom of the camera body.
Note that the adapter requires its own re-
chargeable battery (type LP-E6 Lithium-ion
battery pack, the same as in the camera
body) and has a display for status informati-
on. This device transmits data using the pro-
tocols IEEE 802.11a, b or g. If you prefer, the
data can also be encrypted. An Ethernet port
allows integration in conventional wired
networks (10Base-T and 100Base-TX). A
Bluetooth or GPS device or an external hard
drive can be attached to an additional USB
port. If you have access to an FTP server, you
can transfer the images automatically to a
pre-selected file. It is possible to filter the
different media types. This is a great feature
for working in a studio. Photographers like
to work with RAW files, due to their higher
quality. However, because they are very
large, they take a long time to transmit. The
solution is RAW+JPEG. Select this combinati-
on and within this setting the smallest JPEG
size, which in a 5D Mark II is still over 5 me-
gapixels. Even large DTP monitors can bare-
ly reproduce half of that resolution. If the
preview image doesn’t need to be of the
highest JPEG quality, then you can reduce

the files sizes to just over 1MB, which increa-
ses the transmission speed. Transmission
then takes less than one second. When the
correct filter is used, only the JPEG file is
transmitted, while the 25 MB file remains on
the memory card, so you have a large format
image on the display moments after expo-
sure. Unfortunately this media type switch
doesn’t exist in combination with the came-
ra’s remote control modes.

The 5D/WFT combination offers two of
these remote control modes, which, just as
with FTP transmission, can be found among
the connection methods in the wireless set
up. The “EOS Utility” requires the correspon-
ding software as the host application and is
delivered with every EOS camera. Before-
hand, the wireless LAN connection between
the camera and the computer must be
established using a pairing driver. This is usu-
ally started automatically. The remote con-
trol operates entirely without special host
software in “WFT Server” mode. An ad hoc
wireless LAN connection to the controlling
device is all that is required. A web browser,
if possible with JavaScript support, must be
running on this device. A smartphone or
iPod Touch would do the trick. This is the
best solution we found for mobile remote
control photography in difficult terrain,
where even a netbook is a hindrance. More
details on this later on.

The fourth connecting mode, the “Camera
Linking” function, enables photographers to
link up to 10 “slave” cameras wirelessly to one
“master” camera. The cameras can be placed
up to 300 feet away. Every camera can be
configured as a master or a slave camera. Ho-
wever, due to network run times, it is not pos-
sible to have all 11 cameras shooting simulta-
neously. This applies to all remote control
functions. If the release delay is in the range
of a tenth of a second with a USB cable, it can
amount to a second under bad wireless LAN
conditions.

Smartphone Remote
Photography
None of the remote control solutions presen-
ted so far have been really convenient to use.
A full-fledged Windows or Apple desktop or
notebook computer with a USB port or wire-
less LAN is required for the remote control
software and the driver. Wouldn’t it be great
to be able to leave all the equipment at home
and use your cell phone or iPod to operate
the camera?

One company took a step in the right di-
rection; onOne software, known for professio-
nal Photoshop plug-ins, programmed the
iPhone application “DSLR Camera Remote”.
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DSLR Camera Remote saves all images on the host computer. The Live View and preview
pictures are transferred to the iPod Touch.

The add-on program WFT Utility allows
you to configure the network settings
for the WFT-E4 II on the computer and
transfer them via USB cable or memory
card to the Canon camera



This app also runs on the iPod Touch and pro-
bably also on the iPad. All these devices can
communicate over wireless LAN and, therefo-
re, can contact Nikon and Canon wireless
transmitters. However, the connection alone is
not enough. The smartphone application has
to understand and speak the camera’s
“language”, just like any other application that
also has direct access to the camera settings. In
general, larger manufacturers support the pro-
gramming of third party applications with
software development kits (SDKs). The SDKs is-
sued by Canon and Nikon only run on Wind-
ows and Mac OS and not on the iPhone’s ope-
rating system. Therefore, onOne Software ex-
plains that their remote app requires an addi-
tional computer that can be connected with
the camera via FireWire or USB and should
have a host application (DSLR Camera Remote
Server) running on it. The host application ser-
ves as a “translator” for the camera’s com-
mands. The iPhone app communicates with
the server program and not directly with the
camera or a wireless adapter. In fact, the adap-
ter isn’t required at all.

The advantage of not having an adapter is
also the main advantage of onOne solution,
despite it being complicated. A suitable note-
book costs a fraction of the price of a wireless
transmitter from Nikon or Canon. At least the
notebook can be used for more than one pur-
pose. Furthermore, the onOne app allows for
the wireless operation of those Nikon or
Canon cameras for which there are no pro-
priety wireless transmitters. Updates appear
occasionally for new camera types. So far,
onOne does not seem to have any plans for
the app to support cameras from other ma-
nufacturers. 

DSLR Camera Remote costs about US$20
and has to be downloaded by Apple’s iTunes
App Store. For about US$2, you can get a “Lite
Version”, which only allows you to fire the
shutter and review your images on the iPhone. 

What onOne has not yet succeeded in
doing, Canon managed to implement in seve-
ral of its new WFT adapters via software in De-
cember 2009. The WFT can now be remotely
connected using the WFT Server mode. There-
fore, images can be viewed over a web
browser, similar to web cameras. The remote
control software runs entirely on the server,
which is “in” the WFT adapter, while the remo-
te control takes place via a web browser from
a remote computer, PDA or smartphone. It is a
clever approach, as only the user interface and
the live image have to be transmitted to the
device and that in the worldwide standard
HTML or JavaScript code. Not a single line of
proprietary software is necessary. No program
needs to be installed and there is no app that
needs an Apple certification. Devices such as

iPhone and iPod Touch – which don’t allow
the installation of non-authorized software –
can be just as easily used for controlling the
Canon 5D or 7D as any wireless LAN capable
smartphone. After installing an ad hoc con-
nection, you can access the camera’s IP ad-
dress with the integrated Safari browser. In
order for the connection to succeed you have
to select connection mode “WFT Server”. The
camera window then opens and, once you
have pressed the “Viewer” button, it allows
you to browse and download individual
images or all the images stored on your me-
mory card.

Canon Remote Control

The Canon WFT Server remote control functi-
ons are found behind the buttons on the afo-
rementioned camera side. We will now use
these functions to make a thorough compari-
son of camera remote control software (see
also the chart at the end of the article).

The WFT Server allows the selection bet-
ween simple remote control (live preview,
manual focusing, shutter release) and total
remote control of the camera using
browsers with JavaScript support. Total re-
mote control comprises the selection of
image quality, exposure parameters and
white balance. However, the shooting mode
and focus areas cannot be selected and
have to be adjusted ahead of time on the ca-
mera. Even a contrast autofocus is not avai-
lable. In the Live View mode, there are three
buttons for rough, medium and fine manual
focal adjustments. There is no zoom functi-
on or 100 percent preview image, which
would be very useful for this kind of focu-
sing, and which even the onOne app offers.

If you switch off the live preview you can se-
lect between AF and MF in the browser
window. This means that the camera is trig-
gered without further focus control, even if
it is set to AF. The camera focuses the lens it-
self only when the browser based AF setting
is on, which means the camera’s fast AF set-
ting is on with the mirror down. The only
way to determine where the focal point
should be is to use the camera. Also, there is
no display in the browser window. After ta-
king the picture, as long as the Live View
mode is turned off, the image appears in the
browser window. There is no Zoom functi-
on, overexposure indicator or even a histo-
gram for subsequent image control. 

Remote control per EOS Utility is signifi-
cantly more convenient. There is a contrast
autofocus in live mode (even with face reco-
gnition) and a movable focus area. A histo-
gram (brightness or RGB channels) can be in-
serted on request. You have to switch to “Ex-
posure Simulation” in the live preview set-
tings beforehand. Double-clicking the Live
View image opens a 100 percent section in
another window, which can be opened to al-
most the size of the screen. Even a 200 per-
cent enlargement is possible. Alternatively,
double-clicking can sharpen the image by
using contrast-detect autofocus on the cli-
cked pixel.

Nevertheless, we thought there were a
few features missing: the remote control
window does not allow you to switch the
picture mode of the 5D; after shooting, the
control check on the monitor is limited to a
preview window without a zoom function,
clipping warning, etc. A practical feature is
the option of taking a test photo, which is not
stored but can be stored later. If you specify
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program’s
interface is
password-
protected.



the path to Canon’s RAW converter and edi-
ting software “Digital Photo Professional”
(which is included in the package) in the pre-
ferences, the loaded image is immediately
opened for editing. Alternatively, another
image editing program can be selected. This
feature can be limited to certain file formats
such as RAW files.

The third remote control program, which
is exclusively for Canon cameras, comes from
Breeze Systems (www.breezesys.com) a ma-

nufacturer of digital camera software. “DSLR
Remote Pro” supports almost two dozen
Canon DSLRs and can be tested for 15 days
free of charge. Retail price is US$129. Breeze
Systems also offers a remote control for
Canon Powershot cameras under the name
PSRemote. Both programs have multi-camera
versions allowing you to control up to 16 ca-
meras. The record is the simultaneous control
of 120 Canon D30 cameras for a 360-degree
view of a car. You can have a look at the

spectacular set-up for the photo shoot on the
Breeze website. 

Although DSLR Remote Pro’s design is not
so appealing, it offers a few more features
than the original Canon software. Keyboard
control of the settings is taken for granted.
Using “onion skinning”, the last picture or a
saved background image appears transpa-
rent in the Live View window. This is very use-
ful for stop motion animation, in which ani-
mated films are composed of many single
photographs. For stitching panorama pictu-
res together, you can move the background
image to any edge of the screen. “Photo-
booth” automatically takes a sequence of
photos and prints them out, which is ideal for
parties and corporate events. 

The program only lets you save your
images on the memory card. Since transmis-
sion of the files has been omitted, the camera
is quickly ready for operation again as it do-
esn’t have to react to the computer’s at-
tempts to take pictures during the transfer,
and the Live View image continues while
shooting. However, even when saving only
on the memory card, the minimum time bet-
ween images when shooting from the PC is
still more than two seconds. According to
Breeze, this option leads to instability in some
cameras. Although Breeze did not include the
5D in the list, the program regularly crashed
after taking the first photograph when this
option was selected. 

The functions of the remote control soft-
ware should, of course, use all the possibili-
ties the cameras have to offer, but they can
also go beyond these possibilities. The Time-
Lapse feature is the only function that does
so. Almost all programs allow automatic
shooting of a pre-selectable number of shots
at specified intervals. A lead time can usually
be set as well. 

We found almost no advanced control
functions. The auto bracketing menu offers
an implausible set of options of up to 15
shots at maximum increments of three or
even four EV. However, in practice most of
the combinations did not work. Only five
pictures were possible with the Canon 5D at a
maximum increment of 2 EV which at least is
two more than the camera offers on its own.
Here, EOS Utility is limited to three shots. 

The focus stacking function shows what is
possible, in principle, when putting the Bree-
ze software together with AutoHotKey, an
open-source utility for controlling Windows
programs. The script is free and can be found
in the Breeze installation directory. It controls
the remote program so that the camera
shoots a series of photos with a slightly shif-
ted focus. The images can be assembled to
create one image with a greater depth of
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The remote control window of Canon’s WFT Server showing the full set of camera controls.

An iPod Touch controls the Canon 5D Mark II using the Safari browser and a wireless
LAN. The main hard and software is in the Wireless Transmitter WFT-E4 II, which is
attached to the camera’s body.



field using further program such as Combi-
neZM (http://hadleyweb.pwp.blueyonder.co.
uk/CZM/News.htm). This is how macro pho-
tographs are created with a depth of field
that would not be possible with a normal ca-
mera. The scripts do not offer a user-friendly
interface and the number of photos and the
focal increments have to be changed manu-
ally in the script with a text editor. With a litt-
le more effort a graphical user interface
could be created using AutoHotKey. Of cour-
se it would be even better if the manufactu-
rers had already integrated these quite simp-
le photo series functions in the software.

Nikon’s Remote Controls

Nikon’s own remote control program, Camera
Control Pro (CCP), must be purchased. It was
not created for transferring the images from
the memory card to the computer; the freewa-
re program Nikon Transfer is meant for this
purpose. The settings are spread over five tabs
in CCP’s main window and more can be found
in the menus. This is not very clear and it do-
esn’t really save space on the screen. On the
one hand, it is good that the complete dialog
can be collapsed so that only the most impor-
tant exposure settings remain visible. On the
other hand, it is not ideal that you can’t
change the dialog immediately in the bar.
Once in the settings menu, you have access to
all individual functions of the D700. This could
be called luxurious as these are rarely
changed. However it is rather unacceptable
that there is no keyboard function, at least for
the trigger button. This is rather unsatisfactory
for an expensive professional program.

In Live View,  you can zoom in at 200 per-
cent. However, the window size is limited to
640 x 426 pixels. The image is only displayed
in miniature, but with a histogram and a clip-
ping warning in a status window. It can also

be displayed full screen in the Viewer by se-
lecting Fit to screen. 

The Handheld and Tripod options in the
Live View window influence the way the au-
tofocus functions. In Tripod mode, you are
executing a contrast-detect autofocus when
you click on the AF button. Subsequent ma-
nual correction is possible. The focusing in
Handheld mode takes place using the much
faster camera AF, as the mirror is down du-
ring the process. However, manual focus cor-
rection is not available. The mouse can move
the displayed focus area only in tripod mode.
Four navigation buttons serve this function in
the handheld mode. However, you are not
moving the focus area, but selecting one of
the up to 49 focus areas of the D700, which
can then be displayed by clicking a button.
We thought it distracting that the contrast-
detect AF put the mirror down before and
after the shutter release, even in Live View
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EOS Utility features spread over several
windows. The Zoom View window (100
percent actual pixel size or 200 percent
enlargement) is on the left, the Live
View full screen mode with optional
histogram is in the middle and the
capture menu with the release button
is on the right. 

Breeze Systems DSLR Remote Pro
offers several special features,
including the embedding of IPTC data
immediately after the shot. The data
can be downloaded from a file.



mode. This is a characteristic of the camera it-
self, rather than of the remote software. The
D700 and other Nikon DSLRs master a (slow)
contrast-detect autofocus with the mirror up,
but not exposure measurement. In order to
measure, the mirror is put down briefly,
which increases the release the delay. In con-
trast, the Canon 5D does not move the mirror
at all in Live View mode. 

Breeze Systems also offers remote control
software for Nikon DSLRs. NKRemote is simi-
larly structured to DSLR Remote Pro, but do-

esn’t offer all features. The images are always
saved on the computer without having a
choice. Just as with the Canon version, onion
skinning, Photobooth and color manage-
ment features are available for Nikon. The
Live View image is just as small in Nikon’s CCP
program, but can be scaled to the size of the
screen just as in Breeze’s Canon remote pro-
gram, although with considerable loss of
quality. 

A free alternative to these programs can
be found on the DVD included with this issue.

You will find it under the name Sofortbild
(www.sofortbildapp.com). It was program by
Stefan Hafeneger, a student of computer sci-
ence in Germany. The program and support
are in English. Sofortbild only runs on Mac
and supports only a few Nikon cameras. It
does not transmit the Live View image, but
does cover the most important shooting
modes and offers some special features. The
exposure modes are the most comprehensi-
ve we have found so far. The program can
perform bracketing and there is an option to
merge the pictures automatically to create an
HDR image. The Inspector window displays a
histogram and the EXIF files of the recorded
image. If they contain GPS data you can iden-
tify where the picture was taken. Doing the
opposite - entering the GPS data manually -
would make more sense but is not yet possi-
ble. Nor is the editing of EXIF files.

The iPhone App

In terms of scope of functions, onOne can’t
keep up with the above-mentioned remote
control programs. Nevertheless, it can easily
compete with Canon’s WFT Server. Instead of
using an expensive specific wireless adapter,
the app solution only needs a computer with
a Mac or Windows operating system with
onOne Remote Server (open source) instal-
led. The app itself can be downloaded from
Apple’s App Store for US$19.99.

When held upright, the iPod/iPhone de-
picts exposure settings, white balance and file
format in the main window. These can be mo-
dified in the app. If you tilt the device horizon-
tally, the display switches to wide format. Only
the Fire and menu buttons remain visible. The
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NKRemote’s control panel and main window, in this case in B&W mode. The context menu at
the bottom left shows the viewing options (not depicted here) for the Live View window. 

Nikon’s Camera Control
Pro settings window
(left) and the Live View
window (behind). The
status window in the
middle serves to review
the image after it has
been taken. There is no
separate zoom preview
of the Live View image
but the selection can be
enlarged up to 200
percent.



menu contains an “Intervalometer” for time-
lapse photography, exposure bracketing and
photo series. For exposure bracketing you
need to set the camera to manual, which indi-
cates that this function is controlled by the
program. This way, even with the Canon 5
Mark D II, which limits you to three pictures,
you can take up to 11 pictures using exposure
bracketing over a range of 10 EV – theoretical-
ly. In practice, it was only seven EV, because
the program does not strictly observe the pre-
selected “Full Stop” (1 EV) increment. 

Also, switching into the Live View mode
can be selected in the settings menu. If the
Live View is disabled or is not supported by
a camera, the preview window will then
show the last image taken. You can browse
the last images taken by stroking your finger
over the iPhone’s display. A double-click on
the image displays it 100 percent. Interme-
diate values cannot be displayed and there
is no zoom function in Live View mode. Ins-
tead, when you tap on the display of the
iPhone, the contrast-detect autofocus or a
corresponding setting (such as Canon’s
Quick Mode or Nikon’s Hand Held) starts up
the camera autofocus with fold-down mir-
ror. The obvious assumption is that the
image section will be focused on where you
tapped your finger, but this isn’t the case.
Actually, the autofocus uses the previously
selected camera AF focus area. This, howe-
ver, is not indicated anywhere and moreo-
ver; it can’t be changed from the iPhone. 
It seems that the program always focuses 
on the center of the image when using the
contrast-detect autofocus.

Apart from these undocumented wea-
knesses, the program runs reliably. It takes
up to a second for the image to appear in
Live View. If Live View is off it takes a quarter
of a second, which is comparable to the
other wireless remote controls, as is the Live
View frame rate of a maximum of 10 pictures
per second, which slowed considerably at
distances of just a few yards. Canon’s WFT
Server in combination with the iPod is even
slower.

Conclusions

Although most digital cameras have a USB
port that allows the transfer of data from the
memory card to the computer, immediate
transmission and display of a picture that has
just been taken is by no means a given. Live
image transmission and remote control of ex-
posure times, focusing and triggering are all
state-of-the-art. Manufacturers only install
these gadgets in their high-end cameras. In
addition, you need a USB cable and the re-
mote control software. In the case of Canon,
this is part of the package, but with Nikon it
has to be additionally purchased. You can
bridge up to 15 feet with a USB cable and up
to 100 feet with intermediary repeaters. A
USB LAN adapter goes even further. The acti-
ve USB connection depletes the battery rela-
tively quickly. 

If you want to do without a connecting
cable, then the amount of effort rises consi-
derably. As yet, there is no universal mobile
(hence battery-driven) wireless adapter that
can be plugged into the camera’s USB port.

The camera USB port cannot power the
adapter on its own, because it does not have
a voltage of 5V, and because this would
strain the camera’s rechargeable battery
even more. If power supply is a problem,
you may have to tinker a bit. However, USB
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A self-portrait of onOne Software’s 
DSLR Camera Remote Pro app, here 
shown running on an iPod Touch.

The Sofortbild tethered
shooting freeware allows you
to make bracketing
sequences throughout the
entire shutter speed range.
Unusually, the Step value
refers to the increments in
the shutter speed list, making
three Steps equivalent to one
full f-stop. The program’s
settings dialog includes an
option for automatically
merging bracketing
sequences into HDR images. 



wireless LAN adapters can transmit up to
300 feet outdoors and still get acceptable
data transfer rates. Wireless USB (WUSB)
only performs reliably over a distance of a
few feet and, in practice, doesn’t reach hig-
her transfer rates.

Cameras with integrated wireless LAN
electronics are still the exception. You can re-
trofit your camera using wireless LAN SD
Cards (Eye-Fi) if it has an SD slot, but the
these card have only a short range and don’t
include remote camera control functionality.
There are several wireless transmitters availa-
ble for professional Canon and Nikon DSLRs.
They can be attached directly to the camera
and usually only fit to one type. Even Nikon’s

separate WT-4 transmitter only fits on a few
Nikon cameras. Including the additional bat-
tery pack, you can expect to pay up to
US$800. This doesn’t include a computer for
saving your images. All this is only  worth -
while in a studio environment, where cables
might be in the way and pictures need to be
previewed quickly on the monitor. 

If the camera is to be remote controlled
then onOne’s iPhone app is a good value al-
ternative to the manufacturers own wireless
transmitters. The software and all the hard-
ware (i.e. iPod Touch and notebook) together
cost only a fraction of the other options. Ho-
wever, this solution is a little delicate for using
out in the wild. Although Canon’s WTF adap-

ters are rather pricey, they are robust and can
be controlled by an iPod or smartphone when
set in the WFT Server mode. 

Altogether, wireless solutions and remote
control software are by no means yet fully de-
veloped – presumably; the demand is too low
for manufacturers to make a greater effort.
Low frame rates when operating in Live View
and significant delays when shooting make it
difficult to make snapshots from a distance.
Unfortunately, camera manufacturers have
not used remote control software to extend
their cameras’ capabilities (HDR bracketing
exposure, focus stacking, etc.) We only found
these features in remote control software
from other manufacturers. (ae/rez)
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Wireless Local Area Network (WLAN)
transmits at 2.4 GHz or 5GHz. Originally, it
was intended as a wireless addition to of-
fice networks (LANs) for mobile compu-
ters but it has since been applied in other
fields as well. The technology is specified
in many standards of the Institute of Elect-
rical and Electronics Engineers (IEEE).
These build on each other and are largely
compatible. The IEEE 802.11 (2.4 GHz with
a data rate up to 2 Mbit/sec gross) is the
ancestor of today’s wireless networks. It
was found only in office LANs before the
year 2000 and has no relevance today.
The WLAN boom began in 1999 with the
release of 802.11b standard (2.4 GHz and
max 11 Mbits/sec). Now this standard is
also obsolete. The boom picked up speed
when the faster version 802.11g (2.4 GHz
up to 54 Mbit/sec) became available, but
this standard is now deemed obsolete
and the v802.11a for the 5 GHz wireless
band barely even took hold.

Currently, wireless devices operate in ac-
cordance with the 802.11n standard,
which works on either 2.4 GHz or 5 GHz.
Since 802.11n supports up to 80 different
transmission modes (one to four antennas
and transmitter/receiver modules parallel,
radio channel width of 20 or 40 MHz, va-
rious encodings), gross data rates of 6 to
600 Mbits/sec are sufficient. Devices with
two antennas and transmitter/receiver
modules are common today, transmitting
up to 300 Mbit/sec. Typically, these devi-
ces can manage up to 80 Mbit/sec on ap-
plication level and have a range of 65 feet
net inside buildings, depending on the

frequency used, the installation, the num-
ber and consistency of the walls, and the
competing radio systems. A number of
different radio systems, including analog
video bridges, Bluetooth, ZigBee and sur-
veillance cameras are competing, especi-
ally in the 2.4 GHz bandwidth. These and
further wireless LANs may reduce your
data rate to less than 20 Mbits/sec. In
practice, the increase in range in compari-
son to the older wireless LAN standards
does not turn out to be as high as manu-
facturers claim. 

Wireless USB (WUSB) is based on the ultra
wide band (UWB) radio standard and uses
the frequency range from 3.1 to 10.6 GHz.
It is supposed to reach a gross data rate of
up to 480 Mbit/sec, similar to the USB 2.0
wired transmission standard. This maxi-
mum speed only applies to a range of 10
feet and an unimpaired view between the
antennas. Beyond 30 feet the transmissi-
on rate drops to zero. You are better off
using a cable. It is cheaper and doesn’t re-
quire electricity. 

Moreover, Intel and Texas Instruments,
two important chip manufacturers, dis-
continued their UWB project in 2008.
UWB devices are rare and quite expensi-
ve. There are now alternatives that trans-
mit the USB protocol transparently over
wireless LAN. They achieve the same ef-
fect, are less susceptible to interference
and have a greater range. WUSB is notice-
ably faster at close range only, which is
not relevant for the remote control of a
camera.

Bluetooth is more likely to be a better
cable replacement. It has been successful
for a long time in the communication
between cellphones, notebooks and
headsets. Version 3.0, released in Decem-
ber 2009, may bring an end to the slow
data rate (net 1-2 Mbit/sec) and short
range. Also, Bluetooth was energy effi-
cient right from the start. A quicker con-
nection and greater range (110 yards) is
the main focus of version 3.0, which can,
if necessary, use a parallel wireless LAN
to achieve data rates of up to 24
Mbits/sec.

Meanwhile, Sony has developed its own
close range radio technology to market-
readiness. At the moment, TransferJet has
a range of 1.2 inches, but is claimed to
have a gross transfer rate of 560 Mbit/sec.
At application level, the transmission rate
still should be around 375 Mbits/sec. With
this technology you could transmit a 14-
megabyte image file in a second. The
technology is meant for the transmission
of images and videos between a camera
and a computer or television. Simply tou-
ching one of the devices is enough to ini-
tiate the connection. Since several big ca-
mera manufacturers are involved in the
TransferJet consortium it may be assumed
that it will spread quickly. Just as with the
Eye-Fi wireless LAN SD cards, it should be
possible to retrofit older cameras with
TransferJet memory card combinations.
The new TransferJet memory card should
fit into the memory card slot. Sony has al-
ready announced a memory stick with in-
tegrated TransferJet technology.

Wireless Transmission Rates and Operating Distances
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Remote Control Software
EOS Utility WFT Server DSLR Camera Remote Camera Control Pro 2 NKRemote Sofortbild DSLR Camera Remote

Pro

Manufacturer Canon Canon Breeze Systems Nikon Breeze Systems Stefan Hafeneger onOne Software

Website www.canon.com www.canon.com www.breezesys.com www.nikon.com www.breezesys.com www.sofortbildapp.com www.ononesoftware.com

Minimum system requirement Win XP, Mac OS 10.4 all Mac OS X 10.4, 
Windows 2000 
(also 64 Bit)2

Windows from XP SP3
(also 64 Bit)

Windows XP (32 Bit)
Windows 7 
(32 and 64 Bit)

Mac OS &times; 10.5 Mac OS 10.5, 
Windows XP SP2

Languages English, International English, International English English, International English English English

Test with camera 5D Mark II 5D Mark II 5D Mark II D700 D700 D700 5D Mark II, D700

required hardware – WFT-Transmitter – – – – PC

Controled by PC PC, Smartphone PC PC PC PC (Mac) iPod Touch or iPhone

Preview

LiveView / Live View window size v /any v / 480 x 320 /
(260 x 173)1

v / 1024 x 680 v / 640 x 426 v / 640 x 426 – v / 404 x 262 / 
314  x 205

Live View Zoom 100/200 % (separate
window)

100 % 25–200 % 25–100 % – –

LV frame rate USB cable 10 n. s. 12–15 12–15 12–15 – –

Wireless (WLAN 11g, max.) 3–4 3–5 ca. 5 12–15 12–15 – 10

Preview window v v v v v v if no EV

Histogram / RGB / Highlights v / v / – – / – / – v / v / v v / v / v v / v / v v / v / – –

Depth-of-field preview v – v – – – –

Exposure and focus

Keyboard trigger release – – v – v v –

Release delay without/with EV,
sec.

0.2 / 0.4 0.5 / 1.01 0.2 / 0.5 0.3 / 0.9 0.2 / 0.7 0.3 / – 0.2 / 0.6

Camera AF v v v v (Handheld mode) v v v (Handheld Mode)

AF Focus Area display /select v / v – / – v / v v / v v / v – / – – / –

Contrast-detect AF v – v v (Tripod mode) v – v (Tripod Mode)

Manual focus v v v v v – –

Settings

Shooting mode – (only on camera) – (only on camera) – (only on camera) A, T, P, M A, T, P, M – (only on camera) – (only on camera)

Exposure / Flash correction v / v v /– ±3EV/v ± 5 EV / –3… +1 EV ±5 EV / –3 – / – – /–

Program Shift – – – ±15 steps – – –

ISO / ISO limits v / – v /– v / – v / v v / – v / – v / –

White Balance / fine tuning v / v v / v v / Kelvin v / v v / Kelvin v / – v / –

File format / quality v / v v / v v / v v / v v / v v / v v / v

Color space – – v v v – –

Features

Bracketing / max increments in EV 3/2 – 3–5 / 23 2–9 / 1.0 3–15 / 3 >50 / 3 3–11 / 1/3 oder 1

Interval exposure v – v v v v v

Automatic release over time lapse – v – – v, 1–9 shots with intervalometer

Display

Grid v – v v v – –

Battery capacity v v – v – v (warning at 20 %)

Remaining exposures v v – v – – –

Storage space PC – – – v – – v

File saving

Location only PC or card+PC only on card (manual
download possible)

only card, only PC,
card+PC

only PC (D3S: PC or
PC+card)

only PC only PC only PC

Auto filename / with date / time – v / v / v
(also for filenames)

v / v / v v / v / v
(also for filenames)

v / – / – –

IPTC / EXIF editing – – IPTC (also import/export
from file)

Copyright, comments – EXIF (display only) –

Special features (beyond camera
features

no flash control – Onion skinning, Script 
for Focus stacking, 
Photobooth etc.

– Onion skinning, script 
for focus stacking, 
Photobooth etc.

HDR merge, GPS –

Supported Canon EOS cameras 
(selection – partially dependent 
on OS version)

all current and several
older EOS DSLRs

5D Mark II (with WFT-E4
II) 7D (with WFT-E5), 1 D
Mark III/IV (mit WFT-E2 II)

1D series, 5D Mark II, 
5D, 7D, 50D, 40D, 
30D, 20D, 10D and 
others

– – – 1D series, 20D, 30D, 40D,
50D, 5D, 5D Mark II and
others

Supported Nikon cameras 
(selection)

– – – D2 and D3 series, D700,
D300S, D300, D200,
D100, D40, D40x, D50,
D60, D70x,

D3 series, D300S, D300,
D700, D90, D5000, D200,
D80

D3 series, D300S, D700,
D90, D80, D5000

D3, D3x, D40, D40x, D60,
D80, D90, D200, D300,
D300s, D700, D5000

Price (approximate) free free US$129 US$180 US$129 free US$19.99
1 on iPod Touch  2 seperate software versions for Mac und Windows  3 higher setting possible, but didn’t work in test with 5D 

v available       – not available      n. s. not specified
c
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Image Composition
Some people only realize what great places they have visited 
when they look at their vacation snaps afterwards. I am not
recommending that you look at the world exclusively through a
camera lens, but I do urge you to use your camera to help you get
into situations you might not otherwise encounter and, of course, 
to record them. In the course of this tutorial I will be addressing 
not only some general aspects of photography, but also the inner
workings of digital cameras themselves.



Like me, you too are probably scared by the
flocks of tourists who disgorge from buses,

cameras at the ready, at well-known land-
marks all over the world; and it is tempting to
paraphrase the German comedian Karl Valen-
tin, who once said, “Everything has already
been photographed, just not yet by everyo-
ne”. But the desire to record experiences for
yourself and to share them with others is a le-
gitimate one, and is as old as travel itself. In
earlier times, travelers could only make sket-
ches or keep a diary, so a photo-diary is a
much more convenient way to go about the
same thing, especially if combined with maps
and modern GPS technology.

The camera as an aid to
seeing …

If you should find yourself taking part in a
group trip, turn around! Don’t point your
camera in the same direction as everyone
else – point it the other way. Aren’t the aston-
ished expressions on the faces of a group of
tourists looking at St. Peter’s in Venice a bet-
ter subject for a photo than the cathedral it-
self? There are a thousand perfect postcards
of subjects like this anyway. Look for the little
things that symbolize or even contradict the
character of your surroundings. A photo of a
Balinese student explaining the whys and
wherefores of a temple for a tip is surely a
more personal memory than a photo of the
temple itself.

A camera can be used to manipulate a
view, but it can also teach you to see. Ideally,
the “photographic view” captures not only
the formal qualities of a scene, but also some
background information – a good photo
helps the viewer to look beyond the surface
events. A camera can help occasional photog-
raphers to take a closer look at their surround-
ings too, and the search for new subjects
often takes you to places and gets you into
situations you wouldn’t otherwise have
found. You don’t need to go on a photo safari
or an expensive private tour. You might find
that the local fishermen land their night’s
catch at dawn a couple of hundred yards from
your hotel while their wives light fires to cook
breakfast, but by the time “normal” hotel life
has got into swing (and the sun is too high in
the sky anyway), the beach is once again
empty as if nothing had happened. 

… and as an entrance ticket

With the help of your camera, you can end
up in places you would otherwise not have
been; and a large, professional-looking cam-

era can even help to open official doors with-
out the help of a press pass. It is definitely
difficult to gain the trust of a stranger you
wish to photograph. People who allow
themselves to be photographed are giving
something away, and someone who allows
himself to be photographed many times a
day is either very generous, or it is simply
part of his business. This makes photos of
staged ethnic dances hackneyed in a double
sense: you have already paid for the show

with the price of your ticket, and the photos
you take have no intrinsic value.

On the other hand, the desire to take a
photo is a sign of interest in the events taking
place, and most people (with the exception
of those whose beliefs forbid them to be
photographed) interpret a photographer’s in-
terest as such. The openness towards pho-
tographers in some Islamic countries is aston-
ishing and provides a stark contrast to the
warnings issued by some guidebooks. You
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Here, the photographer should have lowered his viewpoint, or at least opened the aperture
to blur the background a little. The verdict here is: great subject, bad photo!

A successful photo often tells a complex story



do, of course, need to use some intuition
when photographing strangers. Try not to be
too pushy, and make sure you get permission
either with a gesture or using eye contact be-
fore you shoot. Remember to observe the
local customs and, even if it seems strange to
you, you will sometimes have to gain a man’s
permission before photographing his wife or
children. Taking a photo of the head of the
family first is never a bad idea.

People generally don’t mind if you pub-
lish these types of photos at home, and trying
to get someone to sign a model release form
for a casual portrait would probably just
cause confusion. Photos of public places that
unavoidably include passers-by are classed as
documentary or reportage material anyway.
The value that is nowadays attributed to per-
sonal images in the western world is a result
of the commercialization of everything visible
and the legitimate fear of an increasing loss
of privacy.

These are phenomena that photogra-
phers can do little to influence – with the ex-
ception, of course, of the paparazzi or the cre-
ators of Benetton advertisements. It is also le-
gitimate for the subject of a photo to want to
participate in any profit the photo produces,
although publication in an exhibition, a book,
or on a website can’t usually be classed as a
commercial venture. Commercial use defi-
nitely starts when a photo is used for adver-

tizing purposes, and you should be aware
that publishing portraits on the internet is
still something of a legal gray area. 

“Perfect” Photos

What makes a great Photo? Is there a recipe?
If you look at photos from the last few
decades and paintings from bygone cen-
turies, you will come across certain recurring
compositional rules that appear to be almost
genetically linked with our human sense of
perception – regardless of personal individu-
ality or our degree of resistance to fashion.
Over the course of history, human beings
have learned to subconsciously recognize
certain shapes and patterns, some of which
immediately interest us or ring alarm bells ir-
respective of how clearly they are perceived.
Human face recognition is especially highly
developed, and the ability to recognize peo-
ple or interpret their intentions was (and
sometimes still is) crucial to our ability to sur-
vive. The human brain sometimes even
“sees” faces in inanimate objects – for exam-
ple, in the surface of the Moon. 

The forms that are generally accepted as
“good” image composition are based on sim-
ple rules (see Gestalt Theory below). The way
objects, lines, and colors are arranged cause
an image to appear “open” or “closed”,
“calm” or “tense”, and applying a strong soft
focus effect often helps to reveal an object’s
true form. Horizontal and vertical lines com-
municate calm (especially if they are posi-
tioned in the center of an image), while diag-
onal lines generally create an impression of
tension. Triangular compositions that com-
bine vertical and diagonal lines in a closed
form are especially popular. A triangle can be
placed on its point or on its baseline, and can
thus be used to produce appropriately se-
cure or insecure feelings in the viewer. Re-
peated patterns create rhythms that interest
us and simultaneously make us aware of
breaks in rhythm. It is important to include
rhythmic breaks in an image, as the human
brain tends to interpret simple repeat pat-
terns as boring.

Slanted or diagonal lines and textures give
an image structure, but can also spoil the
overall mood. Placing the horizon in the mid-
dle of an image is simply bad technique, and
it is always better to place people away from
the center of the frame. There are, of course,
always exceptions that prove the rule, and
frame-filling portraits will always cover the
center of an image. All the same, it is general-
ly better to avoid using too much symmetry.
Some cameras have a built-in “rule of thirds”
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A photographer’s attention is a gift that children often repay with a smile

What is that photographer looking at?



grid that you can superimpose on the moni-
tor to help you with your composition. The
“golden ratio” divides a line so that the
length of the shorter part has the same ratio
to the longer part as the longer part to the
length of the entire line (approximately
38:62). Artists and architects have been using
this rule for thousands of years to help them
produce harmonious-looking results.

An eyecatcher is an important element
of any image, and immediately gains a vie-
wer’s attention, regardless of what it actu-
ally is. Faces (and especially eyes) are good
eyecatchers, but a patch of bright color
can be just as effective. If the eyecatcher
isn’t the actual subject of your photo, make
sure it doesn’t distract the viewer’s attenti-
on. Multiple eyecatchers are confusing and
should be avoided. If you can’t change
your position or framing, you can always
use a wider aperture to help emphasize
your subject by blurring the background.
You can achieve similar effects using
image processing software, but it is much
easier to use an appropriate aperture while
you are shooting. There are stories of pho-
tographers who have had trees chopped
down in order to achieve the effect they
were looking for, but I prefer to use the
Photoshop cloning tool!

Combining various compositional ele-
ments can make a good image, and unusu-
al compositions help to make an image re-
ally special, although what is “unusual” is
not easy to define. Ideas such as deliberate
blur or radical crops that were considered
revolutionary a few of years ago are stan-
dard fare in today’s newspapers; and by
the time a visual trend has found its way
into advertising images, you can be sure
that the same trend is already “out” in the
art scene. 

But formal suspense only serves to crea-
te interest and expectation the same way
the smell of a steak whets our appetite. A
good image will fulfill your expectations,
while the isolated special effects that many
image processing tools produce only serve
to disappoint. An artificial look cannot
compensate for missing content the same
way that the taste of fast food gets worse
the flashier the advertising that sells it to
you.

Every Picture Tells a Story

Photos extend the observer’s view, filtered by
the photographer. They not only tell the story
of the events they portray, but also tell us
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The fact that you can nowadays process
a digital photo in just about any way
you like increases the risk of the photo-
grapher becoming careless while shoo-
ting. The following sections describe
how image processing can improve an
image and also the circumstances
under which it either doesn’t help or is
simply too much trouble. 

Basic composition and perspective
cannot really be changed once an
image has been shot, although you
can adjust the overall composition
slightly by cropping. Perspective is en-
tirely  dependent on the camera positi-
on and is not affected by the focal
length of the lens. There are two ways
to fill the frame with a subject: either
get nearer or zoom in. Getting nearer
(also known as the “sneaker zoom”
technique) changes the perspective in
your shot, while zooming with the lens
doesn’t. 

Lighting (whether natural or artificial)
is largely responsible for the mood of
an image, and existing light can only
be brightened or darkened using
image processing techniques. This can
change the mood slightly but not fun-
damentally. 

Correct exposure is much more impor-
tant in the digital domain than it ever
was for analog photos, due to the rela-
tively narrow dynamic range of digital
image sensors. While film reacts “gent-
ly” to overexposure, producing only
slowly darkening blacks, a sensor can
no longer function at all once a certain
amount of incident light is exceeded.
Detail in washed-out highlights simply
cannot be retrieved, regardless of
which software tricks you use.   

Sharpness is dictated by your focus
setting, and the aperture is determined
(at least in the case of moving subjects)
by the shutter speed. Blurred images,
especially where camera shake is invol-
ved, cannot be corrected later. In con-
trast, there are a large number of filters
and tools available for causing delibe-
rate blur, including extremely convin-
cing photographic blur filters that pro-

duce an effect very different to run-of-
the-mill soft focus effects. The crux of
post-processing blur effects lies in the
successful isolation of the objects
which are to remain in focus, and em-
phasizing a subject by blurring the
background can involve a lot of hard
work on a computer. If your lens is
bright enough, it is easier to use a
wider aperture while shooting – provi-
ded, of course, that your sensor is capa-
ble of capturing sufficient depth of
field. 

Of all the analog accessory filters avai-
lable only polarizing, neutral density,
and graduated filters are of any real
use in the digital world. Polarizers redu-
ce reflections and intensify colors opti-
cally – effects that are difficult to repro-
duce  digitally. Neutral density filters
can be used to artificially extend expo-
sure times, which can help when pho-
tographing flowing water, for example.
 Graduated filters are generally used to
manage subjects with too much con-
trast. This is a situation that can only ot-
herwise be handled by merging multi-
ple, differently exposed images of the
same subject (a technique known as
High Dynamic Range, or HDR imaging). 

Where analog photographers had to
change films in order to change the
color characteristics of their images, a
digital photographer can choose a film
profile (with soft colors for portraits or
“Velvia”-style candy colors for archi-
tecture or landscapes) at the push of a
button or the click of a mouse. Such ef-
fects can also be achieved (with similar
quality) during post-processing if you
shot your images in RAW format. 

Post-processing is very important if
you are shooting images for grayscale
(black-and-white) presentation, as the
quality of monochrome images is hea-
vily dependent on the relative bright-
ness of the individual tones within the
image. Digital cameras always use the
same preprogrammed tonal patterns
when shooting in black-and-white
mode, but these can be appropriately
adjusted for each individual image
later.

Basic Photographic Techniques
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something about the photographer’s ideas
and interests. We view images in the context
of every other image we have ever seen, from
those in our childhood books to the very last
advert we saw, and the human brain auto-
matically makes connections between all im-
ages we have seen, combining familiar forms,
similarities, and memories. A good photogra-
pher will take this visual experience into ac-
count, and will either use it as a springboard
for his own ideas, deliberately play with your
perceptions, or present his own view as a
counterpoint. An image is only a collection of
colored pixels until the viewer applies his
imagination to it. By the same token, an
image that doesn’t remind us of anything will
probably interest us just as little as one that
appears completely familiar. An image
should leave room for the viewer’s own
 fantasy.

Really great photos are often very
sparsely composed, with nothing to distract

the viewer from the subject. A few clear
shapes with just a few, well-chosen colors
increase the effectiveness of an image.
Monochrome images have never really
gone out of fashion, in spite of relentless
progress in color imaging, and are even cur-
rently experiencing something of a renais-
sance. In times when a flood of information
is more of a burden than a luxury, the arts of
reduction and omission take on new impor-
tance. Having said that, it is much easier to
reduce clutter in a studio than it is “out
there” in the real world. Even experienced
photographers sometimes fail to notice dis-
tracting backgrounds or tree branches pro-
truding behind their subject’s heads. This is
where the monitor on a digital camera
comes into its own, as it shows the scene
you have just photographed in two dimen-
sions. This often helps you to judge the ef-
fects of the surroundings that you might
otherwise miss when concentrating on your
subject.                                             (ae/rez) c

The Gestalt principles describe the cir-
cumstances under which human per-
ception separates single objects from
their surroundings and when spatially
separate objects are perceived as
being joined. The most important of
these principles in a photographic con-
text are

Figure and Ground: an object that has a
distinctive characteristic is more likely to
be perceived as the subject than anot-
her, less, obvious object.

Symmetry: multiple objects that are ar-
ranged symmetrically are perceived as a
single object.

Similarity: similar-looking objects are per-
ceived as belonging together.

Proximity: objects that are close together
are perceived as belonging together.

Continuity: objects that appear to extend
the shape or position of other objects are
perceived as being a part of the other
object.

Closure: broken lines are perceived as
being part of a complete figure. 

Area: the smaller of two overlapping ob-
jects will be perceived as the subject

while the larger will be perceived as
being the background.

Combination: joined elements are percei-
ved as a single object.

Experience: we recognize and prefer sha-
pes that we have often seen in the past.

Gestalt Theory

Optical illusions are often caused by the
simultaneous application of multiple
principles of perception. Here, the brain
fills out the empty spaces and applies
the principles of experience and
continuity to make us see a cube.
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Triangular composition

Repeat pattern with variation

Symmetry

The rule of thirds grid compared with the
golden ratio (illustrated by the red line)





Twenty years ago, even amateur photogra-
phers needed to have a good grasp of the

relationship between shutter speeds and aper-
tures in order to take acceptable photos. No-
wadays, increasingly automatic cameras are
breeding a generation of photographers who
are often unaware of the degree of influence
they can exercise over their results. Many
photographers simply trust the camera’s sys-
tems and view the technically “correct” results
as their own interpretation of the situation. But
aren’t automatically exposed photos just a for-
mularized reproduction of a scene?

From Analog …

A look back at the history of photography
shows that many images that we now regard
as classics were produced under circumstan-
ces that were technically far from ideal. The
20th century’s photo pioneers set out into the
field carrying enormous plate cameras. The
plates themselves were heavy and fragile, and

only a small number of exposures could be
made per session. The results weren’t always
predictable, even for the most experienced
photographers, and focusing using a ground
glass screen protected from stray light by a
cloth was far from easy. The only information
available to a photographer in advance of re-
leasing the shutter concerned framing and
focal plane, and the photographer had to rely
on the power of imagination to visualize the
results.

Photographers with a good grasp of the
photo-chemical development process were
able to influence the resulting image more di-
rectly. While shooting his famous North Ameri-
can landscapes in the 1940s, Ansel Adams
(1902-1984) developed the “zone” system of
composition and development in which the
grayscale values of the different elements of an
image were taken into consideration during
exposure and development, and each negati-
ve was developed individually according to the
nature of the image. This approach allowed
Adams to precisely reproduce the tonal range
of his subject in spite of being limited by the
tonal range of his photo paper. Using his virtu-
oso talents to visualize his own personal inter-
pretation of his subjects, he produced images
that are still unparalleled in their visual power
and technical prowess. Adams’ iron will helped
him to achieve technical near-perfection and to
influence many generations of photographers
who followed in his footsteps. His books The
Camera, The Negative and The Print are still
standard reference texts.

The invention of the 35mm camera made
photography quicker and more practical, as
well making it affordable to a broader public.
Prepacked rolls of film could be used to shoot
multiple images in a single session and there
was suddenly no longer any need to load your
film in the dark. These developments also in-
creased the importance of photography as a
documentary medium. The smaller film format
initially reduced image quality, with grain be-
coming visible in prints and enlargements
made using all but the least sensitive films
while large format negatives were only ever
enlarged using very small magnification fa-
ctors, if at all. Medium format analog film was
developed as a kind of compromise between
the extremes of large and pocket format
photography and today still plays a role in the
professional photographic segment, although
most major camera manufacturers have begun
selling medium format digital cameras and ca-
mera backs that are sure to become the norm
very soon.

The next stage in the development of popu-
lar photography was the advent of single-lens
reflex cameras, which use a system of moving
mirrors to allow the photographer to see the
scene as it is being captured through the view-
finder. The development of through-the-lens
(TTL) exposure metering followed in the 1960s
and, for the first time, allowed fully automatic
flash exposures at the press of a shutter button. 

Once the photographer had been freed
from having to manually meter exposure be-
fore every shot, autofocus was the next logi-
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Back to the Basics
Nowadays, when we are congratulated on a successful photo, praise is 
usually immediately followed by the question, “… and which camera did you use?” 
The role of the camera in the creative process is becoming increasingly important, 
while the photographer’s own skill seems to be taking on a secondary role. 

A 4x5 inch large format camera 
with sheet film holders and a light meter

A classic film-based 
black-and-white image
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cal step, and cameras were soon focusing fas-
ter and more accurately than humans ever
could. Programmed automatic exposure
modes designed for photographing portrait,
macro, landscape or other specific types of
subject gave hobby photographers the op-
portunity to produce well-rounded images,
while image stabilization systems minimized
camera shake without us having to resort to
using a tripod. But the most significant tech-
nological change, which influenced the eve-
ryday behavior of amateur and professional
photographers alike, was the introduction of
digital cameras.

… to Digital Cameras

In recent years, digital image sensors have
completely changed the camera market and
the habits of generations of photographers.
The first digital cameras to hit the market were
extremely expensive and produced results re-
miniscent of video stills. Any film-based pocket
camera – no matter how cheap – produced
better quality images. 

But technology progresses quickly and, si-
milar to the development cycle in the compu-
ter industry, every new generation of cameras
brought considerable improvements at increa-
singly affordable prices. Three-megapixel ama-
teur and 6-megapixel professional cameras
were the first to deliver acceptable image qua-
lity to a broad public. At this stage, image quali-
ty was still not directly comparable to that pro-
duced by analog equivalents, but the practical
advantages of digital photography soon began
to outweigh the new medium’s shortcomings.
Suddenly, images could be viewed immediate-
ly after shooting and manipulated virtually at
will on a computer, and additional images did
not produce any further costs. The savings in
film costs alone made it worth buying a digital
camera, and the image quality of today’s ca-
meras is generally even better than that produ-
ced by their analog cousins. 

The compact camera market is dominated
by cameras with 10- or 12-megapixel sensors
and the quality of the lenses they are coupled
with is quickly reaching a level at which their
full resolution can be used to produce detai-
led, large-format prints. Image quality has
overtaken that produced by most of the
35mm films available. High-end cameras have
sensors whose resolution ranges between 15
and 40 megapixels and which offer quality
that equals or exceeds that of traditional me-
dium format cameras. But there are still a
large number of professional photographers
who cannot overcome their skepticism regar-
ding the digital medium, even though soft-
and firmware-based noise reduction and dy-
namic range enhancement tools produce out-
put that is obviously superior to anything that
the analog medium can produce. The quality

of modern photo printers and print services is
constantly improving, and even professional
photographers often make their own prints.

Image Quality: Analog vs. Digital

Analog film, with its high storage density and
broad color range should – theoretically – be
able to produce better results than any current
digital imaging process. However, in practice,
analog development processes involve too
much quality loss to really compete with the
digital medium. Modern 35mm negative film
is capable of capturing approximately thirteen
f-stops of contrast, but analog photo paper
can only reproduce contrast in a 5-stop range.
Enlarging small negatives also causes further
image quality loss due to diffusion produced
by the enlarger and the optical errors that are
present in every enlarging lens. All of these fa-
ctors increase exponentially with the magnifi-
cation factor and make the theoretically super-
ior resolution of the analog process unrealiza-
ble in practice. Tests have shown that prints
made from conventional, low-speed analog
film produce detail that is comparable to that
produced by an 8-megapixel DSLR. Specialized
document and military film can produce bet-
ter results, but is not available to the general
public. 

Compensatory development, multiple ex-
posures, dodging and burning and the use of
graded paper are all techniques that can be
used to coax greater detail from analog materi-
al, but the process nevertheless involves deci-
sions about which details the photographer
wishes to preserve and which can be sacrificed
in order to produce the desired overall look. 

The digital photo workflow is comparati-
vely loss-free and produces much more con-
sistent results. Color, contrast and image
brightness can all be manipulated using
image processing software, and processed
images can be sharpened for additional im-
pact before they are printed. But digital pro-
cesses involve risks too.

Too Quick and Too Easy

Taking photos has become an almost comple-
tely controllable process. Techniques like
those used by Ansel Adams, whereby the
rhythm used to tilt the developer dish could
have a significant effect on the resulting sha-
dow or highlight detail, today seem like alche-
my from a bygone era. Today’s exposure me-
ters, camera firmware, contrast or brightness
settings and output soft- and hardware all
work toward the same single aim of producing
the best possible distribution of tonal values
and faithful detail reproduction for the entire
image area. Under- or overexposure are taboo
and super-sharp focus is mandatory. In fact,
modern cameras follow the same guiding

principles as Ansel Adams and attempt to pro-
duce balanced images with deep blacks and
radiant whites. 

But that is where Adams’ work really began.
He used deliberate shifts in tonality to inter-
pret rather than just photograph his subjects.
In contrast, modern technology can only pro-
duce “correct” metered results, making it
much faster and simpler to produce results
that are, by definition, increasingly homoge-
nous. An analog photographer has to be
aware of the technical limitations of the me-
dium in order either to avoid them or to use
them deliberately as part of the creative pro-
cess. The costs involved in analog photogra-
phy also force the photographer to seriously
consider each subject and the potential results
of every exposure before releasing the shutter.
This process makes every analog image the re-
sult of a creative process characterized by the
photographer’s own creative style. Visualizing
the desired result in advance of shooting re-
mains the key to producing original photogra-
phic images.

Critics of digital photographic processes
still maintain that analog photos have more
“atmosphere”, but this is only true if the re-
sults are observed in combination with the
processes used to create them. Technical limi-
tations, such as shallow depth of field or the
heavy grain and non-linear color reproduction
associated with some emulsions, are just
some of the factors which cause analog ima-
ges to appear stylized and “atmospheric”.
Many classic photos deliberately use the ab-
straction caused by tonal imbalance or incon-
sistencies in color reproduction to achieve
their effects, especially in the field of black-
and-white photography.

So …

In its infancy, the appeal of the digital photo-
graphic medium was its ease of use. Nowadays,
digital image quality no longer lags behind its
analog equivalent. Metering technology and
reproduction accuracy are constantly impro-
ving and the term “image quality” is beginning
to take on a meaning beyond that which can
be measured using a test chart. The limiting fa-
ctor is no longer the camera, but rather the
photographer. The simpler it is to produce ima-
ges, the more arbitrary the results will be.

The modern photographer must learn to
see and to decide how to interpret a subject
in spite of the virtually boundless technolo-
gical help that is available at the push of a
button or the click of a mouse. There is a lot
to be learned from older, “slow” analog tech-
niques. Digital technology is, of itself, neutral
and is simply waiting to be used usefully and
creatively. With any luck, we will soon get to
hear people saying things like, “Great photo!
Who took it?” (ae/rez) c
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A deliberate grain effect.
This portrait was shot using
high-sensitivity 35mm film.
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Thomas Saur A good black-and-white photo has a
magical quality and often helps to
reveal aspects of a scene that would
normally remain hidden from the
viewer. Black-and-white images are
much more than just color photos with
the color left out – the concentration
on grayscale values gives us a new 
and intriguing view of reality.

Shooting in

Black and White



In his search for the perfect scene, a photog-
rapher who revisited the scenes of some of

Ansel Adams’ most famous landscape photos
was astonished by the banal nature of the
scenery he found. Where were the dark, crag-
gy cliffs? Where was the finely-textured vege-
tation? What had happened to the lush skies
with their radiant cloudscapes? He couldn’t
find any of it. This anecdote proves to me that
photos can often give us an enhanced view of
reality.

It was, of course, Adams’ own view of the
scenes and his virtuoso photographic skills that
enabled him to portray nature the way he saw
it and to produce his famous, almost sculpted-
looking images. On his search for subjects, he
used a contrast filter that enabled him to view
a scene virtually without color, and when mak-
ing prints, he always used the entire range of
tonal values that the black-and-white process
offered. He used a spot meter to meter the in-
dividual zones within a scene and his own, ex-
clusive zone system to expose and develop
each of his images.

Contemporary digital photographers don’t
generally use antiquated manual techniques to
meter their exposures, instead relying heavily
on the camera’s automatic systems to produce
the “right” result. This article explains how
knowledge of traditional photographic meth-
ods can help modern photographers make the
most of the digital photo workflow. The most
important factor in the process is correctly

adapting traditional techniques for use in a
digital environment.

Basic Camera Settings

Make sure you have selected the appropriate
camera settings before you release the shut-
ter and always shoot in RAW format if you can
– it's definitely worth it! RAW image files near-
ly always have greater color depth than JPEGs
and include much more detailed image data.
JPEG image data is automatically processed
according to the camera's built-in algorithms
and the settings the user makes, and often
provides images with improved visual ap-
pearance, but which also lack detail. JPEG al-
gorithms often produce visible compression
artifacts too. If you shoot RAW images, you
can apply selected processing steps individu-
ally under controlled circumstances using a
computer.

If your camera doesn’t support RAW, it is
preferable to select neutral contrast and satura-
tion settings and either to set in-camera image
sharpening to its lowest level or switch it off
entirely before shooting, if you can. That way,
you can preserve the greatest possible range of
detail and you can also sharpen your image
less damagingly later, once you have per-
formed any other necessary adjustments. You
can use your camera’s built-in black-and-white
or sepia settings to preview your composition,
but always shoot in RGB mode if you want to

give yourself the best possible base image for
later conversion to monochrome.

Exposure

You might think that today's automatic
cameras have taken the guesswork out of tak-
ing great photos, but an image that looks fine
on your camera's monitor can still contain im-
perfections that aren't immediately visible.
Most automatic exposure systems select usable
aperture/shutter speed combinations but are
not capable of detecting exactly which part of
a scene is the photographer's chosen subject. A
“normal” scene photographed in bright sun-
light can encompass contrast of up to 16 whole
f-stops, with each stop equivalent to doubling
the amount of light that reaches the camera's
image sensor. This means that the contrast in
our sample scene measures 216 or 65,536:1. But
what remains of all this contrast if the camera
you are using can only capture a tonal range of
nine f-stops (i.e., contrast of 512:1)? If the range
of contrast in a subject exceeds that of the
medium used to record it, your image will end
up with burned out highlights, detail-free
shadows, or both. 

Digital image processing techniques can
compensate for much of the difference be-
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The range of contrast that various input and output media can reproduce varies enormously
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Sunlit subject: 16 stops

Human eye: 13-14 stops (adaptive)

Black-and-white negative film: 12 stops

Color negative film: 8-10 stops

Slide film: 6-8 stops

Digital HDR image: 14-16 stops

DSLR camera: 8-11 stops

Compact digital camera: 6-9 stops

HDR monitor: 17.5 stops

LCD monitor: 10 stops

CRT monitor: 8 stops

Printer: 8 stops

1. Select the highest available image quality
and lowest possible ISO values when shoot-
ing. If possible, always shoot in RAW format.
If this is not possible, use neutral color and
contrast settings without additional sharp-
ening.

2. Visualize how your image will look in
black-and-white. Concentrate on texture,
lines and tonal gradients. These will be-
come more obvious later in the black-and-
white version of your image. Analyze the in-
dividual tones and the dynamic range of
your scene and try to consider the technical
limitations of your camera and printer while
composing your scene. Use the results of
your analysis to decide where to place the
brightest and darkest tones in your finished
image.

3. If in doubt, expose for the highlights!
Slight underexposure is better than overex-
posure.

4. If you are still uncertain of how best to ex-
pose your image, shoot a bracketing se-
quence at half-stop intervals and select
your best shot later. You can also merge
multiple images using HDR or DRI tech-
niques to produce your desired effect.

Shooting Tips



tween input and output contrast levels. This is
mainly due to the fact that the dynamic range
of most output media is narrower than that of
the recording media. An LCD monitor can dis-
play a maximum of approximately 10 f-stops,
while an inkjet printer cannot reproduce more
than six or seven stops of contrast. And al-
though the range of contrast present in the ac-
tual subject will always be compressed to the
range that your chosen output medium can re-
produce, well-made prints can nevertheless in-
clude deep black shadows and radiant high-
lights. 

How can this be? While a densitometer will
always detect the purely qualitative differences
between the highlights and shadows present
in a subject or a print, the human eye automat-
ically adapts to compensate for perceived ir-
regularities in dynamic range. We interpret the
grayscale values in a print in relation to each
other and according to our experience of the
interplay between light and shadow. 

The best monochrome digital images are
the ones with the broadest dynamic range,
making it necessary for the photographer to
actively decide how to expose each frame.
Ansel Adams' guiding motto for shooting with
black-and-white negative film was “Expose for
the shadows and develop for the highlights”. 

Many analog photographers use the tech-
nique of deliberate overexposure and short-
ened development times to compensate for
excess dynamic range in black-and-white sub-
jects. Digital image sensors have different char-
acteristics from negative film and require an
approach that concentrates more on preserv-

ing highlight detail. Lost shadow detail can
often be recovered digitally, while the detail in
burned out highlights is usually irretrievably
lost. 

Transitions from bright areas to highlights
in a correctly exposed negative image are usu-
ally finely graduated, whereas CMOS and CCD
image sensors tend to stop recording abruptly
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The range of contrast present in an image has to be reduced to a level
that a printer can reproduce

The histogram curve is clipped toward the right and the image is
overexposed. The burned out highlights cannot be recovered.

Slight exposure compensation (between 1 and 2 EV) results in much better highlight detail



beyond a certain level of brightness. Underex-
posed RAW image files contain more shadow
detail than their analog equivalents, so it is im-
portant to keep an eye on the highlight values
in the camera histogram or monitor image.
Most contemporary cameras have a clipped
(i.e., overexposed) highlight display feature
that makes potentially overexposed image
areas blink in the monitor. This gives you the
chance to re-expose your photo using different
exposure values – if your camera has this fea-
ture, use it!

If the histogram curve is clipped toward its
right-hand end, this is a clear sign of overexpo-
sure. Set an exposure compensation value or
underexpose manually by between a half and
two stops until the clipped highlights are dis-
played as well exposed. This can, however, lead
to clipping at the other end of the tonal scale
with a corresponding loss of shadow detail. Try
to find the right compromise between the two
extremes and, if you are in any doubt, underex-
posure is always better than overexposure. If
your camera doesn't have an exposure com-
pensation feature, you can press the shutter
button halfway while pointing the camera at a
brighter part of the frame before reframing to
include your intended subject. Be careful if you
use this technique, as pressing the shutter but-
ton halfway usually locks both the exposure
values and the current focus setting. If you can-
not capture the entire dynamic range of your
subject in a single image, you can take multiple
photos and merge them in to a single HDR
(High Dynamic Range) image. Especially effec-
tive for stationary subjects, this technique in-
volves producing a kind of digital negative that
is saved at 32-bit color depth and can cover up
to 16 stops of contrast and a wide range of
finely graded tonal values. This 32-bit image
file then serves as the basis for a technique
called tone mapping that transposes the
image's extended dynamic range into a form
that can be reproduced using conventional
monitors or printers. Tone-mapped images
make an ideal basis for black-and-white con-
versions.

Shoot using low ISO values whenever possi-
ble. The default ISO 100 setting is best, as high-
er values tend to reduce a digital camera's ex-
posure headroom. This can lead to a total dy-
namic range of 6 EV or less in some compact
cameras, which will significantly reduce your
creative potential. Washed out highlights often
betray the digital nature of an image, and if you
apply additional sharpening later, your images
can end up having an artificial, video-like look. 

Compact cameras, with their small sensors
and inherently narrow dynamic range, suffer
more in this respect than DSLRs, although
some camera models produce burned out
highlights more readily than others. It is advis-
able to deliberately underexpose by  or  of a
stop if you are shooting a high-contrast scene

with a compact camera. Many cameras now
have built-in “highlight priority” functionality
that automatically exposes to preserve high-
lights and highlight detail.

The Zone System 

In his legendary reference book The Negative,
Ansel Adams details a three-step approach to
improving your perceptive and image compo-
sition skills:

1. Look for the darkest relevant detail in
your scene. Adams states that some objects
that appear to be black – such as a black hat or
a cat – are not actually black in a photographic
sense. He recommends learning to see all dark
tones as shades of dark gray in order to select
which portions of your image you want to ap-
pear truly black in a print.

2. The next step involves concentrating on
the brightest parts of your scene. Here, Adams
recommends that you always mistrust your first
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A great example of the abstract effect
a black-and-white conversion can have





impressions. A white tablecloth might be the
lightest colored object within the frame, but re-
flections from a polished metal spoon, for ex-
ample, will produce much more intense high-
lights than the cloth itself at the same exposure
level. The reflections from the spoon should, as
a result, appear much brighter than the cloth
in the finished print. Bright features, like the
highlights produced by reflective metal, can
even be printed as pure, detail-free white if
they only represent minor detail within the
frame. This example illustrates Adams' primary
idea that the tonal values of individual details
have to be assessed within the context of the
entire image, and that your choice of the de-
tails you accentuate will be based on the re-
sults of this assessment.

3. The third step involves assessing the mid-
tones that lie between white and bright gray
and those between black and dark gray. An im-
portant factor at this stage is deciding which
gray value represents the middle of the image's
overall range. A photographer can learn to rec-
ognize and compose using individual tones
and semitones, rather like a musician. Adams
actually defined a standard range of 11 zones,
named using Roman numerals from 0 to X (see

the illustration below). His technique involved
using a narrow-band spot meter to meter the
important details within a scene and allocating
them to one of the 11 zones. This allowed him
to judge the overall dynamic range of his sub-
ject and thus to select the correct combination
of aperture and shutter speed, as well as the
appropriate developer concentration and de-
velopment time to produce print contrast that
was appropriate to the individual subject.

This technique was originally developed to
produce a single, optimized print from a sin-
gle, large-format negative. While early photog-
raphers were unsure how their results would
look until after the print had been developed
and chemically fixed, digital photographers
often only take a quick glance at the camera
monitor to see whether a shot has worked out.
Whatever you do, don't let this apparent sim-
plicity become a substitute for conscious per-
ception and composition when you are taking
photos. While the zone system can’t be trans-
posed directly to the digital context, a good
grasp of the theories involved can help you to
view your subject in more detail and to com-
pose an image that can be effectively convert-
ed to grayscale. In the world of endless digital

processing options, a preconceived image
concept helps you to avoid losing track of your
original idea. Human perception doesn't work
like a light meter – it tends to see colors and
tones differently depending on the nature and
brightness of their surroundings. The emo-
tions an image produces depend on how the
viewer perceives it, not on the measured val-
ues used to create it, so remember to concen-
trate not just on “correct” exposure, but also
on how you want your finished image to ap-
pear. A deeper understanding of basic photo-
graphic technique can help you to see and
photograph the portions of the enormous
range of available tones that are important to
the emotional impact you want your image to
have. A great photographer knows not only
how to pack the maximum amount of infor-
mation into an image, but also which informa-
tion to leave out in order to produce the best
possible results. (ae/rez)
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The dynamic range of our subject, divided into 11 Ansel Adams-style zones c

Fine, high-contrast textures 
are ideal subjects for 

black-and-white photos
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Ralph Altmann

Cellphone
Photography

with a twist
Cellphone photographs are underexposed and out of focus, 
full of image noise and JPEG artifacts – suitable, at best, as
souvenirs, right? Are you sure? What about using the flaws 
as a stylistic device instead of covering them up?



Pro SLR cameras passed the 50 megapixel
mark long ago. Even my Motorola, which

isn’t the youngest anymore, boasts a million
pixels. OK, that was already standard 10 years
ago, even for SLRs. Technically speaking, the
lack of pixels doesn’t mean you can’t take
great pictures with your phone. Rather, the
quality is defined by the pinhead-sized lens
and the enormous JPEG compression, which
boils the 1280 x 960 pixel images down to an
average of 300 KB. The settings are limited to
white balance and exposure compensation,
and the phone immediately forgets any
changes you have made to them once you
snap it shut. Moreover, the location of the
 exposure button makes unfocussed pictures
almost inevitable.

Even so, the camera phone beats any
other camera in terms of availability. With
other cameras, whether professional or
compact models, you have to make that
conscious decision to take your camera
along, whereas the cellphone is always in
your pocket. Eventually, for me, due to the
lack of a “real” camera, the day came where
I succumbed to the temptation of taking pi-
ctures with my phone – even though I
thought I knew that nothing good could
come from it. At first my suspicions were
confirmed: overexposed highlights, under-
exposed shadows, out-of-focus or shaky
images and limp colors characterized the
results. My lame attempts to take corrective

action only made further inherent qualitati-
ve shortcomings like noise and JPEG arti-
facts more apparent.

The results from my camera phone are
likely ill-suited for artwork intended to satisfy
ordinary viewing expectations. However, it is
not common to use cellphones for landscape
and architectural photography or, for that
matter, the ubiquitous wedding. Rather, cam-
era phones are more appropriate for snap-
shots, photographs “in passing”, or for cap-
turing situations and moods – basically, for
pictures where the images don’t have to be
in focus or the colors accurate, where

crooked horizons and blurred or grainy im-
ages aren’t considered flaws but rather un-
derline the fleetingness of the moment. I pre-
fer to intensify these flaws, especially the
image noise and the JPEG artifacts, until they
become visible. This gives the washed out
cellphone photograph a graphical texture; a
strong emphasis on color does the rest.

My guiding principle when editing cam-
era phone images is strict separation of
brightness and color editing. The L*a*b*
color mode is not required. It is sufficient to
put a grayscale version of the picture with a
suitable blend mode over the layer with the
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The grayscale image is created by masking the color image with a pure
gray or black layer (using Hue blend mode). We do this in the  Layers
panel within the “Luminosity conversion” layer group. The entire group
is set to Luminosity blend mode. This allows you to manage the color
and brightness separately. Color can be regulated using the adjustment
layer (second layer from the bottom), brightness by correcting the
overlying grayscale image. The top layer in the Layers panel shows a
heavy gradation shift after merging the group.

Strong colors and
structures make a blurred

cellphone image look
more like an abstract

painting

The top row depicts the original cellphone image, the
partially solarized grayscale image and the result of the
layering by applying the Luminosity blend mode. I used
the Soft Light blend mode to create the larger image.
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color image. The blend mode on offer is
 Luminosity or Lighten. The principle is the
same even when the gray scale image relies
on the luminance of the color image. See the
figure at the bottom left on the previous
page for how to achieve a “luminance image”
like this. Next, I create a Hue/Saturation ad-
justment layer over the original image and
enhance the saturation globally or selective-
ly. The saturation can be regulated further to
the right than would otherwise be possible
because the grayscale layer greatly reduces
the danger of oversaturating an image.

Editing the grayscale layer affects the
overall picture only in terms of the brightness
of the colors, but not their hue and satura-
tion. Therefore, even significant adjustments
to the tone curve alter the image less than if
the same modification were applied to the
entire image. The image at the bottom right

on the previous page was created by partially
solarizing the grayscale image (a partial in-
version of the tonal values using a gradation
curve, for example).

My preferred blend mode for layers, how-
ever, is not Luminosity but Soft Light, which
produces further amplification of the contrast
and colors in the result. You may have to fac-
tor this in when preparing the grayscale
image. Overlay and Hard Light” give harsher
results which, like any result achieved with an
overlay layer, can be softened by moving the
Opacity  slider.

I usually use a variation of the “sharpen-
ing using grain” technique to counteract the
blur and lack of sharpness in my camera
phone pictures. A copy of the original is
transformed into a grayscale image and is re-
peatedly sharpened with the Unsharp Mask
filter until only the underlying textures re-

main in the image. The bigger the sharpen-
ing radius, the more the contours will be en-
hanced. I set this layer to either Luminosity,
Overlay, or Soft Light blend mode. In most
cases,  opacity has to be reduced. The con-
tours, which shimmer through feebly, sepa-
rate color spaces from one another and en-
sure that the image appears sharp when
magnified. Furthermore, a surface that ini-
tially appears to be an almost homogenous,
blurry color then gains a texture which in it-
self also appears to be sharp. This texture re-
sults from the image noise and the JPEG arti-
facts of the camera phone picture. It can
even break open under- and overexposed
image sections which are almost completely
black or white and give them an interesting
graphical effect.

Multiple sharpening has the disadvan-
tage of creating very harsh ultra-high-con-
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Focus in a fuzzy
image: Overlay
mode prevents
the colored
highlights in this
blurred
photograph from
dissolving
completely

Berlin Central Station Waiting



trast images that contain nothing but black
and white. It is desirable to have an image
that still has the contrast gradation of the
original, even though it has been extremely
enhanced. I create such contrast images
with my SF Maskerade plug-in. In addition
to the freeware version, the full version  of
the program (available at
www.simplefilter.de/en/) contains two mask
modes, called Contours and Contrast. You
can also blend several of these masks with-
in the filter. The result is a grayscale image,
which I lay over the  original with one of the
previously men tioned blend modes. The in-
terposed “Hue/Saturation” layer setting
provides the color boost.

The partially solarized grayscale image
(see above) was also created by means of
the Maskerade plug-in with the Lightness
mode. These reverse gradations can pro-
duce better results than the gradation curve
tool, and it is also possible to apply the free-
ware version’s filter. I then increase the con-
trast using the same blend mode, mixing
the result beforehand in the filter with the
brightness mask. The result is a grayscale
image with a visible “grain”, the size of
which depends on the radius chosen. The
contours are also enhanced, and you can
choose whether the enhancement will af-
fect only the weak, only the strong, or all
types of contours. For our purposes, the
other options are irrelevant.

Photographs with totally burnt-out
highlights have no JPEG artifacts or image
noise at all, so the texture cannot even be
made visible, even with maximum contrast
enhancement. So it is important that the
raw material, the cellphone photograph, is
not overexposed. Underexposing the

image is less harmful, because although
underexposed areas may not contain any
useful details, they do contain artifacts that
can lighten dark shadows when enhanced.
This kind of simulated enhancement of de-
tails is always better than not changing
anything at all, especially for details where
we expect some texture in the image, such

as in brickwork and other building materi-
als, textiles, fur, and hair. These kinds of
textures can be distracting on smooth skin
but there are proven methods of selective
image editing and masking that allow you
to apply powerful effects to a specific area
of an image while excluding others.

(ae/rez)  c
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Partial solarizaton in
the Maskerade

filter’s Brightness
mode. In this case,
applied to only the
red channel of the

original image.

The grayscale layer,
which I blended in

the filter, from a
normal but
somewhat

brightened grayscale
image and my high-
contrast image, and

applied over the
original layer. A

radius value of 3.0
gives a stronger

contour. The two
partial images can be

seen at the bottom
right.

Cologne Bonn AirportStreet café



The source images were shot using a
Nikon D80 attached to a 1200mm teles-

cope with a 130mm aperture. I used a Barlow
Lens to increase the effective focal length to
3170 mm. This degree of magnification al-
lows even small details to fill the frame, so I
shot 64 individual images at ISO 800 and 1/60
second to produce the source material for
the nine segments necessary to cover the en-
tire surface. I used a stepper motor to keep
the subject centered on the image sensor du-
ring shooting. Atmospheric turbulence spoi-
led some of my shots, leaving me with 38
usable source images, equivalent to about
four per segment.

As with terrestrial images, processing took
much longer than the actual shoot. I used

Giotto 2.1.2 (a free astrophotographic image
processing program) to stack the images for
each segment and to apply a Gaussian sharp-
ening filter to the results. I then used Panora-
maStudio 2.0 Pro to merge the stacked seg-
ments into a single image.

I used Photoshop to perform my fine-tun-
ing. In order to avoid loss of detail while pro-
cessing the extreme difference in brightness
between the edge of the Moon and the shad-
ow surrounding it, I merged two versions of
the image with different brightnesses using
the Photoshop Gradient tool. I also produced
a low-noise version of the image using Noise-
ware Professional 2.6 and merged the edge
portions of the resulting image – again, using
the Gradient tool – with the overall picture.

This step reduced noise where it was most
evident and reduced the effects of artifacts in
the brightly-lit parts of the image. Finally, I
used the Unsharp Mask tool to sharpen the
merged image.

The finished image – almost 70 MB in size
– is included on this issue’s free DVD, along
with a detailed description of the individual
steps in the processing workflow. To view the
image, I recommend using the largest moni-
tor you can get your hands on or having a
print made by a high-end print service. 
The details are fascinating and you are sure 
to end up inspecting individual craters 
and bumps with a magnifier. The image is
 licensed for private use and non-commercial
printing and display. (jr)  c
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Rolf Hempel

The Moon
as a large format panorama

Thirty-eight source images and a lot of image processing were the basic
components of this 24-megapixel, high-resolution panorama image of the
Moon. The finished image, which is suitable for printing as a poster, is
licensed for private use and is included on this issue’s free DVD. Here, find
out how the image was made.

The 68-mile-long, 1,000-foot-high
elevation in the centre of this

section has a slope of just seven
degrees and appears as a dark

line just after sunrise, changing to
a bright line at sunset.

One of the many details in the
finished panorama: Copernicus is a
prominent and relatively young crater
that is 59 miles in diameter. The
mountains in the center of the crater
reach heights of up to 4,000 feet.
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Photographed directly 
from Earth using a DSLR 
and a telescope. The 
finished 24-megapixel image 
is constructed from 38 
individual source images.
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